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4-Year Bachelor (Honours with Research) in Library and Information Science
4-Year Bachelor (Honours with Research) in Library and Information Science

A four-year full-time course divided into eight semesters leading to the degree of 4-Year Bachelor
(Honours with Research) Programme in Library and Information Science
A. Program Details
Name of the Department: Department of Library and Information Science
School: School of Computational Sciences, Information and Communication Technology (SCSI&CT)
Subject: Library & Information Science
Duration of the Programme: 4 Year divided into 8 Semester (NEP 2020 System)
B. Objectives of the Programme

1. To promote Multidisciplinary and a Holistic education across the sciences, social sciences, arts
and humanities.
To familiarize students with basic concepts of Library and Information Science.
To learn knowledge organization and processing.
To emphasize on conceptual understanding rather than rote learning and learning-for- exams.
To develop skills in using computer and communication technology.

To enhance in personality and communication skills.

N oo g s~ N

To promote flexibility, so that learners have the ability to choose their learning trajectories and
programmes, and thereby choose their own paths in life according to their talents and interests,
8. Flexibility, so that students have the ability to choose their learning trajectories and
programmes, and thereby choose their own paths in life according to their talents and interests.
C. Programme Outcomes
After the completion of this programme the student will be in a position to work at middle and
top managerial positions in all types of libraries, viz. academic, public, or special. It involves
competencies relating to drafting and getting approval for the library policy, delegation, recruitment,
conflict resolution, etc. They will have competencies to design and develop innovative library services
such as integrated library management systems, digital library, institutional repositories and for the
specific needs of the community of users. Additionally, they will be able to conduct studies to evaluate
the impact, effectiveness and efficiency of library services and library collection among the users.
Another outcome of the programme is to develop a strong subject foundation for doctoral-level courses

in library and information science.
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4-Year Bachelor (Honours with Research) in Library and Information Science

C. Details of Course Credit Scheme and Scheme of Examination:

4-Year Bachelor (Honours with Research) in Library and Information Science

(2024-25 onwards)
Intake: 33
Total Semester: 8 Credit: 188

Level Programme Qualification Titles Total Credits
Level 4.5 | 4-Year Minimum Eligibility: Semester | 24 Credits
Bachelor 10 + 2 in any discipline from Central/State | Semester I1: 24 Credits
(Honours . . .. Total : 48 Credits
h Government recognized Board having minimum
wit .| 50% marks or equivalent grade (5% marks
Research) in )
Library and relaxation  for ~ SC/ST/OBC  (Non-creamy
Information | layer)/PwD Candidates)
Science
Ist Year Type of Qualification Exit student: 48+4 = 52
Students on exit shall be awarded Undergraduate | credits
Certificate in Library and Information Science after
securing the requisite 44
Total 44 Credits (Including 4 Credits Internship) on
completion of Semester Il
Level 5 | 4-Year Minimum Eligibility: Semester 111: 24 Credits
Bachelor 10 + 2 in any discipline from Central/State | Semester IV: 24 Credits
(Honours . . .. Total: 48+48 = 96 Credits
th Government recognized Board having minimum
wit .| 50% marks or equivalent grade (5% marks
Research) in .
Library and | "elaxation  for  SC/ST/OBC  (Non-creamy
Information | layer)/PwD Candidates)
Science and
lInd Year

One Year Undergraduate Certificate in Library and
Information Science having minimum 50% marks or
equivalent grade (5% marks relaxation for
SC/ST/OBC (Non-creamy layer)/PwD Candidates)
from Central/State Government recognized Board

Type of Qualification

Students on exit shall be awarded Undergraduate
Diploma in Library and Information Science
after securing the requisite 84 credits.

Total 84 Credits (Including 4 Credits Internship) on
completion of Semester 1V

Exit student: 96+4 = 100
credits

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar
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4-Year Bachelor (Honours with Research) in Library and Information Science

Level Programme Qualification Titles Total Credits
Level 5.5 | 4-Year Minimum Eligibility: Semester V:.24 Credi'_cs
Bachelor 10 + 2 in any discipline from Central/State from ?%E.Stgeg Jr\g:a' :24 Credits
(Honours Central/State Government recognized Board having | 144 credits
with | minimum 50% marks or equivalent grade (5%
Research) in | marks relaxation for SC/ST/OBC (Non-creamy
Library and | jayer)/PwD Candidates)
Information | 54
Science Two Years Undergraduate Diploma in Library and
lird Year Information Science having minimum 50% marks or
equivalent grade (5% marks relaxation for
SC/ST/OBC (Non-creamy layer)/PwD Candidates)
from Central/State Government recognized Board
Type of Qualification Exit student : 144+4 =
Students on exit shall be awarded Bachelor of | 148 Credits
Library and Information Science after securing
the requisite 148 credits
(Including 4 Credits Internship) on completion of
Semester VI
Level 6 4-Year Minimum Eligibility: Semester VII: 22 Credits
Bachelor Bachelor (Hons.) in Library and Information | Semester VilI: 22Credits
(Honours Science or, having minimum 50% marks or Tlggalc'rié?t?ﬂ'_
\éevétsgarch) in equivalent grade (5% marks relaxation for
Library and SC/ST/OBC (Non-creamy layer)/PwD Candidates)
Information | from  Central/State  Government  recognized
Science University with B.Lib.l1.Sc. with 75% marks or
IVth Year

equivalent grade and wish to undertake research at
the undergraduate level can choose a research
stream in the fourth year.

Type of Qualification

Students shall be awarded 4-year Bachelor
(Honours with Research) in Library and
Information Science with 75% and above in after
securing the requisite 188 credits on completion of
Semester VIII

Other Students shall be awarded 4-year Bachelor
(Honours) in Library and Information Science
with below 75% in after securing the requisite 188
credits on completion of Semester VIII

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar
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4-Year Bachelor (Honours with Research) in Library and Information Science

4-Year Bachelor (Honours with Research) in Library and Information Science

1st Year, Semester I, Level 4.5

Course Code Course Title Broad Credit Distribution Duration | 1A ESE | Total
Categoryof | | T P | Total
Course

Discipline Specific Core Course (DSC) (Compulsory)

BLIS3101 Foundation of Library and Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Information Sciences

BLIS3102 Knowledge Organization I: Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Classification (Theory)

BLIS3103 Fundamentals of Computer Core/DSC | 3 1 0 4 60 HRS | 40 60 100
(Theory)

BLIS3104: Generic Elective (GE) (Opt any one course from the following or, choose from MOOCs/SWAYAM/ Multi-

disciplinary from other departments of University) (Select Any One)

BLIS3104A | Knowledge Society GE 3 1 0 4 60 HRS | 40 60 100
BLIS3104B | Historical Development of GE 3 1 0 4 60 HRS | 40 60 100
Library
BLIS3104C | Human Resource GE 3 1 0 4 60 HRS | 40 60 100
Management
Ability Enhancement Course (AEC)
BLI1S3105 Hindi Grammar and AEC 1 1 0 2 30HRS | 40 60 100
Composition
Skill Enhancement Course/Practical (Compulsory)
BLIS3106 Knowledge Organization I: PC/SEC 0 1 1 2 30HRS | 40 60 100
Classification (Practical)
BLIS3107 Fundamentals of Computer PC/SEC 0 1 1 2 30HRS | 40 60 100
(Practical)
BLIS3108: Value -Added Course (VAC) (Select Any One)
BLIS3108A | Library and Information VAC 1 1 0 2 30HRS | 40 60 100
Portals
BLIS3108B | Library 4.0 VAC 1 1 0 2 30HRS | 40 60 100

BLIS3109: Mandatory Elective Non-Credit Course (MENC)

equivalent to 2 credits (Opt any one course from the following)

(Select Any One)
BLIS3109A | Open Access Initiatives MENC 30 HRS
BLIS3109B | Information, Communication MENC 30 HRS
and Society
Total Credit [ 24
Abbreviations:

DSC: Discipline Specific Core Course (Compulsory), OEC: Open Elective Course, PC: Practical Course, SEC:
Skill Enhancement and MENC: Mandatory Elective Non-Credit Courses equivalent to 2 credits.
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4-Year Bachelor (Honours with Research) in Library and Information Science

1st Year, Semester 11, Level 4.5

Course Code Course Title Broad Credit Distribution Duration | 1A ESE | Total
Categoryof | | T P | Total
Course

Discipline Specific Core Course (DSC) (Compulsory)

BLIS3201 Management of Library and Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Information Centres

BLIS3202 Knowledge Organisation II: Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Cataloguing (Theory)

BLIS3203 Collection Development and Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Management of E-Resources
(Theory)

BLIS3204: Generic Elective (GE) (Opt any one course from the following or, choose from MOOCs/SWAYAM/ Multi-

disciplinary from other departments of University) (Select Any One)

BLIS3204A | Organizing and Managing GE 3 1 0 4 60 HRS | 40 60 100
Information

BLIS3204B | Library and Information in GE 3 1 0 4 60 HRS | 40 60 100
Social Perspective

BLIS3204C | Libraries, Information and GE 3 1 0 4 60 HRS | 40 60 100
Knowledge - Based Society

Ability Enhancement Course (AEC)

BLIS3205 | English Grammar and AEC 1 1 0 2 30HRS | 40 60 100
Composition

Skill Enhancement Course/Practical (Compulsory)

BLIS3206 Knowledge Organisation Il: PC/SEC 0 1 1 2 30HRS | 40 60 100
Cataloguing (Practical)

BLIS3207 Collection Development and PC/SEC 0 1 1 2 30HRS | 40 60 100
Management of E-Resources
(Practical)

BLI1S3208: VValue -Added Course (VAC) (Select Any One)

BLIS3208A | National Information System VAC 1 1 0 2 30HRS | 40 60 100

BLIS3208B | Library and Social Media VAC 1 1 0 2 30HRS | 40 60 100

BLIS3209: Mandatory Elective Non-Credit Course (MENC)

(Select Any O

ne)

equivalent to 2 credits (Opt any one course from the following)

BLIS3209A | Internet of Things MENC 30 HRS
BLIS3209B | RFID Implementation MENC 30 HRS
Total Credit 24
BLIS3210 Internship™ Internship 0 1 3 4 60 40 60 100
(Exit Module) HRS
Abbreviations:

DSC: Discipline Specific Core Course (Compulsory), OEC: Open Elective Course, PC: Practical Course, SEC:
Skill Enhancement and MENC: Mandatory Elective Non-Credit Courses equivalent to 2 credits.

*Students on exit shall be awarded Undergraduate Certificate in Library and Information Science after
securing the requisite 52 Credits (Including 4 Credits in Internship Programme) on completion of

Semester |
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4-Year Bachelor (Honours with Research) in Library and Information Science

4-Year Bachelor (Honours with Research) in Library and Information Science

2nd Year, Semester 111, Level 5

Course Code Course Title Broad Credit Distribution Duration | 1A ESE | Total
Categoryof | | T P | Total
Course
Discipline Specific Core Course (DSC) (Compulsory)
BLIS3301 Information Source, System Core/DSC | 3 1 0 4 60 HRS | 40 60 100
and Services
BLIS3302 Knowledge Management Core/DSC | 3 1 0 4 60 HRS | 40 60 100
BLIS3303 Knowledge Organization IlI: Core/DSC | 0 1 3 4 60 HRS | 40 60 100
Advanced Classification
(Theory)
BLIS3304: Discipline Specific Elective Course (Opt any one course from the following or, choose from
MOOCs/SWAY AM/Generic Elective (GE) from other departments of University) (Select Any One)
BLIS3304A | Remote Access of Electronic DSE 3 1 0 4 60 HRS | 40 60 100
Resources
BLIS3304B | Library Consortia DSE 3 1 0 4 60 HRS | 40 60 100
BLIS3304C | Library and Information DSE 0 1 3 4 60 HRS | 40 60 100
Science Profession
Ability Enhancement Course (AEC)
BLIS3305 | Principal Hindi AEC | 1] 1 | 0] 2 [30HRS]| 40 60 100
Internship/Apprenticeship/Project/Community Outreach (IAPC)
BLIS3306 | Re-Envisioning Public IAPC 1 1 0 2 30HRS | 40 60 100
Library
Skill Enhancement Course/Practical (Compulsory)
BLIS3307 | Knowledge Organization IlI: PC/SEC 0 1 1 2 30HRS | 40 60 100
Advanced Classification
(Practical)
BLIS3308: Value -Added Course (VAC) (Select Any One)
BLIS3308A | Professional Ethics in LIS VAC 1 1 0 2 30HRS | 40 60 100
BLIS3308B | Cloud Computing VAC 1 1 0 2 30HRS | 40 60 100

BLIS3309: Mandatory Elective Non-Credit Course (MENC)

equivalent to 2 credits (Opt any one course from the following)

(Select Any One)
BLIS3309A | Personality Development and MENC 30 HRS
Communication Skills
BLIS3309B | Professional Ethics MENC 30 HRS
Total Credit [ 24
Abbreviations:

DSC: Discipline Specific Core Course (Compulsory), OEC: Open Elective Course, PC: Practical Course, SEC:
Skill Enhancement and MENC: Mandatory Elective Non-Credit Courses equivalent to 2 credits.
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4-Year Bachelor (Honours with Research) in Library and Information Science

4-Year Bachelor (Honours with Research) in Library and Information Science
2nd Year, Semester 1V, Level 5

Course Code Course Title Broad Credit Distribution Duration 1A ESE Total
Categoryof | L | T | P [ Total
Course

Discipline Specific Core Course (DSC) (Compulsory)

BLIS3401 Preservation & Conservation Core/DSC 3 1 0 4 60 HRS | 40 60 100
of Library Materials

BLIS3402 Knowledge Organisation IV: Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Advanced Cataloguing
(Theory)

BLIS3403 Library Automation and Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Networking (Theory)

BLIS3404: Discipline Specific Elective Course (Opt any one course from the following or, choose from
MOOCs/SWAY AM/Generic Elective (GE) from other departments of University) (Select Any One)

BLIS3404 A | Institutional Repository DSE 3 1 0 4 60 HRS | 40 60 100
BLIS3404 B | Intellectual Property Rights DSE 3 1 0 4 60 HRS | 40 60 100
and Copyrights
BLIS3404 C | Database Design and DSE 0 1 3 4 60 HRS | 40 60 100
Management
Ability Enhancement Course (AEC)
BLIS3405 English Comprehension and AEC 1 1 0 2 30HRS | 40 60 100
Writing Skills
Internship/Apprenticeship/Project/Community Outreach (IAPC)
BLIS3406 | Re-Envisioning Academic IAPC 1 1 0 2 30HRS | 40 60 100
Library
Skill Enhancement Course/Practical (Compulsory)
BLIS3407 Knowledge Organisation I1V: SEC 0 1 1 2 30HRS | 40 60 100
Advanced Cataloguing
(Practical)
BLIS3408: Value -Added Course (VAC) (Select Any One)
BLIS3408A | Mobile-Based Library VAC 1 1 0 2 30HRS | 40 60 100
Services
BLIS3408B | Intelligent Library Search VAC 1 1 0 2 30HRS | 40 60 100

and Federated Search

BLIS3409: Mandatory Elective Non-Credit Course (MENC) equivalent to 2 credits (Opt any one course from the following)
(Select Any One)

BLIS3409A | Academic Integrity and MENC 30 HRS
Plagiarism
BLIS3409B | Information Security MENC 30 HRS
Total Credit 24
BLIS3410 Internship* Internship 0 1 3 4 60 HRS | 40 60 100
(Exit Module)

Abbreviations:
DSC: Discipline Specific Core Course (Compulsory), OEC: Open Elective Course, PC: Practical Course, SEC:
Skill Enhancement and MENC: Mandatory Elective Non-Credit Courses equivalent to 2 credits.

* Students on exit shall be awarded Undergraduate Diploma in Library and Information Science after securing the
requisite 100 Credits (Including 4 Credits Internship) on completion of Semester 1V
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4-Year Bachelor (Honours with Research) in Library and Information Science

4-Year Bachelor (Honours with Research) in Library and Information Science
3rd Year, Semester V, Level 5.5

Course Code Course Title Broad Credit Distribution Duration | 1A ESE | Total
Categoryof | | T P | Total
Course
Discipline Specific Core Course (DSC) (Compulsory)
BLIS3501 Marketing of Library and Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Information Products and
Services
BLIS3502 Information and Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Communication Technology
(Theory)
BLIS3503 Media and Information Core/DSC | 3 1 0 4 60 HRS | 40 60 100
Literacy in LIS
BLIS3504: Discipline Specific Elective Course (Opt any one course from the following or, choose from MOOCs/SWAY AM
from other departments of University) (Select Any One)
BLIS3504 A | Academic Library and DSE 3 1 0 4 60 HRS | 40 60 100
Information System
BLIS3504B | Public Library and DSE 3 1 0 4 60 HRS | 40 60 100
Information System
BLIS3504C | Research and Technical DSE 3 1 0 4 60 HRS | 40 60 100
Library and Information
System
BLI1S3505: Generic Elective (GE) (Opt any one course from the following or, choose from MOOCs/SWAY AM/
Multi-disciplinary from other departments of University) (Select Any One
BLIS3505A | Electronic Publishing GE 3 1 0 4 60 HRS | 40 60 100
BLIS3505B | Reference Management GE 3 1 0 4 60 HRS | 40 60 100
Internship/Apprenticeship/Project/Community Outreach (IAPC)
BLIS3506 | Re-Envisioning Special IAPC 0 1 1 2 30HRS | 40 60 100
Library
Skill Enhancement Course/Practical (Compulsory)
BLIS3507 Information and SEC 0 1 1 2 30HRS | 40 60 100

Communication Technology
(Practical)

BLIS3508: Mandatory Elective Non-Credit Course (MENC)

(Select Any O

ne)

equivalent to 2 credits (Opt any one course from the following)

BLIS3508A | User Studies and User MENC 30 HRS
Education
BLIS3508B | Big data and Data MENC 30 HRS

Visualization

Total Credit |

24

Abbreviations:
DSC: Discipline Specific Core Course (Compulsory), OEC: Open Elective Course, PC: Practical Course, SEC:
Skill Enhancement and MENC: Mandatory Elective Non-Credit Courses equivalent to 2 credits.
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4-Year Bachelor (Honours with Research) in Library and Information Science
3rd Year, Semester VI, Level 5.5

Course Code Course Title Broad Credit Distribution Duration 1A ESE Total
Categoryof | L | T | P [ Total
Course

Discipline Specific Core Course (DSC) (Compulsory)

BLIS3601 Information Retrieval System | Core/DSC | 3 1 0 4 60 HRS | 40 60 100

BLIS3602 Web Based Information Core/DSC 3 1 0 4 60 HRS | 40 60 100
Systems and Services
(Theory)

BLI1S3603 Content Management System | Core/DSC 3 1 0 4 60 HRS | 40 60 100

BLIS3604: Discipline Specific Elective Course (Opt any one course from the following or, choose from MOOCs/SWAYAM
from other departments of University) (Select Any One)

BLIS3604A | Computer and DSE 3 1 0 4 60 HRS | 40 60 100
Communication Technology

BLIS3604B | Media and Publishing DSE 3 1 0 4 60 HRS | 40 60 100
Technology

BLIS3604C | Data Analytics DSE 3 1 0 4 60 HRS | 40 60 100

BLIS3605: Generic Elective (GE) (Opt any one course from the following or, choose from MOOCs/SWAY AM/
Multi-disciplinary from other departments of University) (Select Any One

BLIS3605A | Library and Information GE 3 1 0 4 60 HRS | 40 60 100
Services
BLIS3605B | Internet Resource and GE 3 1 0 4 60 HRS | 40 60 100
Services
Internship/Apprenticeship/Project/Community Outreach (IAPC)
BLIS3606 | Re-Envisioning of Law IAPC 0 1 1 2 30HRS | 40 60 100
Library
Skill Enhancement Course (SEC)
BLIS3607 Web Based Information SEC 0 1 1 2 30HRS | 40 60 100
Systems and Services
(Practice)

BLIS3608: Mandatory Elective Non-Credit Course (MENC) equivalent to 2 credits (Opt any one course from the following)
(Select Any One)

BLIS3608A | Technical Writing MENC 30 HRS
BLIS3608B | Disaster Management MENC 30 HRS
Total Credit 24
BLIS3609 Internship* Internship 0 1 3 4 60 HRS | 40 60 100
(Exit Module)

Abbreviations:
DSC: Discipline Specific Core Course (Compulsory), OEC: Open Elective Course, PC: Practical Course, SEC:
Skill Enhancement and MENC: Mandatory Elective Non-Credit Courses equivalent to 2 credits.

*Students on exit shall be awarded Bachelor of Library and Information Science after securing the requisite 148
Credits (Including 4 Credits Internship) on completion of Semester VI
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4-Year Bachelor (Honours with Research) in Library and Information Science
4th Year, Semester VII, Level 6

Course Code Course Title Broad Credit Distribution Duration 1A ESE Total
Categoryof | L [ T | P [ Total
Course

Discipline Specific Core Course (DSC) (Compulsory)

BLIS3701 Research and Publication Core/DSC 3 1 0 4 60 HRS | 40 60 100
Ethics

BLIS3702: Discipline Specific Elective Course (Opt any Three courses from the following or, choose from MOOCs/SWAYAM
from other departments of University) (Select Any Three)

BLIS3702A | Research Methodology DSE 3 1 0 4 60 HRS | 40 60 100
BLIS3702B | Digital Library DSE 3 1 0 4 60 HRS | 40 60 100
BLIS3702C | Change Management DSE 3 1 0 4 60 HRS | 40 60 100
BLIS3702D | Project Management DSE 3 1 0 4 60 HRS | 40 60 100
BLIS3702E | Indian Culture and Tradition DSE 3 1 0 4 60 HRS | 40 60 100
Academic Project/ Dissertation

BLIS3703 Library Minor VAC 0 1 5 6 90 HRS | 40 60 100

Project/Dissertation
Internship
BLIS3704 | Internship | Internship | 0 | 1 [ 7 [ 8 [120HRS| 40 | 60 | 100

BLIS3705: Mandatory Elective Non-Credit Course (MENC) equivalent to 2 credits (Opt any one course from the following)
(Select Any One)

BLIS3705A | LIS Research MENC 30 HRS

BLIS3705B | Organizational Behaviour MENC 30 HRS

Total Credit [ 22

Abbreviations:
DSC: Discipline Specific Core Course (Compulsory), OEC: Open Elective Course, PC: Practical Course, SEC:
Skill Enhancement and MENC: Mandatory Elective Non-Credit Courses equivalent to 2 credits.
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4-Year Bachelor (Honours with Research) in Library and Information Science
4th Year, Semester VIII, Level 6

Course Code Course Title Broad Credit Distribution Duration 1A ESE Total
Categoryof | L [ T | P | Total
Course

Discipline Specific Core Course (DSC) (Compulsory)

BLIS3801 Information Communication Core/DSC 3 1 0 4 60 HRS | 40 60 100
Technology: Application

BLIS3802: Discipline Specific Elective Course (Opt any Three courses from the following or, choose from MOOCs/SWAYAM
from other departments of University) (Select Any Three)

BLIS3802A | Special Library and DSE 3 1 0 4 60 HRS | 40 60 100
Information System

BLIS3802B | Engineering Library and DSE 3 1 0 4 60 HRS | 40 60 100
Information System

BLIS3802C | Health Science Library and DSE 3 1 0 4 60 HRS | 40 60 100
Information System

BLIS3802D | Agricultural Sciences Library DSE 3 1 0 4 60 HRS | 40 60 100
and Information System

BLIS3802E | Information Resource DSE 3 1 0 4 60 HRS | 40 60 100

Development

Academic Project/ Dissertation

BLIS3803 Academic Project/ VAC 0 1 5 6 90HRS | 40 60 100
Dissertation

Internship

BLIS3804 [ Internship [Internship | 0 | 1 | 7 | 8 [120HRS] 40 | 60 | 100

BLIS3805: Mandatory Elective Non-Credit Course (MENC) equivalent to 2 credits (Opt any one course from the following)
(Select Any One)

BLIS3805A | Semantic Web MENC 30 HRS

BLIS3805B | Informatics and MENC 30 HRS
Scientometrics

Total Credit | 22

Abbreviations:
DSC: Discipline Specific Core Course (Compulsory), OEC: Open Elective Course, PC: Practical Course, SEC:
Skill Enhancement and MENC: Mandatory Elective Non-Credit Courses equivalent to 2 credits.

Students passed with 75% and above shall be awarded 4-year Bachelor (Honours with
Research) in Library and Information Science after securing the requisite 188 credits on
completion of Semester VI1lI

Other Students passed below 75% shall be awarded 4-year Bachelor (Honours) in Library
and Information Science after securing the requisite 188 credits on completion of Semester
VI
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4-Year Bachelor (Honours with Research) in Library and Information Science

4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND
INFORMATION SCIENCE

ISTYEAR, SEMESTER-I

Course Code BLIS3101

Course Title Foundation of Library and Information Sciences

Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To acquaint the students with the basic concepts of foundation of library and
information, professional associations and how to deal with.
Outcome- After completion of the course, students will be able to understand the concept of

library,

Unit I:
>
>
>
>

types of libraries, library legislation and their application in information science.

Concept of Library

Meaning, Concepts, Need, Definitions and Purpose.
Historical Developments of Libraries in India

Types of Libraries- Academic, Public, Special and National
Five Laws of Library Science and their Implications

Unit I1: Professional Associations

YV V VY

National: ILA, IASLIC, IATLIS

International: IFLA, ALA, CILIP, ASLIB, SLA

Role of UGC, RRRLF and UNESCO in Promotion and Development of Libraries

Library Legislation and Library Acts in Indian States: The Press and Registration of Books
Act: The Delivery of Books and Newspapers (Public Libraries) Act.

Unit I11: Concept of Information

A\

>
>
>

Data, Information, Knowledge, and Wisdom.

Information Life Cycle- Generation, Collection, Storage and Dissemination.

Role of Information in Planning, Management, Socio-economic, Cultural, Educational and
Technological Development.

Information Science - Relationship with other subjects, Information Society and
Knowledge Society.

Unit IV: Library and Information

>

>

>

Library and Information Science Education in India

Information Industry- Generators, Providers, and Intermediaries

IPR and Legal Issues- Categories, Conventions, Treaties and Laws: Right to Information
Act (RTI), Information Technology Act

National Knowledge Commission: National Mission on Libraries
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4-Year Bachelor (Honours with Research) in Library and Information Science
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3102

Course Title Knowledge Organization I: Classification (Theory)

Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Obijectives- To apprise the students with the organization of knowledge with different basic
concepts and philosophies of library classification.

Outcome- After completion of the course, students will understand the basic concept and
philosophies of library classification, and recent trends and developments in the library
classification.

Unit I: Overview of Concepts
» Concepts, Terminology and Need
» Purpose, and Functions of Library Classification
» Obijectives of Library Classification
» Library Classification: Historical Perspectives

Unit I1: Elements of Library Classification
» Types of Classification Schemes: Enumerative Classification Scheme, Analytico-
Synthetic Classification Scheme
» General Theory of Classification
» Normative Principles and Postulates of Classification
» Canons of Classification

Unit I11: Preliminaries of Colon Classification
» Five Fundamental Categories in Colon Classification
» Notation: Definition, Need, Purpose, Types and Qualities of notation
» Isolates: Common Isolate, Time Isolate, Space Isolate, Language Isolate
» Phase and Intra Facet Relation

Unit IV: Colon Classification Scheme
» Historical Background of Colon Classification (CC)
» Structure of Colon Classification (CC)
» Construction of Class Numbers: CC 6th edition
» Research in Colon Classification (CC)
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

EES NS -

o

10.
11.
12.

Ranganathan, S.R. (1956). Colon Classification 6 edition.

Broughton, V. (2004). Essential Classification. London: Facet Publishing.

Dhiman, A. K. & Yashoda Rani. (2005). Learn Library Classification. New Delhi: Ess Ess.
Husain, S. (2004). Library Classification: Facets and Analysis. Delhi: B. R. Publishing.
Jennex, M. E. (2008). Knowledge Management: Concepts, Methodologies, Tools, and
Applications. New York: Information Science Reference.

Kao, Mary L. (2003). Cataloguing and Classification for Library Personnel. Mumbai: Jaico.
Kumar, P. S. G. (2003). Knowledge Organization, Information Processing and Retrieval
Theory. Delhi: B. R. Publishing.

Pathak, L. P. (2000). Sociological Terminology and Classification Schemes. New Delhi:
Mittal Publications.

Ranganathan, S. R. (2006). Philosophy of Library Classification. Bangalore: Ess Ess.
Singh, S. (1998). Universe of Knowledge: Structure & Development. Jaipur: Raj Publishing.
Sood, S. P. (1998). Universe of Knowledge and Universe of Subjects. Jaipur: G. Star Printers.
Taylor, A. G. (2007). Introduction to Cataloguing and Classification (10" ed.). New Delhi:
Atlantic.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3103

Course Title Fundamentals of Computer (Theory)

Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To familiarize the students with the fundamentals of computer, memory, software
and operating systems.

Outcome- After completion of the course, students will be able to understand the basic of
computer, different software, devices, and operating systems etc.

Unit I: Basic Concepts of the Computer
» Computer: Meaning and Definitions
» Evolution and Generations of Computer
» Classification of Computers
» The Computer System and Applications of Computer

Unit I1: Input and Output Devices

» Keyboard, Pointing Devices, Scanning Devices and Optical Recognition Devices

» Digital Camera, Voice Recognition System, Data Acquisition Sensors, and Media Input
Devices

» Display Monitors, Printers, Impact Printers and Non-impact Printers.

» Plotters, Voice Output Systems, Projectors and Terminals

Unit I11: Computer Memory and Software
» Cache Memory, Primary Memory, Secondary Memory
» Static RAM (SRAM), Dynamic RAM (DRAM)
» Types of Computer Software: System Software and Application Software
» System Management Programs and Standard Application Programs

Unit IV: Operating Systems

» Operating Systems: History and Functions

» Process Management, Memory Management, File Management, Device Management,
Security Management

» Types of Operating Systems, Providing User Interface, Popular Operating Systems:
Windows XP, Vista, NT, Linux setting of Desktop

» Microsoft Software: MS Word System, MS Excel System, MS PowerPoint System, MS
Access System, MS Publisher
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Arora, A. & Bansal, S. (2000). Computer Fundamentals. New Delhi: Excel Books.

2. Basandra, S. K. (1999). Computer Today. New Delhi: Galgotia Publications.

3. Chandrasekaran, M., Govindaraju, S., Hug, A., Abdul & Narayanan, T. R. (1996). Elements
of Computer Science. New Delhi: New Age International.

4. Sinha, P. K. & Sinha, P. (2007). Computer Fundamentals. New Delhi: BPB Publication.

5. Stallings, W. (2007). Computer Networking with Internet Protocols and Technology. Delhi:
Pearson Education.

6. file:///C:/Users/ TEMP/Downloads/FundamentalsofComputerStudies.pdf

7. https://ashishmodi.weebly.com/uploads/1/8/9/7/18970467/computer_fundamental.pdf

8. https://nibmehub.com/opac-service/pdf/read/Fundamentals%200f%20Computers.pdf
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3104 A

Course Title Knowledge Society
Type of Paper GE (Generic Elective)
Credit 4

Teaching Hours 60

Objectives: To trace the progress of Information Society, Types of Information Institutions,
Knowledge society, trends and development in learning and society.

Outcome: After completion of the course, students will understand the concept of
Information Society, Information Institutions, Knowledge society, trends and development
in learning and society.

Unit I: Information Society
» Concepts, terminology, factors, and perceptions
» Economic Structure and Information society
» Impact of Information Society on Information Profession; Information Literacy and IT
Literacy
» Information Society and Public Policy

Unit I1: Information Institutions

» Evolution of Information Institutions: Growth Patterns

» Types of Information Institutions: Libraries; Documentation Centres; Information
Analysis Centres; Data Centres; Referral Centres and Clearing Houses; De
institutionalized Information Services

» Institution Building: Prerequisites for Building Institutions; Human Resources.

» Role of Institutions in Knowledge Based Economy

Unit 111: Knowledge Society

» Knowledge Society: Features and Impact on Sectors; Life and Culture in a Knowledge
Society

» Information and Knowledge Industry

» Knowledge Economy: Characteristics; Scope and Ramification

» Indian Society: Digital Divide ; Indian Planning and Targets

Unit-1V Trends and Developments
» Role of Information in Planning, Decision Making, Innovations and National
Developments.
» Impact of Information and Knowledge Society on Education, Training and Research.
Conventional vs Web Based Learning, MOOC
Impact of Social Media on Society and National Development

Y VY
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

10.

11.

12.

13.

Becker, J. (1979). Library Society and Technological Change. Library Trends. 27(3), 409-
16.

Bell, D. (1979). The Social Framework of Information Society. In : Dertouzos, M. L. and
Moses J. (eds.), Computer Age: A Twenty-Year View. Cambridge, Mass: MIT Press. pp.
163-211.

Gunasekara, A. (2003). Knowledge and Information Technology Management: Human
and Social Perspectives. Hershey: Idea Group Publishing.

Lancaster, F. W. (1979). Science, Scholarship and Communication of Knowledge.
Library Trends. 27(3), 367-88.

Matarazzo, J. and Connolly, S. (1999). Knowledge and Special Libraries. Boston
Mathew, J. R. (1980). Choosing and Automated Library System: A Planning Guide.
Chicago: ALA.

Natarajan, G. (2000). Knowledge Management: Enabling Business Growth, New Delhi:
Tata McGraw Hills.

Online Information Provision. London: Oxford University Press.

Powell, T. A. (2000). The HTML Complete Reference. 2nd ed., New Delhi: Tata McGraw
Hill.

Raman, A. T. (2003). Knowledge Management: A Resource Book. New Delhi: Excel
Books.

Seethrama, S. (1997). Information Consolidation and Repackaging, Frame Work,
Methodology, Planning. New Delhi: Ess Ess Publication.

Sollumon, M. R., Marshall, G. W. and Stuart, E. (2004). Marketing Real People, Real
Choices, 4th ed., NJ: Prentice Hall. Trcson, Arizona: Knowledge Computing Corporation.
Weingand, D. E. (1987). Marketing Planning Library and Information Services. Littleton,
Colorado: Library Unlimited.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3104 B

Course Title Historical Development of Library
Type of Paper GE (Generic Elective)

Credit 4

Teaching Hours 60

Objectives- To trace the History and Development of Academic Libraries in India, Role of
Commissions and Committees before and after Independence, Academic Libraries in India
after Independence, Concept and Development of National Library in India and abroad,
various plans and programmes.

Outcome- After completion of the course, students will understand the Objectives and
Functions, History and Development of Academic Libraries in India, National Library in India
and Abroad. Students will be further able to explain the Government's role in library
development through policy directions, planning processes and recommendations of
committees.

Unit I: History of Academic Libraries and their Development
» Academic Library: Objectives and Functions
» History and Development of Academic Libraries in India: Taxila University, Nalanda
University, Vikramshila University, Vallabhi University
» Role of Commissions and Committees before and after Independence
» Libraries in modern India (1757-1947), Academic Libraries in India after Independence

Unit 11: History of National Libraries and their Development

» National Library: Definitions, Objectives and Functions
» Historical Perspectives

» Sections and Services of National Library

» Development of National Library in India, UK, USA

Unit 111: History of Public Libraries and their Development
» Public Library: Definitions, Objectives and Functions
» Public Library: Historical Background
» Sections and Services of Public Library
» Development of Public Library in India, UK, USA

Unit 1V: History of Special Libraries and their Development

» Special Library: Definitions, Objectives and Functions
» Special Library: Historical Background

» Sections and Services of Special Library

» Development of Special Library in India
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

10.

11.

12.

13.

14.

Barman, B. (2011). Library and Society. Krishna Kanta Handiqui State Open University.
Day, A. (1994). The New British Library. London: Library Association Publishing. XII, 265.
Goodrum, C. A. (1980). Treasurers of the Library of Congress. New York: Harry Nabrams,
Inc., 318.

Kumar, K. (1987). Library Organisation. Chapter 9. New Delhi: Vikas.
http://www.knowledgecommission.gov.in/recommendations/libraries.asp

India. (1949). University Education Commission 1948-49. Report. Vol.1. Delhi: Manager of
Publications.

India. Ministry of Education and Youth Affairs. (1959). Report of Advisory Committee for
Libraries, Delhi: Manager of Publications.

India. Ministry of Human Resource Development Department of Culture (1986). National
Policy on Library and Information System - A Presentation. New Delhi. .

Planning Commission (1966). Report of the Working Group on Libraries, New Delhi.
Planning Commission (1984). Report of the Working Group on Modernization of Libraries
and Informatics for the Seventh Five Year Plan 1985-90, New Delhi. Publication, P.110.
Rajagopalan, T. S. (1988). Year's Work in Indian Librarianship, Indian Library Association:
Delhi.

Report of the Working Group of the Planning Commission on Libraries and Informatics for
the Eighth Five Year Plan 1990-95. (1989). New Delhi, Department of Culture.

Report of the Working Group of the Planning Commission on Libraries and Informatics for
the Ninth Five Year Plan 1997-2002. (1996). New Delhi, Department of Culture.

University Grants Commission (1959). University and College Libraries, Containing the
Report of the Library Committee of the UGC and the Proceedings of the Seminar on From
Publisher to Reader held on March 4-7, 1957, UGC: New Delhi.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3104 C

Course Title Human Resource Management
Type of Paper GE (Generic Elective)
Credit 4

Teaching Hours |60

Objectives- To discuss the Meaning, Need and Purpose of Human Resource Management
(HRM), Approach, Challenges and Strategies of HRM, Human Resource Planning and
Financial Planning.

Outcome- After completion of the course, students will understand the concept of HRM,
Macro and Micro approach, Human resource planning for staffing in libraries; the sources
of finance, Financial management in libraries etc.

Unit I: Human Resource Management (HRM)

Meaning and Objectives
Need and Purpose
Concept and Features
Functions and Principles

YV VYV

Unit I1: HRM: Approach, Challenges and Strategies
» Macro and Micro Approach
» Job Analysis, Job Description and Job Specification
» TQM, Six Sigma (Directorate of Distance Education
» Reengineering, Change Management

Unit I11: Human Resource Planning
» Staffing Pattern
» Qualifications, Recruitment and Selection,
» Training and Development
» Continuing Professional Development (CPD)

Unit IV: Financial Management and Financial Planning
» Principals of Financial Management
» Source of Finance for various Libraries
> Library Expenditure
» Methods of Financial for Libraries
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

10.

11.

12.

13.
14.

Kumar, P.S.G. (1988). Manpower Planning for College Libraries. Librarianship and
Library Science Education, edited by Sewa Singh. New Delhi: Ess Ess Publications.
Narayana, G. J. (1991). Library and Information Management. New Delhi: Prentice-Hall
of India

Ranganathan, S. R. (1959). Library Administration. 2nd ed. Bombay: Asia Publishing
House.

Holt, G. (2002). Long-range Financial Planning for Libraries. Bottom Line: Managing
Library Finances, 15(3), 125-8.

Mckay, D. (2003). Effective Financial Planning for Library and Information Services, 2nd
ed. London: Europa.

Prentice, A. E. (1996). Financial Planning for Libraries: 2nd ed. Lanham: Scarecraw Press.
Spyers-Duran, Peter and Thomas W. Mann Jr. (1985). Financing Information Services:
Problems, Changing Approaches, and New Opportunities for Academic and Research
Libraries. Westport: Greenwood Press.

Hisrich, R. D., Peters, M. P. & Shepherd, D. A. (2008). Entrepreneurship, Sixth Edition.
New Delhi: Tata McGraw-Hill

Charantimath P. M., (2008), Entrepreneurship Development & Small Business Enterprise,
Third Edition. New Delhi: Pearson Education.

Desai, V. (2011). The Dynamics of Entrepreneurial Development and Management, Sixth
Edition. Mumbai: Himalaya Publishing House.

Evans, G. E. (1983). Management Techniques for Librarians. 2nd ed. New York:
Academic Press.

Evans, G. Edward and Ward, Patricia L. (2003). Beyond the Basics: The Management
Guide for Library and Information Professionals; New York: Neal-Schuman Publishers.
Griffin, R. (2005). Principles of Management. 4th ed. Boston, MA: Houghton Mifflin.
Indira Gandhi National Open University. (1988). School of Management Studies, MS-2:
Managing Men: New Delhi.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3105

Course Title Hindi Grammar and Composition (&t wITsT 37T Homo)
Type of Paper AEC (Ability Enhancement Course)

Credit 2

Teaching Hours 30
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4-Year Bachelor (Honours with Research) in Library and Information Science
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3106

Course Title Knowledge Organisation I: Classification (Practical)
Type of Paper PC/SEC (Practical course/ Skill Enhancement Course)
Credit 2

Teaching Hours 30

Objectives- To familiarize the students with the practical experience of library classification
using Colon Classification (CC- 6" edition).

Outcome- After completion of the course, students will be able to classify library resources
using Colon Classification (CC- 6" edition) scheme.

Unit I: Colon Classification (CC- 6™ edition)
» Classification of Documents with Complex Subjects
A. Assigning Class Numbers representing Simple, Compound, Complex Subjects according to

Colon Classification (CC- 6™ edition) - 40 Marks
B. Viva Voce — 20 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3107

Course Title Fundamentals of Computer (Practical)

Type of Paper PC/SEC (Practical Course/ Skill Enhancement Course)
Credit 2

Teaching Hours 30

Objective- To provide hands on practice in computer operating systems and different

application software.
Outcome- After completion of the course, students will be able to work on computer operating

systems and application software.
Unit I: Operating Systems

> Window XP, Vista,
> Windows NT- Installation and Functions
» Linux Setting of Desktop

Unit 11: Hands on experience in Application Software

MS-Word

MS-Excel

MS-Power Point

Search Engines and Web Browsing

YV V V

>

Assigning Operating Systems, Hands on experience in Application Software-
40 Marks
B. Viva Voce- 20 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Courter, G. and Marquis, A. (2005) Mastering Microsoft Excel 2002. New Delhi: BPB
Publishers.

2. Cusumano, M. A. and Selby, R. W. (2003). Microsoft Secrets. London: Profile.

Haag, S. (2002). Microsoft Office XP. Boston: McGraw-Hill.

. Johnson, O. and Hanson, R. (2003). Microsoft Word 2002 manual for Gregg College

Keyboard & Document Processing. New York: McGraw-Hill.

Minasi, M. (2001). Mastering Windows XP Professional. New Delhi: BPB Publishers.

Norton, P. et al. (1999). Peter Norton's complete guide to Microsoft Office 2000.

New Delhi: Techmedia.

Perspection, Inc. (2001). Microsoft Word 2002: Simply Visual. New Delhi: BPB Publishers.

Walkenbach, J. (2007). Microsoft Office 2007 Bible. New Delhi: Wiley Publishers.

10. Winston, W. L. (2007). Microsoft Office Excel 2007: Data Analysis and Business Modeling.
New Delhi: Prentice-Hall
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code

BLIS3108 A

Course Title Library and Information Portals
Type of Paper VVAC (Value-Added Course)
Credit 2

Teaching Hours 30

Objectives- To enable students to understand the concept of Library and Information Portals,
its importance, standards and relationship between Users and Portal, Library staff, Portal
and Library Resource sharing and Networking.

Outcome- After completion of the course, students will understand the importance, standards
and relationship between Users and Portal, Library staff and Portal, Library Resource
sharing and Networking.

Unit I: Library and Information Portal

» Library Portal its Meaning, Types and Features
» Importance and Major Elements

» Standards and Evaluation of Library Portal

» Users and Portal, Library Staff and Portal

Unit I1: Library Resource Sharing and Networking

» Concept Definition and Objectives of Resource Sharing

» Areas and Levels of Resource Sharing

» Developments in India (some Case Studies): CALIBNET, DELNET, INFLIBNET
» Resource Sharing through Library Networking: Use and Basic Requirements.
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

10.
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Hofmann, M. A. (2011). Next Generation or Current Generation: A Study of the OPACs of
260 Academic Libraries in the USA and Canada. Library Hi Tech 29 (2): 266-300.

Caplan, P. (2012). On Discovery Tools, OPACs and the Motion of Library Language. Library
Hi Tech, 30 (1), 108-115.

Preece, E., Barbara, G. (2002). Consortia and the Portal Challenge. The Journal of Academic
Librarianship, 28(3), 160-162.

O’Leary, Mick. Grading the Library Portals.
http://www.onlinemag.net/OL2000/oleary11.html

Scheucher, R. (2000). Portals: A Study of Information Portals. Graz: Graz University of
Technology.

Feather, J. and Sturges, P. (eds.). (1997). International Encyclopedia of Information and
Library Science, London: Routledge.

Garkoti, G. K. (2001). Concise Encyclopedia of Library and Information Technology, New
Delhi: Ess Ess Publications.

http://search.epnet.com
http://www2.iicm.edu/cquetl/education/projects/rscheuch/seminar/nodel.html

INFLIBNET Review Committee Report (1996). New Delhi: UGC.

Kaul, H. K. (1992). Library Networks: An Indian Experience. New Delhi: Virgo.

Kaul, H. K. (1996). DELNET: The First Operational Library Network in India. New Delhi:
DESIDOC Bulletin of Information Technology, 16(2), pp. 23-34.

Kaul, H. K.(1999). Library Resource Sharing and Networks. New Delhi: Virgo Publications.
Kent, A. and Galvin, T. (eds). (1979). Structure and Governance of Library Networks:
Proceedings of the 1978. Conference in Pittsburg. New York: Marcel Dekker.

Kent, A. and Galvin, T. (1977). Library Resource Sharing. New York: Dekker.

Kent, A. and Galvin, T. (1979). The Structure and Governance of Library Networks. New
York: Marcel Dekker.

Kent, A. (ed) (1978). Encyclopedia of Library and Information Science. New York: Marcell.
Kumar, P. and Arora, O. P. (1996). Information and Library Network (INFLIBNET)
Programme: New Delhi: DESIDOC Bulletin of Information Technology, 16(Z), pp. 11-22.
Mitra, A. C. (1996). CALIBNET on Stream: New Delhi. DESIDOC Bulletin of Information
Technology, 16(2), 35-45.

Molhott, P. (1989). The Influence of Technology on Library Networking. Special Libraries,
80(8), pp.82-89. New York: SLA.

University Grants Commission (1988). Development of an Information and Library Network
(INFLIBNET) Report of the Inter-Agency Working Group. New Delhi: UGC.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3108 B

Course Title Library 4.0

Type of Paper VVAC (Value-Added Course)
Credit 2

Teaching Hours 30

Objectives- To understand the concept of Library 1.0 to 3.0 and 4.0 meaning, comparison
between Library 1.0, 2.0 and 3.0, Library 4.0, Hardware and software requirements for
Library 4.0 etc.

Outcome- After completion of the course, students will be able to understand the meaning of
library 1.0, 2.0, 3.0 and 4.0, Characteristics and Implementation of library 4.0 etc.

Unit I: Library 1.0 t0 3.0

Library in Digital Age
Library 1.0
Library 2.0
Library 3.0

Y V.V V

Unit Il: Library 4.0

» Library 4.0: Meaning and Definitions

» Concept and Design of Library 4.0

» Hardware and Software Requirements for Library 4.0
» Characteristics and Implementation
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS
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Casey, M. Working Towards a Definition of Library 2.0. Library Crunch, October 2005.
Casey, M. & Savastinuk, L. Library 2.0: A Guide to Participatory Library Service.
Information Today Press, 2007.

Casey, M. & Savastinuk, L. Library 2.0: Service for the Next-Generation Library, Library
Journal, September 1, 2006.

Crawford, W. Library 2.0 and Library 2.0. Cites and Insights, 6, 2, January 2006.

Harris, C. Library 2.0 Week (Updated), Infomancy, January 2006.

Maness, J. Library 2.0 Theory: Web 2.0 and Its Implications for Libraries. Webology, 3(2),
Article 25, 2006.

Aswal, R. S. (2006). Library Automation for 21st Century. New Delhi: Ess Ess Pub.
Kumar, PSG. (2003). Information Technology: Basic Concepts. New Delhi: BR Publishing
Corporations, p9-17.

Kannappanawar, B. U. (2004). Problems and Prospects of Information Technology in R&D
Libraries, Dr. P.S.G Kumar Festschrift Library and Information Profession in India, Vol-1,
Part-2, Delhi: B. R. Publishing Corporation, p612-617.

Miller, P. Web 2.0: Building the New Library. Ariadne, No.45, October 2005.

Miller, P. and Chad, K. Do Libraries Matter?: The Rise of Library 2.0, Talis November 2005.
Miller, P. Library 2.0: The Challenge of Disruptive Innovation. Talis, February 2006.65
O’Reilly, T. Web 2.0: Compact Definition. Radar Blog, 1 October 2005. (http:/
/radar.oreilly.com/archives/2005/10/web_20 compact_definition.html)

O’Reilly, T. What Is Web 2.0? OReilly.net. Posted September 30, 2005. (http:/
Iwww.oreillynet.com/pub/a/oreilly/tim/news/2005/09/30/what-is-web-20.html)

O’Reilly, T. (2005). What is Web 2.0? Retrieved May 18, 2006.
(http://www.oreillynet.com/pub/a/oreilly/tim/news/2005/09/30/what-is-
web20.html#mememap)

Pin, W. W. Library 2.0: The New E-World Order. Library Connect, 5(4), 2, 2007.
Stephens, M. Web 2.0 and Libraries: Best Practices for Social Software. Library Technology
Reports, 42, 4, 2006.

Jagdis, A. (29-30 January, 2009). Innovative Technologies for Building Libraries o
Tomorrow. Open Access to Textual and Multimedia Content: Bridging the Digital Divide
(pp. 49-65). Noida: INFLIBNET Centre, Ahmedabad and CEC, New Delhi.

Shukla, A. & Tripathi, A. (2012). Library 2.0: Tools & Techniques. In National Seminar
on “Innovative Challenges in Information Services" (pp. 74-85). Deptt. of Library &
Information Science, University of Jammu, Jammu. Published by Kutub Publications: New
Delhi.

Noh, Y. (2015). Imagining Library. 4.0: Creating a Model for Future Libraries. The Journal
of Academic Librarianship. http:// dx.doi.org/10.1016/j.acalib.2015.08.020.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code

BLIS3109 A

Course Title Open Access Initiatives
Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours

30

Objectives: To understand the concept and meaning of Open Access Initiatives in India and
in Developing Countries, Open access Journals: availability and usability, Open-Source
Models for Artificial Intelligence, Artificial Intelligence: Emerging tool in research and

development.

Outcome: After completion of the course, students will be able to understand the concept and
meaning of Open Access, Open Access Initiatives in India, Open access Journals its
availability and usability, Open access software for libraries, Open-Source Models for
Artificial Intelligence, Artificial Intelligence: Emerging tool in research and development.

Unit I: Open Access and Possibilities

» Concept and Meaning of Open Access

» Open Access Initiatives in India

» Open Access Journals: Availability and Usability
» Open Access Initiatives in Developing Countries

Unit 11: Open Access Software and Artificial Intelligence

» Open Access E-resources and its Significance

» Open Access Software for Libraries

» Open-Source Models for Artificial Intelligence

» Artificial Intelligence: Emerging Tool in Research and Development
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

9.

10.
11.
12.
13.

Corrado, E. M. (2005). The Importance of Open Access, Open Source, and Open Standards
for Libraries. Issues in Science & Technology Librarianship. 42. http://www.istl.org/05-
spring/article2.html

Ferraro, J. (2006). Why Your Library Needs Open Source.
http://liblime.com/c/welcome.html

Free Software Foundations Software Directory. http://www.fsf.org/

Hebert, E. How  Open-Source  Software Can  Improve Our  Library.
http://www.degreetutor.com/library/managing-expenses/open-source-library

Manoj K. Eds. Proceedings CALIBER 2007: 5 International Convention on Automation of
Libraries in Education and Research Institutions, 1-5.

Mackenzie, A. (2001). Open-Source Software: When is a Tool? What is a Commodity?
Science as Culture, 10(4), 541-552.

Morgan, E. L. (2002). Possibilities for Open-Source Software in Libraries. ITAL: Information
Technology and Libraries. 21(2), 12-
http://www.ala.org/ala/lita/litapublications/ital/2101morgan.cfm

Open-Source Software. Wikipedia. Retrieved February 5, 2008, from Website:
http://en.wikipedia.org/

Source Forge. http://sourceforge.net/

UNESCO Free & Open-Source Software Portal. http://www.unesco.org/
https://platform.openai.com/docs/models
https://platform.openai.com/docs/model-index-for-researchers
https://analyticsindiamag.com/7-open-source-models-from-openai/
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code

BL1S3109 B

Course Title Information, Communication and Society
Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours

30

Objectives- To understand the meaning of information, communication and society,
information industry, use of information in society and role of LICs in modern society.
Outcome- After completion of the course, students will be able to understand the meaning of
information, communication and society, information industry, use of information in society
and role of LICs in modern society.

Unit I: Information and Communication

» Information: Concept, Types, Models and Theories
» Information: Channels and Barriers

» Trends in Scholarly Communication

» Information Industry

Unit I1: Information and Society
» Role of Library and Information Centres in Modern Society
» Information: Characteristics, Nature, and Value
» Use of Information in Society
» Emergence of Social Networking Sites
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

2.

10.

11.

12.

13.

14.

15.

A. V. (1985). Concise Encyclopaedia of Information Technology. 2nd ed. London: Gower.
114-115.

Aggarwal, B. (2002), Media and Society: Challenges and Opportunities, Concept Publishing
Company, New Delhi.

Baker, K. (1982). The Impact of Information Technology. Amsterdam: North Holland. pp.
77-80.

Baran, S. J. (2007). Introduction to Mass Communication: Media Literacy and Culture Ed.
4, McGraw Hill New York 2007.

Bowden, D. and Blakeman, K. (1990). Going, Automated: Implementing and Using
Information Technology in Libraries and Information Units. London: ASLIB.

Deming, C. J. and Samuel L. B. (1988). Media in Society: Readings in Mass Communication,
Scott, Foresman and Company, Glenview, Illinois, 1988.

Finnegan, R. (1989). Communication and Technology. Linguistics and Communication.
9(3), 107-127.

Kochen, M. (1981). Technology and Communication in Future. JARS. 148-157. McGraw-
Hill Encyclopaedia of Science and Technology (1992): An International Reference Volume
Including Index 7th ed. New York: McGraw Hill. VVol. 18, p.151.

Peltu (1982). Information Technology: An Overview. Taylor, H. (ed.). Information
Alanagement and Organisational Change. London: ASLIB. pp.81-86.

Singh, P and Khanna, J. K. (1994). Information Technology in Libraries. Delhi: Pragati
Publications.

Rajan, T. N. and Satyanarayana, R. (1987). Application of Information Technologies in India.
Handbook of Libraries and Information Centres in India. New Delhi: Information Industry
Publications.

Satyanarayana, R. (1991). Information Technology and University Libraries in India.
Prasher, R.G. ed. University Libraries in India: 1980s and Beyond. New Delhi: Medallion.
Pp.19-50.

Satyanarayana, R. (1996). Information Technology and Its Facets. New Delhi: Mamak
Publications.

Smith, R. L. and Cambell, B. (1982). Information Technology Revolution. New York:
Longman, Stokes.

Straubhaar, J. and Rose R. La. (2000). Media Now: Communication Media in the Information
Age, Wadsworth Thomson Learning.
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4-Year Bachelor (Honours with Research) in Library and Information Science

I°T YEAR, SEMESTER- II

Course Code BLI1S3201

Course Title Management of Library and Information Centers

Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4
Teaching Hours |60

Objectives- To make the students understand the management techniques in organization
of Library & Information Centers.

Outcome- After completion of the course, students will be able to manage the Library &
Information Centers effectively.

Unit I: Principles of Library Management
» Management: Concept, Definitions, Scope and Functions
» Principles of Management
» Schools of Management Thought: Classical Management Theory, Neo-Classical Theory,
Modern Management Theory, Problems and Conflicts in Management Theories.
» Management Functions

Unit 11: Physical Resource Management and Library House Keeping Operations

» Library Building: Site, Selection, Planning; Furniture, Fittings and Equipment:
Standards and Specifications

» Collection Development and Management

» Acquisition Section, Technical Section, Circulation Section, Maintenance Section,
Periodical Section and Reference Section; Stock Verification and Rectification: Policies
and Procedures

» Preservation and Conservation

Unit 111: Human Resource Management
» Human Resource Management: Organizational Structure, Job Description and Analysis
» Personal Relations: Selection, Recruitment, Training, Development, Performance
» Appraisal Motivation: Group Dynamics, Training and Development
» Resource Mobilization and Outsourcing

Unit 1V: Financial Source
> Library Finance and Sources of Finance,
> Library Budgeting Techniques.
» Cost Effectiveness and Cost Benefit Analysis.
» Library Statistics and Annual Report
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

10.
11.

12.

13.

Bryson J. (1996). Effective Library and Information Management. Bombay: Jaico Pub.
House

Beardwell, 1. and Holden, L. (1996). Human Resource Management: A Contemporary
Perspectives. London: Longman.

Chabhra, T. N. et. al. (2000). Management and Organization. New Delhi: Vikas.

Drucker, P. F. (2002). Management Challenges for the 21st century. Oxford; Butterworth
Heinemann.

Evans, G. E. and Layzell, P. (2007). Management Basics for Information Professionals,
Second Edition. London: Libraries Unlimited.

Johnson, P. (2009). Fundamentals of Collection Development and Management, 2nd ed.
ALA

Kotler, P. (2003). Marketing Management. 11thed. New Delhi: Pearson.

Narayana, G. J. (1991). Library and Information Management. New Delhi: Prentice Hall of
India.

Paton, R. A. (2000). Change Management. New York: Response Books.

Rowley, J. (2001). Information Marketing. Aldershot: Ashgate Publishing Limited.

Smith, J. R., M, L. G. and Kallaus N. F. (2010). Records Management. 7th ed.
Southwestern, Division of Thomson Learning.

Stueart, R. D. and Moran (Barbara B. Moran). (2007). Library and Information Centre
Management. 7th ed. London: Libraries Unlimited.

Stoner, J. A. F. (et. al). (1996). Management: Global Perspectives. 10thed. New York: MC
Graw Hill Inc.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3202

Course Title Knowledge Organization II: Cataloguing (Theory)
Type of Paper DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours |60

Obijectives- To accustom the students with the organization of knowledge with different
basic concepts and philosophies of library cataloguing.

Outcome- After completion of the course, students will understand the basic concept
and philosophies of library cataloguing, rules of filing entries and subject headings in
cataloguing and different bibliographic standards.

Unit I: Concept of Cataloguing

» Catalogue: Definition, Objectives
» Purpose and Functions of Catalogue
» Types and Physical Forms of Catalogue

>

Introduction to: CCC, AACR-IIR

Unit I1: Types of Catalogue Entries

>
>
>
>

Kinds of Entries and their Elements of Description in CCC and AACR-1IR
Filing of Entries: Classified and Alphabetical

Elements of Bibliographic Description of Non-Book Material (AACR-IIR)
Rules for Choice and Rendering of Headings in AACR —IIR

Unit 111: Standards of Bibliographic Description and Record Formats

YV V.V YV

ISBD, FRAD (Functional Requirements for Authorized Description)

GARR (Guidelines for Authority Records and References)

RDA (Resource Description and Access)

ISBN (International Slandered Book Number), ISSN (International Standard Serial
Number)

Unit IV: Current Trends in Library Cataloguing

>

>
>
>

Metadata: Meaning and Purpose
Use of Metadata and its Types
Metadata: MARC 21
DUBLINCORE
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

no

10.
11.

12.
13.
14.

15.
16.

17.
18.

Andrew, P.G. (2003). Cataloguing Sheet Maps. London: Haworth Press.

Aswal, R. S. (2004). MARC21: Cataloging Format for 215t Century. New Delhi: Ess Ess.
Dhawan, K.S. (1997). Online Cataloguing Systems. New Delhi: Commonwealth
Publication.

Dhiman, Anil K. (2004). Cataloguing of Non-book Materials. New Delhi: Ess Ess.
Girija Kumar & Krishan Kumar. (2004). Theory of Cataloguing. New Delhi: Vikas
Gredley, Ellen & Hopkinson, Alan (1990). Exchanging Bibliographic Data: MARC and
other International Formats. Ottawa: ALA.

Hagler, Ronald & Simmons, Peter. (1991). The Bibliographic Record and Information.
J.S.C. ed. (2002). Anglo-American Cataloguing Rules. London: Canadian Library
Association.

Kao, Mary L. (2003). Cataloguing and Classification for Library Personnel. Mumbai:
Jaico.

Leigh, Gernert. (2003). A Textbook of Cataloguing. New Delhi: Dominant Publishers.
Mitchell, Anne M. & Surratt, Brian E. (2005). Cataloguing and Organizing Digital
Sources. London: Facet Publishing.

Roe, Sandra K (2002). The Audio-Visual Cataloguing. New York: Haworth Press.
Sharma, Pandey S.K. (2001). Library Cataloguing Theory. New Delhi: Sahitya Prakashan
Singh, S.N. & Prasad, H.N. (1985). Cataloguing Manual AACR-II. New Delhi: B.R.
Publishers.

Sood, S.P. (1999). Theory of Library Cataloguing. Jaipur: Raj Publishing House.

Taylor, A.G. (2007). Introduction to Cataloguing and Classification (10™ed.). New Delhi:
Atlantic.

Viswanathan, C. G. (2008). Cataloguing Theory and Practice. New Delhi: Ess Ess
https://egyankosh.ac.in/handle/123456789/32995
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3203

Course Title Collection Development and Management of E-Resources (Theory)

Type of Paper DSC (Discipline Specific Core Course) Compulsory

Credit 4

Teaching Hours |60

Obijectives- To make the students aware about collection development and different types of
e-resources and their use.

Outcome- After completion of the course, students will be able to differentiate and utilize e-
resources for their learning and research activities.

Unit I: Electronic Resources: An Overview
» E-Resources: Introduction, Advantages, Disadvantages
E-Resources Life Cycle
Standards for E-Resources
Open Access Initiatives

vV V VY

Unit I1: Types of Electronic-Resources
» E-Journals & E-Books
» Databases, CD-ROM Databases
» Internet Resources
» Library Consortium, Criteria Evaluation of E-Resources

Unit 111: Web Resources
» Web Resources — Introduction, Needs
» Science & Technology
» Humanities & Social Sciences
» Evaluation of Web Resources

Unit IV: Collection Development and Management of Electronic Resources
» Collection Development of E-Resources
» Policy for E-Resources
» Licence and Agreement for Procurement of E-Resources
» Case Study of Digital Library
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Frank Rennie & Robin Mason. (2011). e-Learning and Social Networking Handbook:
Resources for Higher Education.

2. James E. Bobick and G. L. Berard (2011). Science and Technology Resources: A Guide
for Information Professionals and Researchers (Library and Information Science Text Series).

3. Karin Wikoff. (2011). Electronic Resources Management in the Academic Library: A
Professional Guide.

4. Peter Clayton and G. E. Gorman. (2001). Managing Information Resources in Libraries:
Collection Management in Theory and Practice.

5. Ruth C. Clark & Richard E. Mayer. (2011). e-Learning and the Science of Instruction: Proven
Guidelines for Consumers and Designers of Multimedia Learning (Essential Knowledge
Resource).
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3205

Course Title English Grammar and Composition
Type of Paper AEC (Ability Enhancement Course)
Credit 2

Teaching Hours 30

Obijectives- The course is designed to provide the students a formal knowledge of English
Grammar. Enable students to have command over sentence construction in English. Enable
students to have competence in both spoken and written English. Train students to use the
language with confidence and without committing errors.

Outcome- After completion of the course, students will be able to understand and enhance their
skills in Sentence structure, Speech, Paragraph Writing, Comprehension, Summarizing and

Paraphrasing.

Unit I: Sentences and Narration

» Types of Sentences

» Parts of Speech

» Active and Passive Voice
» Direct and Indirect Speech

Unit 11: Clauses and Composition

» Idioms and Phrases

» Synonyms and Antonyms

» Paragraph Writing and Comprehension
» Summary and Paraphrasing
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

Prism: Spoken and Written Communication

Crystal, David. (1985). Rediscover Grammar with David Crystal. Longman

Bakshi, R. N. A Course in English Grammar. Orient Longman

Close, R. A. Reference Grammar for Students of English. Orient Longman

Hewings, M. (1999). Advanced English Grammar. Cambridge University Press

Murphy, Raymond: Essential English Grammar Answers

Aroor, Usha (Ed.) Word Master Learner’s Dictionary of Modern English. Orient Longman
Krishnaswamy, N. Modern English — A Book of Grammar, Usage & Composition.
Macmillan India Ltd.

i S A A o

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar
Page 45 of 185



4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3206

Course Title Knowledge Organization 11: Cataloguing (Practical)
Type of Paper SEC (Skill Enhancement Course)

Credit 2

Teaching Hours 30

Obijectives- To acquaint the students with the cataloguing practical of various types of library
resources using Classified Catalogue Code (CCC- Latest edition).

Outcome- After completion of the course, students will be able to catalogue library resources
by using Classified Catalogue Code (CCC- Latest edition) and use of subject headings.

Unit I: Classified Catalogue Code (CCC- Latest edition)

Works of Single and Shared Authorship

Works of Mixed Responsibilities

Editorial Publications, Series Publications Multi-volume, Works & Pseudonymous
Works of Corporate Authorship (Government, Institution and Conference), Periodical
Publications

» Ordinary and Artificial Composite Books

YV V VYV

A) Assigning Classified Catalogue Code (CCC- Latest edition)- 40 Marks

B) Viva Voce - 20 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code

BLI1S3207

Course Title Collection Development and Management of E-Resources (Practical)
Type of Paper SEC (Skill Enhancement Course)

Credit 2

Teaching Hours |30

Objectives- To acquaint the students with the collection development and management of e-
resources in various types of libraries.

Outcome- After completion of the course, students will be able to learn the practical works or
tasks performed in the process of collection development and management of e-resources.

Unit I: Access of E-resources Through the Internet or Locally

E-Books

E-Images

VVVVYVYVYY

E-Journals

Full-Text (aggregated) Databases

Indexing and Abstracting Databases

Reference Databases (Biographies, Dictionaries, Directories, Encyclopedias, etc.)
Numeric and Statistical Databases

E-Audio/Visual Resources

Unit I1: Technical Practicability

» Availability: Remote Access, Stand-Alone Access.

» Authentication: IP [Internet Protocol] Filtering or Login Password.
» Storage and Maintenance: Remote Hosting, Local Hosting.

» Platforms which Facilitate Access to E-Resources.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3209 A

Course Title Internet of Things (10T)

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours

30

Obijectives- This program aims to train students to be equipped with a solid theoretical
foundation, systematic professional knowledge, and strong practical skills in the loT

Platform.

Outcome- After completion of the course, students will be able to understand the vision of
0T from a global perspective, understand its applications, determine its market perspective,
using gateways, devices, and data management, building a state of art architecture in loT

and its applications in

commercial building automation.

Unit I: Internet of Things (1oT)
» Internet of Things: Meaning and its Importance

> Elements of an

loT Ecosystem

» Trends and Implications

» Web of Things

Unit I1: 10T Networking Core
» Technologies Involved in 10T Development
» Internet Web and Networking Technologies
» Infrastructure, Overview of 10T
»  Wireless Networking Equipment and Configurations

Unit I11: 10T Architecture
» loT Architecture
» Remote Monitoring and Sensing
» Remote Controlling and Performance Analysis
» Sensors and Sensor Node

Unit IV: 10T Application Development & Security
» Application Protocols

» HTML & CSS

» Security and Privacy
» 1oT Applications for Industry
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Vijay Madisetti and Arshdeep Bahga, “Internet of Things (A Hands-on-Approach)”,
1st Edition, VPT, 2014

2. Adrian McEwen, Hakim Cassimally, “Designing the Internet of Things”, November
2013, John Wiley and Sons.

3. Francis da Costa, “Rethinking the Internet of Things: A Scalable Approach to
Connecting Everything”, 1st Edition, Apress Publications, 2013

4. CunoPfister, Getting Started with the Internet of Things, O“Reilly Media, 2011, ISBN:
978-14493- 9357-1

5. Dr. Ovidiu Vermesan, Dr. Peter Friess “Internet of Things: Converging Technologies
for Smart Environments and Integrated Ecosystems”, River Publishers

6. Zach Shelby, Carsten Bormann, “6LoWPAN: The Wireless Embedded Internet”, John
Wiley and Sons.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code

BL1S3209 B

Course Title RFID Implementation
Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours

30

Obijectives- This program provides students’ knowledge of Radio Frequency Identification
(RFID) Technology, its theoretical aspects and implementation and functions of RFID in

libraries.

Outcome- After completion of this course, students will have the knowledge of the Radio
Frequency ldentification (RFID). Students will learn the structure, operation, standards,
Components of RFID systems, tags, reader, advantages and limitations of RFID technology.
Also, the instructions on how to plan, design and implement a solution using RFID technology.

Unit I: Fundamentals and Operating Principles of RFID
» Introduction and History of RFID
» RFID Tag Components: Tag Antenna, Integrated Circuits, Substrate
» RFID Tag Types: Passive Tags, Active Tags
> Zigbee and Wi-Fi Tags

Unit I11: Fundamentals and Operating Principles of Sensors
» Types of Sensors

> Use of Sensors

» Basics of Sensor Design
> Wireless Sensors and Wireless Sensor Network

Unit I11: Design of RFID-Enabled Sensor

> RFID Antenna

Design

» Antenna Basics and Dipole
> Passive RFID Antenna
» Active RFID-Enabled Sensor

Unit IV: RFID Applications
» Short Range RFID Applications
» Long Range RFID Applications
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

2.

10.

11.

12.

13.

14.

V. Daniel Hunt, Alber Puglia, Mike Puglia, “RFID: A guide for radio frequency
identification”, Wiley & Sons, Inc., Publication, 2011

Amin Rida, LiYang, Manos Tentzeris, “RFID-Enabled Sensor Design and
Applications”. 2nd Edition, ARTECH HOUSE, 2010.

Steven Shepard, “Radio Frequency Identification”, 1st Edition, McGraw Hill, 2011.
Jung, K.& Lee, S (2015). A Systematic Review of RFID applications and Diffusion:
Key Areas and Public Policy Issues. Journal of Open Innovation: Technology, Market
and Complexity, 1(9), 1-19.

Kaur, M. et.al. (2011). RFID Technology Principles, Advantages, Limitations & its
applications. International Journal of Computer and Electronical Engineering, 3(1),
151-157.

Krishnan, V. (2021). Application of RFID Technology in Library: A view. Materials
Today: Proceeding.

Mittal, A. et. al. (2010). RFID: A Complete Security System for Libraries. Emerging
Technologies and Changing Dimensions of Libraries and Information Services, 327-
331.

Nagalakshmi, R. (2017). Authentication of RFID technology in academic libraries: A
survey. LIS Digest, 1(1).

Pal, K. & Sharma, A.K. (2017). Implementation of RFID technology in library.
International Journal of Digital Library Services, 7(2), 70-79.

Rajeswari, S. M. (2017). RFID Technology: Mechanism and Usage in Library.
International Journal of Library and Information Studies, 7(4), 130-135.

Sammi, S. & Singh, 1. (2020). A Comprehensive Review of RFID Technology.
International Journal of Advance Science and Technology, 29(10), 5977-5986.

Singh, R. & Sultana S. (2010). RFID: A System or Library & Information Centre.
Proceeding of 5th ILA Conference on Library and Information Science in Digital Era,
January 21-24, 174-178.

Syad, S. (2005). Use of RFID Technology in libraries: A New Approach to Circulation,
Tracking, Inventorying and Security of Library Materials. Library Philosophy and
Practice, 8(1), 1-10.

Want, R. (2006). An Introduction to RFID technology. IEEE Pervasive Comput 5(1),
25-33.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3210
Course Title Internship
Type of Paper Internship
Credit 4
Teaching Hours 60
Objectives-

i. To train the students in practical librarianship in the working environment of the library
by deputing them in different types of libraries for a period of one month; and
ii. To train them in preparing the Internship Report in a prescribed format based on their
practical training and learning.
Outcome- After completion of the course, students will be able to works in Library without any

hesitation.

The work for paper shall start in the beginning of the SECOND semester for which each student
will be allotted a topic for writing the Report. The Report will be submitted at the end of
SECOND semester on the date to be decided by the Department.

A. Report on Internship Programme — 40 Marks
B. Viva-Voce — 20 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

IIN°YEAR, SEMESTER-III

Course Code BLI1S3301

Course Title Information Source, System and Services

Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To make the students understand different types of information source, systems and
services with their specific features and characteristics.

Outcome- After completion of the course, students will be acquainted to provide differenttype of
information services in library & information centers.

Unit I: Sources of Information
» Information Sources: Meaning, Definition, Importance, Nature, and Characteristics

» Sources of Information: Primary Information Source, Secondary Information Sources,
Tertiary Information Sources

» Primary, Secondary and Tertiary Information Sources (Print and Electronic)

» Criteria for Evaluation of Reference Sources

Unit I1: Electronic Information Resources
» Electronic Resources: Meaning. Need and Types

» Subject Gateways, Web Portals, Bulletin Boards and Discussion Forums/Groups
» Databases: Bibliographic, Numeric, Full text Databases and Open Access Databases
» Evaluation of Web Resources

Unit I11: Information Services
» Information Services, Types of Information Services: Reference Service, Referral Service,

Bibliographic Service, Translation Service, Indexing & Abstracting Services, Reprographic
Service, CAS/Alerting Service, SDI.

» Internet based Information Services Library 2.0 and 3.0: Concepts, Characteristics &
Components

» Synchronous Communication & Content Delivery: Instant Messaging, RSS Feeds,
Streaming Media, Podcasts, VVodcasts, SMS Enquiry Service

» Collaborative Publishing Tools: Blogs & Wikis, Collaborative Service Platforms: Social
Networks, Tagging, Social Bookmarking

Unit IV: Information System and Programmes
» Categories of Information Systems: Libraries, Documentation Centres, Information

Clearing Houses, Referral Centres, Information Analysis Centres, Databanks
» Different kinds of Information Systems: Decision Support Systems, MIS, GIS
» Information Systems and Programmes at the Global Level
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RECOMMENDED BOOKS

1.

Guha, B. (1999). Documentation and Information Services (2nded.). Calcutta: World
Press.

Krishan Kumar. (1984). Reference Service. New Delhi: Vikash Publication.

Lancaster, F. W. (1998). Indexing and Abstracting in Theory and Practice. Illinois:
University of Illinois.

Panley, E. P. C. (1979). Technical Paper Writing Today. Boston: Houghton.
Ranganathan, S. R. (1991). Reference Service. Bangalore: Sarada Ranganathan
Endowment.

Seetharama, S. (1997). Information Consolidation and Repackaging Framework,
Methodology, Planning. New Delhi: Ess Ess Publications.

Walford, A. J. (1968-70). Guide to Reference Materials (3 Vols). London: Library
Association.

Gupta, Sangita. (2012). Innovative Challenges in Information Services. New Delhi:
Kutub Publications.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3302

Course Title Knowledge Management

Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To make the students aware of need and concepts of knowledge management in
library.

Outcome- After completion of the course, students will be aware of the application of
knowledge management in libraries & information centres.

Unit I: Basics of Knowledge Management
» Concept of Knowledge

> Types of Knowledge: Explicit Knowledge and Implicit Knowledge
» Concept and Scope of Knowledge Management
» Knowledge Management Cycle

Unit I1: Knowledge Management: Creation & Tools
» Knowledge Creation, Access, Transfer and Sharing

Knowledge Tools
Knowledge Networks
Knowledge in Decision Making

Y V V

Unit I11: Pre-requisites of Knowledge Management
» Sharing of Expertise

» Knowledge Mapping
» Knowledge Worker

Unit IV: Trends and Challenges of Knowledge Management
» KM Initiatives in Indian Organization

» Software for Knowledge Management
» Pioneers in Knowledge Management
» Advances in Knowledge Management
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RECOMMENDED BOOKS

1.

10.

11.

12.

Anderson, Paul. (2012). Web 2.0 and beyond: principles and technologies. Boca
Raton: CRC Press

Cappelli, Peter. (2010). The performance effects of it-enabled knowledge
management practices. Cambridge, MA; National Bureau of Economic
Research

Carl Frappaolo. (2006). Knowledge Management. Amazon.com

Christee Gabour Atwood. (2009). Knowledge Management Basics (ASTD
Training Basics Series.Amazon.com

Donald Hislop. (2009). Knowledge Management in organization.Amazon.com
Elias M. Awad. (2010). Knowledge Management: Updated 2nd Edition (2010
Second Edition). Amazon.com.

Easterby-Smith, Mark & Lyles, Marjorie A. (2011). Handbook of
organizational learning and knowledge management. Chichester, West Sussex :
Wiley,

Guilin, Guangxi Zhuangzu Zizhiqu. (2006). Advances in knowledge acquisition
and management; Pacific Rim Knowledge Acquisition Workshop, PKAW. New
York: Springer,

Irma Becerra-Fernandez and Rajiv Sabherwal. (2010). Knowledge Management
System and Processes.Amazon.com

J. Paul Peter and James H. Donnelly. (2010). Marketing Management:
Knowledge and Skills, 10th Edition. Amazon.com

Jay Liebowitz. (2012). Knowledge Management Handbook: Collaboration and
Social Networking, Second Edition .Amazon.com

Kimiz Dalkir and Jay Liebowitz. (2011). Knowledge Management Theory &
Practice.Amazon.com
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Course Code BL1S3303

Course Title Knowledge Organization I11: Advanced Classification (Theory)
Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Obijectives- To apprise the students with the organization of knowledge with different basic
concepts and philosophies of library classification.
Outcome- After completion of the course, students will understand the basic concept and
philosophies of library classification, functions of different classification schemes available
and recent trends and developments in the subject.

Unit I: Elements of Library Classification
» Mapping of Universe of subjects in major schemes of Library classification
» Species of Classification Schemes
» Modes of Formation of Subjects

Unit I1: Classification Theory and Approaches
» Postulational Approach and System approach to classification
» Facet Analysis and Facet Sequence
» Phase Relation, Common Isolates
» Devices in Library Classification

Unit I11: Traditional and Special Classification Schemes
» Library of Congress Classification (LCC)
» Bibliographic Classification (BC)
> Expansive Classification (EC)
» Broad System of Ordering (BSO)

Unit 1V: Contemporary Issues in Classification
» Current Trends in Library Classification
» Technological issues in Library Classification
» Online Classification and OCLC
» Basic Competencies required in Knowledge Organisation
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RECOMMENDED BOOKS

1.
2.

10.

11.

Broughton, Vanda. (2004). Essential Classification. London: Facet Publishing.
Dhiman, A. K. & Yashoda Rani. (2005). Learn Library Classification. New
Delhi: Ess Ess.

Husain, Sabahat. (2004). Library Classification: Facets and Analysis. Delhi: B.R.
Publishing.

Jennex, Murray E. (2008). Knowledge Management: Concepts, Methodologies,
Tools and Applications. New York: Information Science Reference.

Kao, Mary L. (2003). Cataloguing and Classification for Library Personnel.
Mumbai: Jaico.

Kumar, P. S. G. (2003). Knowledge Organization, Information Processing and
Retrieval Theory. Delhi: B. R. Publishing.

Pathak, L. P. (2000). Sociological Terminology and Classification Schemes.
New Delhi: Mittal Publications.

Ranganathan, S. R. (2006). Philosophy of Library Classification. Bangalore:Ess
Ess.

Singh, Sonal. (1998). Universe of Knowledge: Structure & Development.Jaipur:
Raj Publishing.

Sood, S. P. (1998). Universe of Knowledge and Universe of Subjects. Jaipur: G.
Star Printers.

Taylor, A. G. (2007). Introduction to Cataloguing and Classification (10thed.).
New Delhi: Atlantic.
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Course Code BLI1S3304 A

Course Title Remote Access of Electronic Resources
Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Obijectives- To make the students aware about electronic resources and remote access.
Outcome- After completion of the course, students will be able to understand the concepts of
electronic resources and remote access.

Unit I: Electronic Resources: An Overview

» E-Resources: Introduction, Advantages and Disadvantages
» E-Resources Life Cycle

» Standards for E-Resources

» Open Access Initiatives

Unit I1: Types of Electronic Resources

» E-Journals & E-Books

» Databases, CD-ROM Databases

» Internet Resources

» Library Consortium, Criteria Evaluation of E-Resources

Unit I11: Remote Access

» Remote Access: Meaning, Definitions, Need and Purpose.
» Historical Background of Remote Access

» Advantages and Disadvantages of Remote Access

» Protocols and Rules for Remote Access

Unit 1V: Remote Access Platforms and Tools

» Proxy Server, Virtual Private network (VPN)
» EZproxy, Library Discovery System

» TeamViewer, AnyDesk, LogNeln, MyLOFT
» Knimbus, RemoteXS, Refread and INFED
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RECOMMENDED BOOKS

1.

10.

11.

12.

Harris, Robert (2000). Evaluating Internet Research Sources. VirtualSalt.
(http://www.virtualsalt.com/evalu8it.htm).

IGNOU. PGDLAN. MLI-005. Internet Resources. New Delhi: IGNOU.

Frank Rennie & Robin Mason. (2011). e-Learning and Social Networking Handbook:
Resources for Higher Education. Amazon.com

James E. Bobick and G. L. Berard (2011). Science and Technology Resources: A Guide
for Information Professionals and Researchers (Library and Information Science Text
Series). Amazon.com

Karin Wikoff. (2011). Electronic Resources Management in the Academic Library: A
Professional Guide. Amazon.com
https://digitalcommons.unl.edu/cgi/viewcontent.cgi?article=14315&context=libphilpr
ac

Dixit , Gopal Prasad. (2018). Off Campus Access to Licensed E-resources of Central
Library Central University of Karnataka Through Knimbus: A Study. International
Journal of Creative Research Thoughts, 6(1), 1004-1008.

Choukimath, Puttaraj A. (2011). Remote Access to Electronic Resources Using Virtual
Private Network (Vpn) At Tiss Library. ICDLEIMC

Akpunonu , Anulika. (2022). Influence of Electronic Reference on Users’ Satisfaction
in Academic Libraries. Library Philosophy and Practice (e-journal). 6882.

Akwang, Nse E. PhD, CLN. (2022). A Study on the Use of Academic Social
Networking Sites (Asnss) By Professional Librarians In Public Universities In Akwa
Ibom State, Nigeria. Library Philosophy and Practice (e-journal). 6962.

Millie Jackson, Ayse Gider, Celeste Feather, Kelly Smith, Amy Fry, Jamene Brooks-
Kieffer, Christopher D. Vidas and Rose Nelson.(2007). Electronic Resources &
Libraries, 2nd Annual Conference 2007. Library Hi Tech News, 4-17.

Singh, S. P. (2003). Evaluation of Electronic Reference Sources. DESIDOC Bulletin of
Information Technology, 23(2), 42-47.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3304 B

Course Title Library Consortia

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware about library consortia, consortia in India and
other countries.

Outcomes- After completion of the course, students will be able to understand library
consortia in detail and know about various consortia in India and abroad.

Unit I: Introduction to Library Consortia

» Library Consortia: Meaning, Definitions and Need.
» Growth of Library Consortia

» Obijectives of Library Consortia

» Advantages of Library Consortia

Unit I1: National Consortia

» INDEST, ICMR e-Consortia

> FORSA, SPACENET, CeRA

» UGC-INFONET, HELINET, NKRC

» CSIR E-Journals Consortium, 1IM Consortium

Unit 111: International Consortia

> IDAL, CARLI
» KERIS, SANLIC
» CONCERT, EIFL
» CURL, ICOLC

Unit IV: National and International Library & Information Networks

» Library & Information Networks in India: INFLIBNET, DELNET, CALIBNET
> ADINET, MYLIBNET, MALIBNET, BONET
> International Library Networks: OCLC, RLG, JISC, JANET and CALIS
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RECOMMENDED BOOKS

1.

16.

17.

18.

19.

20.

Ball, David (2002). Consortium Purchase of Electronic Resources by Public Libraries
in England: Museums. Libraries and Archives, UK, available at -
chttpc//:www.peoplesnetwork.gov.uk/documents/rel 78-01.pdf>

Biswas, Band Dasgupta, S. (2001) Opportunities for Libraries in Managing and
Resource Sharing through Consortia: A New Challenge for Indian Librarians.

Chand, Prakash and Mahesh, G. (2003). CSIR E-Journals Consortium. In: Proceedings
of the Annual Conference of the Society for Information Science. Roorkee: Indian
Institute of Technology.

Evans, Edwards (2002). Management Issues of Consortia. Part Two. Library
Management. 23(617), 275.

Hiremath, Uma (2001). Electronic Consortia: Resource Sharing in the Digital Age.
Collection Building. 20(2), 80-87.

http://paniit.iitd.ac.in/indest

http://web.inflibnet.ac.in/econsortialindex.htm.

http://www.curl.ac. uk/.
http://www.keris.or.kr/.

. http://www.rguhs.ac.in/hn/newhell.htm.

. http://www.stic.gov.tw/fdb.

. INFLIBNET Newsletter, October - 2003 to March 2004, 9 (4) and 100).

. Kaul, H. K. (1999). Library Resource Sharing and Networks. New Delhi: Virgo.

. Landesman, M and Reenen, J. Van (2000). Consortia vs. Reform: Creating Congruence.

The Journal of Electronic Publishing. 6(2).

. Nfila, Reason Baathuli and Darko-Ampem, Kwasi (~002). Developments in Academic

Library Consortia from the 1960s through to 2000: A Review of the Literature. Library
Management. 23(4/5), 203-212.

Sayers, Richard (2004). A Smart Place in the Sun: Future-proofing the Queensland
Government Libraries Consortium. Library Management. 25(617), 283.

Balakrishnan, Shyam. Networking and the Future of Libraries. New Delhi: Ess Ess,
2000.

Basandra, Suresh K. Computer Today. New Delhi: Galgotia, 1999.

Kaul, S. Information resource sharing models in developing countries: a network
emerging from the World Bank supported environmental management capacity
building project.

National Commission on Libraries and Information Science. Towards a National
Progress for Libraries and Information Services: Goals for Action. Washington: Govt.
Printing Office, 1975.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3304 C

Course Title Library and Information Science Profession
Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware about LIS profession and categories of LIS
professionals.

Outcomes- After completion of the course, students will be able to understand the LIS
profession in detail and various categories of LIS professionals.

Unit I: Introduction to Library & Information Science Profession

» Profession: Introduction, Definitions, Characteristics
Profession and Occupation

LIS as a profession

Evolution of the LIS profession

Y YV V

Unit Il: Transformation of the LIS Profession

» Custodian, Librarian

» Documentation Officer

» Information Officer/Scientist
» Digital Librarian

Unit I11: Categories of LIS Professionals

» Library Administrator, Classifier, Cataloguer, Classificationist
> Reference Librarian, Thesaurus Designer, Bibliographer

» LIS Teacher, Bibliometrician

» Content Developer

Unit IV: LIS Profession in India

» Ancient Period
» Medieval Period
» British India

» Independent India
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RECOMMENDED BOOKS

1. Bhattacharya, G. Information Sciences. Calcutta: IASLIC, 1978. Print.

Butler, P. “Librarianship as a Profession”. Library Quarterly 21 (1951): 237. Print.

3. Chopra, H.R., U.C. Sharma and M.K. Srivastava. “Library Science and its Facets”. 2
vols. Delhi: Ess Ess, 1998. 572. Print.

4. Dakhole, P.S. “Librarianship as a Profession”. Library and Information Profession in
India: Dr P.S.G. Kumar Festschrif. Vol.1, Part 1. Reflections and Redemptions Ed C.
P. Vashisht and M. P. Satija, et al. Delhi: B. R. Publishing Corporation, 2004. Print.

5. Danton, J. Periam. “A Plea for a Philosophy of Librarianship”. Library Quarterly
4(1934): 545. Print.

6. Fricke, Martin; Mathiesen, Kay; and Fallis, Don. “The Ethical Presuppositions behind
the Library Bill of Rights.” Library Quarterly 29 (2000): 468-91. Print.

7. Greenwood, T. “Professional Ethics”, New Library World 82. 973 (1981): 123-5.

8. Kaula, P.N. “Library Science Today. Ranganathan Festschrift”. BIS, 1965. Print.

N
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Course Code BLI1S3305

Course Title Principal Hindi

Type of Paper AEC (Ability Enhancement Course)
Credit 2

Teaching Hours 30
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Course Code BL1S3306
Course Title Re-Envisioning Public Library

Type of Paper IAPC (Internship/Apprenticeship/Project/Community Outreach)

Credit 2
Teaching Hours | 30

Objectives- To make the students aware of new perspectives and strategies for designing,
managing, and enhancing public libraries in various contexts.

Outcome- After completion of the course, students will be able to understand the
importance of public libraries with a new perspective.

Unit I: Understanding Public Libraries in Contemporary Contexts

Public Library: Definitions, Characteristics, Functions

Historical Evolution and Relevance in the Digital Age

Specific Needs and User Communities of Public Libraries

Digital Transformation and its Impact on Public Libraries

Challenges in Collection Development, Resource Management, and Information
Dissemination

YV V VY

Unit I1: Innovating and Enhancing Public Libraries

Designing Flexible and Collaborative Spaces

Curating and Promoting Digital Collections

Strategies for Effective Content Discovery and Access

Knowledge Sharing, Documentation, and Retention within Public Libraries
Collaborative Approaches to Content Creation and Dissemination

YV V VYV
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Course Code BL1S3307

Course Title Knowledge Organisation I11: Advanced Classification (Practical)
Type of Paper PC/SEC (Skill Enhancement Course)
Credit 2

Teaching Hours | 30

Obijectives- To familiarize the students with the practical experience of library
classification by using Dewey Decimal Classification Scheme (DDC) latest edition.
Outcome- After completion of the course, students will be able to classify library resources
by using Dewey Decimal Classification Scheme (DDC) latest edition.

Unit I: Dewey Decimal Classification Scheme (DDC) latest edition.

Classification of Documents with Compound and Complex Subjects

A. Assigning Class Numbers representing Simple, Compound, Complex Subjects
according to Dewey Decimal Classification Scheme (DDC) latest edition- 40 Marks
B. Viva Voce — 20 Marks
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Course Code BLIS3308 A

Course Title Professional Ethics in LIS
Type of Paper VAC (Value-Added Course)
Credit 2

Teaching Hours 30

Objectives- To make the students aware of librarianship as a profession and professional
ethics in librarianship.

Outcome- After completion of the course, students will be able to understand the
librarianship as a profession and professional ethics in librarianship.

Unit I: Librarianship as a Profession

» Introduction, General Ethics

» Profession, Professional, Professionalism
» Professional Ethics

» Librarianship as a Profession

Unit I1: Professional Ethics in Librarianship

» US Experience

» UK Experience

» Indian Situations

» Issues and Problems
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RECOMMENDED BOOKS

1. Librarianship as a profession, egyankosh

2. IASLIC. Towards a Code of Professional Ethics. Papers presented at the llth
National Seminar, Osmania University, Hyderabad, 1984

3. FINKS Lee W: Professional Ethics. Encyclopedia of Library and Information
Science. V 52, Supplement 15, p 301-321

4. KING S S: Organizational Ethics: Encyclopedia of Library and Information
Science. V 56; Supplement 19, p 307 - 318
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Course Code BL1S3308 B

Course Title Cloud Computing

Type of Paper VAC (Value-Added Course)
Credit 2

Teaching Hours 30

Obijectives- To make the students familiarize with cloud computing its architecture

and resource sharing.
Outcome- After completion of the course, students will be able to understand the
concepts of cloud computing, resource sharing etc.

Unit I: Cloud Computing Fundamentals and Virtualization

Cloud Computing: Concepts, Definitions and Purpose

Cloud Deployment Models, Service Models and Cloud Architecture
Resource Virtualization

Applications of Cloud Computing

VV V V

Unit 11: Resource Provisioning, Load Balancing and Security

» Resource Pooling, Sharing, and Provisioning.
» Scaling

» Load Balancing

» Security Issues in Cloud Computing
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RECOMMENDED BOOKS

1. Cloud computing and IoT, Egyankosh.

2. R. Buyya, C. Vecchiola, and S. T. Selvi, S. T. (2013). Mastering cloud
computing: foundations and applications programming. Newnes.

3. S. A. Babu, M. J. Hareesh, J. P. Martin, S. Cherian, and Y. Sastri, “System
Performance Evaluation of Para Virtualization, Container Virtualization, and
Full Virtualization Using Xen, OpenVZ, and XenServer,” 2014 Fourth
International Conference on Advances in Computing and Communications,
2014, pp. 247-250, doi: 10.1109/ICACC.2014.66.

4. https://www.ibm.com/in-en/cloud/learn/hypervisors#toc-type-1-vs--1k2a8-2y

https://www.vmware.com/topics/glossary/content/hypervisor.html

6. https://www.sciencedirect.com/topics/computerscience/fullvirtualization#:~:te
xt=Full%20virtualization%?20is%20a%?20virtualization,run%20in%?20
each%20individual%20VM.

o
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3309 A
Course Title Personality Development and Communication Skills

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours 30

Objectives- To make the students familiarize with personality and communication skills.
Outcome- After completion of the course, students will be able to develop their personality
and communication skills effectively.

Unit I: Personality and its Characteristics

Personality: Meaning, Definitions and Characteristics
Personality: Types and Traits

Social, Soft and Influencing Skill Development
Attitude and Appearance

Time and Stress Management Skill

YV VYV VYV

Unit 11: Communication Skill

» Professional Communication Skills (Verbal and Non-Verbal)
Communication: Understanding the Audience, Presentation, Body Language
Interpersonal Skills and Ability to Listening Skill.

Technical Communication Skills

Editorial Tools

YV V V
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RECOMMENDED BOOKS

[EEN

. Aitchison, J. (1988). Teach Yourself Linguistics. Hodder and Stoughton.

. Booth, P. F. (1991). Report Writing. 2nd ed. Kings Ripton: Huntington.

. Chandler, B. E. (1983). Technical Writer’s Handbook. Ohio: American Society

forMetals.
4. Chandra, A. and Saxena, T. P. (1979). Style Manual. New Delhi: Metropolitan
Books.

. Cooper, B. M. (1986). Writing Technical Reports. New York: Penguin.

.Gerson, S. J. and Gerson, S. M. (1992). Technical Writing, Process and
Product. Englewood Cliff’s: Prentice Hall.

. Gladis, S. D. (1993). Write type, personality types and writing styles. Amherst,
Mass.: Human Resource Development Press.

. Gupta, S.(2009). Personality development and communication skills. Jaipur,
India: Book Enclave.

. Harrison, C. (1980). Readability in the Classroom. Cambridge: Cambridge
University Press.

10. Huckin, T. N. and Olsen, L. A. (1991). Technical Writing and Professional
Communication for Non-Native Speakers of English. 2nded. New York:
McGraw-Hill.

11. James, G. Gray. (1986). Strategies and Skills of Technical Presentations.
Westfort: Greenwood Press.

12. Karten, N. (2010). Presentation skills for technical professionals achieving
excellence. Ely: IT Governance Publications.

13. Masters, L. A., Wallace, H. R., & Harwood, L. (2011). Personal development
for life and work (10th ed.). Australia: South-Western Carnage Learning.

14. McMurry, J. H. (2002). The etiquette advantage: personal skills for social
success. Wilmington, NC: Stellar Publications.

15. Sherman, T. A. and Johnson, S. S. (1990). Modern Technical Writing. 5th ed.
Englewood Cliff’s: Prentice Hall.

16. Swain, D. V. and Swain, J. R. (1991). The Issue of Audience. In Scripting for

the New Audio-Visual Technologies.2nd ed. Chapter 4. Boston: Focal Press.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3309 B

Course Title Professional Ethics

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours 30

Obijectives- To enable the students to imbibe and internalize the Values and Ethical
Behavior in the personal and Professional lives.

Outcome- After completion of the course, students will understand the importance
of Values and Ethics in their Personal lives and professional career.

Unit I: Introduction to Professional Ethics

Basic concepts Governing Ethics

Personal & Professional Ethics, Ethical Dilemmas

Life Skills, Emotional Intelligence

Thoughts of Ethics, Value Education

Dimensions of Ethics, Profession and professionalism, Professional Associations,
Professional Risks

» Professional Accountabilities, Professional Success, Ethics and Profession.

YVVV VY

Unit I1: Basic Theories

» Basic Ethical Principles, Moral Developments
Deontology, Utilitarianism

Virtue Theory, Rights Theory, Casuist Theory

Moral Absolution, Moral Rationalism, Moral Pluralism
Ethical Egoism, Feminist Consequentialism

YV V V
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Professional Ethics: R. Subramanian, Oxford University Press, 2015.

2. Business Ethics concepts & Cases: Manuel G Velasquez, 6e, PHI, 2008.

3. Kultgen, John, (1988). Ethics and Professionalism. Philadelphia: University of
Pennsylvania Press.

4. Naagarazan, RS. (2006). A Textbook on Professional Ethics and Human Values.
Delhi: New Age International Publishers.

5. Rachels, James (2007). The Elements of Moral Philosophy. The McGraw Hill
Companies, US.

6. Subramanian. R. (2017). Professional Ethics Includes Human Values. Oxford
University Press.
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4-Year Bachelor (Honours with Research) in Library and Information Science

IIN°YEAR, SEMESTER-IV

Course Code BLI1S3401
Course Title Preservation & Conservation of Library Materials
Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory

Credit 4
Teaching Hours | 60

Objectives- To appraise need and techniques of preservation and conservation
of library materials.

Outcome- After completion of the course, students will be able to understand
various preservation and conservation techniques of library materials.

Unit I: Basics of Preservation and Conservation: Overview
» Preservation and Conservation: Historical Development, Need and Purpose

» Preservation of Print Materials: Books, Periodicals, Pamphlets
» Digital Preservation

Unit I1: Preservation of Non-Print Materials
> Palm Leaves

» Manuscripts
» Films
» Pen Drive, DVD

Unit I11: Hazards and Control Measures to Library Materials
» Environmental Factor (Temperature, Humidity, Water, Light, Air Pollution,

Smoke, Dust, etc.)
» Chemical Factors
» Biological Factors

Unit IV: Binding
» Types of Binding of Library Materials
» Binding Material and their Varieties
» Binding Process
» Standards for Library Binding
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Casey, J. P. (1982). Paper making. New York: Interscience Publishers

2. Corduroy, John. (1978). Book binding for beginners. London: Thomas and Hudson

3. Dasgupta, Kalpana, ed. (1988). Conservation of library materials. Calcutta:
National Library

4. Durean, J. M. & Clements, D. W. G. (1986). Principles of the preservation of
library materials. Hague: IFLA

5. Gabriel, M. & Ladd, D. (1980). The microfilm revolution in libraries. Greenwich:

JAI Press

Harvey, Poss. (1993). Preservation in libraries: a reader. London: R R Bowker

Hans, K. J. (1958). Sign, symbol, and script. London: George Allen & Unwin

Sharma, R. G. (1979). Pandulipi sampadan kala. Delhi: Prabhat Prakashan

Singh, R. S. (1993). Conservation of documents in libraries, archives, and

museums. Delhi
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3402

Course Title Knowledge Organisation IV: Advanced Cataloguing (Theory)
Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To accustom the students with the organization of knowledge with different
basic concepts and philosophies of library cataloguing.

Outcome- After completion of the course, students will understand the basic concepts and
philosophies of library cataloguing, rules of filing entries and subject headings in
cataloguing and different bibliographic standards.

Unit I: Cataloguing Principles

» Introduction to Catalogue

» Principles of Cataloguing

» Ranganathan’s Canons of Cataloguing

» History and Development of Library Catalogue Codes

Unit 11: Variations in Cataloguing

» Centralized Cataloguing

» Cataloguing-in-Publication

» Pre-Natal Cataloguing

» Machine Formats: MARC and CCF

Unit 111: Vocabulary Control and Subject Cataloguing

» Subject Cataloguing: Meaning, Purpose and Objectives
» Subject Heading Lists: Sears List & LCSH

» Vocabulary Control: Meaning, Purpose and Objectives
» Thesaurus: Definitions, Functions, Types and Structure

Unit 1V: Recent Trends in Cataloguing

» Cataloguing on the Internet
» Computerized and Online (OPAC) Catalogue
» TEI (Text Encoding Initiative), METS
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

[N

ok wd

10.

11.
12.

13.
14.

15.
16.

17.
18.

19.

. https://ia601402.us.archive.org/35/items/in.ernet.dli.2015.126240/2015.126240.Classi

fied-Catalogue-Code-Ed-5th_text.pdf
https://egyankosh.ac.in/bitstream/123456789/33132/1/Unit-10.pdf
https://egyankosh.ac.in/bitstream/123456789/33131/1/Unit-11.pdf
https://egyankosh.ac.in/handle/123456789/32995

Andrew, P. G. (2003). Cataloguing Sheet Maps. Landon: Haworth Press.

Aswal, R. S. (2004). MARC 21: Cataloging Format for 21st Century. New Delhi: Ess
Ess.

Dhawan, K. S. (1997). Online Cataloguing Systems. New Delhi: Commonwealth
Publication.

Dhiman, Anil K. (2004). Cataloguing of Non-book Materials. New Delhi: Ess Ess.
Girija Kumar & Krishan Kumar.(2004). Theory of Cataloguing. New Delhi: Vikas
Gredley, Ellen & Hopkinson, Alan (1990). Exchanging Bibliographic Data: MARC and
other International Formats. Ottawa: ALA.

Hagler, Ronald & Simmons, Peter. (1991). The Bibliographic Record and Information.
Kao, Mary L. (2003). Cataloguing and Classification for Library Personnel. Mumbai:
Jaico.

Leigh, Gernert. (2003). A Textbook of Cataloguing. New Delhi: Dominant Publishers.
Mitchell, Anne M. & Surratt, Brian E. (2005). Cataloguing and Organizing Digital
Sources. London: Facet Publishing.

Roe, Sandra K (2002).The Audio-Visual Cataloguing. New York: Haworth Press.
Sharma, Pandey S. K. (2001). Library Cataloguing Theory. New Delhi: Sahitya
Prakashan

Sood, S. P. (1999). Theory of Library Cataloguing. Jaipur: Raj Publishing House.
Taylor, A. G. (2007). Introduction to Cataloguing and Classification (10thed.). New
Delhi: Atlantic.

Viswanathan, C. G. (2008). Cataloguing Theory and Practice. New Delhi: Ess Ess

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar

Page 80 of 185


https://ia601402.us.archive.org/35/items/in.ernet.dli.2015.126240/2015.126240.Classified-Catalogue-Code-Ed-5th_text.pdf
https://ia601402.us.archive.org/35/items/in.ernet.dli.2015.126240/2015.126240.Classified-Catalogue-Code-Ed-5th_text.pdf
https://egyankosh.ac.in/bitstream/123456789/33132/1/Unit-10.pdf
https://egyankosh.ac.in/bitstream/123456789/33131/1/Unit-11.pdf
https://egyankosh.ac.in/handle/123456789/32995

4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3403

Course Title Library Automation and Networking (Theory)

Type of Paper Core/ DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To enable students in understanding about Library Automation and Digital
Library Software.

Outcome- After completion of the course, students will be able to work on Library
Automation Software, database creation and Digital Library software for various Digital
Library works.

Unit I: Library Automation

» Library Automation: Planning and Implementation

» Historical Perspective of Library Automation

» In-house Operations: Acquisition, Processing; Circulation
» Serial Control, Cataloguing, Maintenance and OPAC

Unit I1: Library Housekeeping Operations

» Procedural Model of Library House Keeping Operations
» Bibliographic Standards: MARC; CCF; MARC 21; Dublin Core
» Inter Library Loan, Document Delivery

Unit I11: Library Automation Softwares

» KOHA: Installation, Configuration and Functions
» SOUL: Installation, Configuration and Functions
» e-Granthalaya: Installation, Configuration and Functions

Unit IV: Library Automation Software Packages and Evaluation of Software Package

» Open-Source Software Packages: Evergreen; NewGenLib; PMB

Commercial Software Packages: Libsys; SLIM; Virtual ILS

Freeware ILS: ABCD; WEBLIS

Parameters of Evaluation of Software Packages: Generic Parameters of Evaluation;
Specific Parameters of Evaluation for Commercial ILSs; Specific Parameters of
Evaluation for Freeware and Open-Source ILSs

YV V V
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Arora, Ashok & Bansal, Shefali.(2000). Computer Fundamentals. New Delhi: Excel
Books.

2. Date, C. J. (2003). An Introduction to Database Systems. Pearson Education. New
Delhi : BPB Publications,

3. Jain, Madhulika& Jain, Satish.(2007). Introduction to Database Management
Systems. New Delhi : BPB Publication.

4. Kumar, P. S. G. (2004). Information and Communication. Delhi : B. R. Publication.

5. Matthew, Neil & Stones, Richard.(2008). Beginning Linux Programming. New Delhi:
Wiley India.

6. Prasher, R. G. (2003). Information and its Communication. Ludhiana: Medallion
Press.

7. Ramesh Babu, B. & Gopalakrishnan, S. (2004). Information, Communication, Library
and Community Development. Delhi : B. R. Publishing.

8. Sinha, Pradeep Kumar & Sinha, Priti. (2007). Computer Fundamentals. New Delhi :
BPB Publication.

9. Stallings, William. (2007). Computer Networking with Internet Protocols and
Technology. Delhi: Pearson Education.

10. Sybex. (2007). Linux Complete. BPB Publications, 2007: New Delhi.

11. Cohn, John M. (2001). Planning for Integrated Systems and Technologies: A Howto-
do-it Manual for Librarians. London: Neal-Schuman.

12. Cooper, Michael D. (1996). Design of Library Automation Systems: File Structures,
Data Structures, and Tools. New York: Wiley & Sons.

13. Mishra, R.K. (1999). Library Software Selection: An Analysis. IASLIC Bulletin.
44(3); 125-132.

14. Rayward, W.B. (2002). A History of Computer Applications in Libraries:
Prolegomena.

15. Reynold, D. (1985). Library Automation: Issues and Applications. London: Bowker.

16. Rowley, J. (1998). The Electronic Library. London: Library Association Publishing.

17. Yates, R. (1996). Library Automation: The Way Forward? Program. 30(3), 239-53.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3404 A

Course Title Institutional Repository

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware of the institutional repository & maintenance and
implementation.

Outcome- After completion of the course, students will learn institutional repository software,
implementation maintenance.

Unit I: Introduction of Institutional Repository
» Institutional Repository: Meaning, Definitions, Importance and Types
» Role of Institutional Repository in Scholarly Communication
» Structure of Institutional Repository
Unit I1: Implementation and Maintenance of Institutional Repository
» Software for Institutional Repository
» Hardware for Institutional Repository
» Technical Skills
» Difficulties in Implementation & Maintenance
Unit I11: Digital Repository Management
» Digital Right Management
» Copyright & License Issues
» Creative Commons
» Institutional Repository Initiatives in India
Unit IV: Institutional Repository Software
» DSpace: Administration: Content Organization; E-people, Workflow
> Eprints: Administration: Content Organization; E-people, Workflow
» Harvesting: OAI-PMH and OAI-ORE
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

w

Marianne A. Buehler (2014). Demystifying the Institutional Repository for Success. Chandos
Publishing.

Jones, Richard et al. (2006). The Institutional Repository. Oxford: Chandos Publishing.

Judith, Andrews & Derek, Law. (2004). Digital Libraries. Ashgate. 198.

Lucy A. Tedd & Andrew Large. (2004). Digital Libraries : Principles and Practice in a Global
Environment. G.G. Saur.

Purcell, Aaron .(2016). Digital Library Programs for Libraries and Archives: Developing,
Managing, and Sustaining Unique Digital Collections. ALA
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3404 B

Course Title Intellectual Property Rights and Copyrights
Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objective- To make the students aware of the intellectual property & copyright concepts andother
issues related to patents.

Outcome- After completion of the course, students will be aware of IPR & copyright, copyright
violation and infringement.

Unit I: Intellectual Property and Rights

> Intellectual Property: Concept, Genesis, Development and Categories
Enforcement of Intellectual Property Rights

Role of WIPO

Emerging Issues in Intellectual Property Rights

YV V V

Unit 11: Copyright

» Copyright: Meaning and Scope

> Rights to Copyright Owner

» Licensing of Copyright

» Copyright Laws and Related Issues

Unit I11; Patents

» Patent: Concept and Scope

» Patent Laws in India

» Patent Laws in Abroad

> Violation and Infringement, Violation, and Infringement - India - USA — UK

Unit IV: Copyright& Patent in Digital Era

» Intellectual Property Digital Era: Meaning and Development
> |IPR Acts

»> Application of IPR in Electronic Environment

» Copyright of Electronic Resources
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

10.

11.

12.

13.
14.

Ajit Parulekar and Sarita D’ Souza, Indian Patents Law — Legal & Business Implications;
Macmillan India Ltd, 2006.

Andrew Murra. (2010).Information Technology Law: The law and society. Amazon.com
B. L. Wadhera; Law Relating to Patents, Trade Marks, Copyright, Designs &
Geographical Indications; University Law Publishing Pvt. Ltd., India, 2000
Bourgagaize, Jewell and Buiser, Biotechnology: Demystfying the Concepts, Wesley
Longman, USA, 2000

Carlos M. Correa and Abdulgawi A. Yusuf. (2008). Intellectual Property and International
Trade: The TRIPS Agreement (Second Edition. Amazon.com

D. Balasubramaniam, C.F.A. Bryce, K. Dharmalingam, J. Green and K. Jayaraman,
Concepts in Biotechnology, University Press (Orient Longman Ltd.)., 2002

Deborah E. Bouchoux. (2012). Intellectual Property: The Law of Trademarks, Copyrights,
Patents, and Trade Secrets .Amazon.com.

Federico Munari and Raffaele Oriani. (2011). The Economic Valuation of Patents:
Methods and Applications (New Horizons in Intellectual Property Series) . Amazon.com
Fishman, Stephen. (2008). The copyright handbook: what every writer needs to know.
Berkeley, CA: Nolo.

Freeman, Lee & Peace, A. Graham. (2005). Information ethics : privacy and intellectual
property. Hershey, PA : Information Science Pub.

Jessica Litman. (2001). Digital Copyright: Protecting Intellectual Property on the Internet.
Amazon.com

John Grant, Charlie Ashworth and Henri J. A. Charmasson. (2008). Patents, Registered
Designs, Trade Marks and Copyright For Dummies. Amazon.com

Jude C. Umeh. (2008). The World beyond Digital Rights Management . Amazon.com
P.Narayanan; Law of Copyright and Industrial Designs; Eastern Law House, Delhi, 2010
P.N. Cheremisinoff, R.P. Ouellette and R M Bartholomew, Biotechnology Applications
and Research, Technomic Publishing Co., Inc. USA, 1985
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3404 C

Course Title Database Design and Management

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware of the database design and management concepts and
other issues related to database.

Outcome- After completion of the course, students will be aware of database design and
management.

Unit I: Database Design and Management

» Database: Concept, Genesis, Development and Categories
» Entity and Column, Entity in Detail, Column in Detail

» The Three-Levels of ER Model, Key and Relationship

» Database View, Triggers and Stored Procedures

Unit I1: Database Engineering

» Database Engineering: Meaning and Scope
» Generate Database

» Patch Database

» Reverse Database to ERD

Unit I11; Database Software

» Microsoft SQL server, Oracle
» MySQL, PostgreSQL

» MagoB

» Amazon Web Services

Unit IV: Database Programming

» SQL

» Python, R
» PHP

> C#
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Hansen, Gary W. & Hansen, James V. (1992). Database Design and Management. Los
Angeles :Pearson.

2. Captain, Fidel (2013). Six-Step Relational Database Design™ (Second Edition): A step by
step approach to relational database design and development. Kindle Edition.

3. Reis, Joe & Housley, Matt (2022). Fundamentals of Data Engineering. O'Reilly Media, Inc.

4. Campbell, Laine & Majors, Charity (2017). Database Reliability Engineering. O'Reilly Media,
Inc.

5. Eagar, Gareth (2021). Data Engineering with AWS: Learn how to design and build cloud-
based data transformation pipelines using AWS. Kindle Edition.

6. Petkovic, Dusan (2020). Microsoft SQL Server 2019: A Beginner's Guide. McGraw Hill.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3405

Course Title English Comprehension and Writing Skills
Type of Paper AEC (Ability Enhancement Course)
Credit 2

Teaching Hours 30

Obijectives- The make the students skilled with English comprehension and writing skills.
Outcome- After completion of the course, students will be able to improve vocabulary, learn
professional writing skills and understand English comprehensions.

Unit I: English Comprehension

» Comprehension: Nature, Scope and Definitions
» Prose, Poetic, News Passage

» Note making

» Paraphrasing

Unit I1: Writing Skills

» Nature and Scope of Writing Skills
» Purpose and Functions of Writing Skills
» Types of Writing: Paragraph, Essay, Precis
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RECOMMENDED BOOKS

N

https://www.rvskvv.net/images/Communication-Skills_20.04.2020.pdf
https://egyankosh.ac.in/bitstream/123456789/41770/1/Unit-3.pdf

N. Krishnaswamy and T. Sriraman, Current English for Colleges, Macmillan India
Limited.

George Orwell, War Minus the shooting - The sporting spirit.

Wren and Martin, High School English Grammar & Composition, S. Chand and Co.
Publication.

SP Robbin, Organizational Behaviour, Pearson Prentice Hall.

Nichols, J.N. (1980). Using paragraph frames to help remedial high school students with
written assignment. Journal of Reading, 24, 228-31.

Arnold, M.T. (1981). Teaching theme, thesis, topic sentences and clinchers as related
concepts. Journal of Reading, 24, 373-376.

Thomson A. J. and A.V. Martinet, A Practical English Grammar, Oxford University
Press, 1986

10. R. Fernandez Carmona, English Grammar... with exercises, Longman, 2000
11. R. Murphy, English Grammar in Use, Cambridge University Press 1990
12. Harrison, Grammar Spectrum 2, Oxford University Press, 1996
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3406

Course Title Re-Envisioning Academic Library

Type of Paper IAPC (Internship/Apprenticeship/Project/Community Outreach)
Credit 2

Teaching Hours 30

Objectives- To make the students aware of new perspectives and strategies for designing,
managing, and enhancing academic libraries in various contexts.

Outcome- After completion of the course, students will be able to understand the importance
of academic libraries with a new perspective.

Unit I: Understanding Academic Libraries in Contemporary Contexts

Academic Library: Definitions, Characteristics and Functions

Historical Evolution

Relevance in the Digital Age

Digital Transformation and its Impact

Challenges in Collection Development, Resource Management, and Information
Dissemination

YV VV VYV

Unit 11: Innovating and Enhancing Academic Libraries

» Academic Library: Designing and Collaborative Spaces
Curating and promoting Digital Collection

Strategies for effective Web Discovery Scale
Knowledge Sharing and Documentation

YV V V
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

=

https:/files.eric.ed.gov/fulltext/EJ1213958.pdf

2. https:/lepgp.inflibnet.ac.in/epgpdata/uploads/epgp content/S000021L1/P000203/M002007
JET/1463134935P11 M9 et.pdf

3. file:///C:/Users/ TEMP/Downloads/Unit-1%20(2).pdf

4. https://www.ala.org/rt/sites/ala.org.rt/files/content/popularresources/Chpt6 AcadLibs.pdf

5. https://files.eric.ed.gov/fulltext/ED571288.pdf

6. https://egyankosh.ac.in/handle/123456789/4819
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3407

Course Title Knowledge Organisation IV: Advanced Cataloguing (Practical)
Type of Paper SEC (Skill Enhancement Course)

Credit 2

Teaching Hours 30

Obijectives- To acquaint the students with cataloguing practical of various types of library
resources using AACR-2 revised.

Outcome- After completion of the course, students will be able to catalogue library resources
using AACR-2 revised effectively.

Unit I: AACR-2 Revised

Works of Single and Shared Authorship

Works of Mixed Responsibilities

Editorial Publications, Series Publications, Multi-volume

Works & Pseudonymous, Works of Corporate Authorship
Works of Conflict of Authorship

Periodical Publications Ordinary and Artificial Composite Books

YV VVVVY

>

Assigning Cataloguing on AACR-2 revised 40 Marks.
Viva Voce- 20 Marks.

@
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3408 A

Course Title Mobile-Based Library Services
Type of Paper VAC (Value-Added Course)
Credit 2

Teaching Hours 30

Objectives- To make the students aware of mobile based library services.
Outcome- After completion of the course, students will be able to understand mobile based
library services with examples.

Unit I: Mobile-Based Library Services

YV V VYV

Unit I1:

YV VYV

Mobile Technology: Introduction and Definitions
Evolution of Mobile based Library Services

Mobile Technology and Libraries

Mobile OPAC, Mobile Databases, Mobile Library Website

Mobile-Based Library Tools

Mobile Library Apps

Mobile Library Instructions, Augmented
SMS Alerts, Geo-Location

Reference Enquiry

Library News, Blogs, and Events
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. https://library.iitd.ac.in/arpit 2020-2021/Week%208%20-%20Module%2020%20-%20PPT-
%20Mobile%20Based%20L ibrary%20Services.pdf
2. https://www.brookings.edu/wp-content/uploads/2016/07/chapter-One.pdf

3. http://www.cs.yorku.ca/~jarek/courses/6421/F12/presentations/M

obile-Databases_%20Presentation.pdf

4. https://egyankosh.ac.in/bitstream/123456789/26325/1/Unit-9.pdf

5. Pasquinelli, A. (2002). Digital Library Technology Trends (White Paper available at
http://144.16.72.189/is214/is214-2003-01-04/ digital_library trends-020923.pdf). Santa
Clara, California: Sun Microsystems.

6. Poulter, Alan and Tseng, Gwyneth (1999). The Library and Information Professional’s Guide
o

the World Wide Web. London: Library Association.
7. Poulter, Alan, Hiom, Debra and Tseng, Gwyneth (2000). The Library and Information

Professional’s Guide to the Internet. London: Library Association.
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http://www.cs.yorku.ca/~jarek/courses/6421/F12/presentations/Mobile-Databases_%20Presentation.pdf
http://www.cs.yorku.ca/~jarek/courses/6421/F12/presentations/Mobile-Databases_%20Presentation.pdf
http://www.cs.yorku.ca/~jarek/courses/6421/F12/presentations/Mobile-Databases_%20Presentation.pdf
https://egyankosh.ac.in/bitstream/123456789/26325/1/Unit-9.pdf
http://144.16.72.189/is214/is214-2003-01-04/

4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code

BL1S3408 B

Course Title Intelligent Library Search and Federated Search
Type of Paper VAC (Value-Added Course)

Credit 2

Teaching Hours 30

Objectives- To make the students aware of intelligent library search and federated search.
Outcome- After completion of the course, students will be able to understand and use intelligent
library search and federated search effectively.

Unit I: Intelligent Library Search

YV V VYV

Services

Unit I1: Federated Search

Intelligent Library Search: Introduction, Concept, Need

Advantages and Disadvantages of Intelligent Library Search

Traditional Vs Intelligent Library Search

Application of Intelligent Search in Libraries: Al, Machine Learning, Discovery

» Federated Search: Introduction, Definition, Need
» Federated Search Vs Meta Search

» Types of Federated Search

» Benefits and Challenges of Federated Search

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar

Page 96 of 185




4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. https://library.iitd.ac.in/arpit 2019-2020/Week%206-%20Additional%20Module-
%20Designing%20the%20Intelligent%20L ibrary%20Search%20Service.pdf.pdf
2. https://ir.inflibnet.ac.in:8443/ir/bitstream/1944/1233/1/27.pdf
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3409 A

Course Title Academic Integrity and Plagiarism

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit 2

Teaching Hours 30

Objectives- To make the students aware of plagiarism and promote understanding of academic
integrity concepts, policies, etc.

Outcome- After completion of the course, students will be able to understand plagiarism and
academic integrity in detail.

Unit I: Academic Integrity

Academic Integrity: Meaning, Definitions, Purpose

Academic Integrity: Importance and Challenges

The Fundamental Values: Honesty, Trust, Fairness, Respect, Responsibility, Courage
Developing cultures of Academic Integrity

Relevance of Academic Integrity in Educational, and Professional

VVYYVYY

Unit Il Plagiarism

» Plagiarism: Meaning, Definition and its Levels
» Types of Plagiarism and its Consequences

» Plagiarism Tools: Open-Source and Proprietary
» UGC Regulations for Plagiarism
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. https://www.chapman.edu/academics/academic-integrity/_files/the-fundamental-values-
of-academic-integrity.pdf

2. https://www.ufv.ca/media/assets/counselling/Plagarism+and+Academic+Integrity.pdf

3. https://hrmars.com/papers_submitted/8189/plagiarism-and-academic-integrity.pdf

4. https://cdn.dal.ca/content/dam/dalhousie/pdf/healthprofessions/Academiclntegrity/Syllab
us%20Statement%200n%20Academic%20integrity.pdf

5. https://www.cccua.edu/student-
life/educational_resource_center_pdfs/2023.Academic.Integrity.syllabus..pdf

6. https://content.bridgepointeducation.com/curriculum/file/a71laaf31-7529-49ea-a879-
6a04f8bcc1b0/1/Common%20Types%200f%20Plagiarism.pdf

7. https://qualifications.pearson.com/content/dam/pdf/Support/Quality%20Assurance/Plagi

arism-Factsheet.pdf
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code

BL1S3409 B

Course Title Information Security

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit 2

Teaching Hours 30

Objectives- To make the students aware of information security, cryptography, internet, and

web security.

Outcome- After completion of the course, students will be able to understand information
security, current trends in security, etc.

Unit I: Information Security and Authentication

YV VYV

Information Security: Principles

Services and Attacks, Functional requirements of Security

Current Trends in Security

Types of Authentications: Biometric Authentication and Third-Party Authentication

using KDC and Kerberos

Y

Unit I1: Cryptography

Mutual Authentication, Reflection Attack

» Cryptography: Concept, Symmetric and Asymmetric Cryptography.

» Mathematics of Cryptography: Modular Arithmetic Additive Inverse, Multiplicative
Inverse, Euclidean Algorithm and Extended Euclidean Algorithm

» Stream Cipher and Block Cipher, Concept of Confusion and Diffusion
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. https://nvipubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-12r1.pdf
2. https://engineering.futureuniversity.com/BOOKS%20FOR%201T/Book%20Introduction%20to
%20Information.pdf

3. https://mu.ac.in/wp-content/uploads/2022/05/information-security.pdf
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3410

Course Title Internship

Type of Paper Internship

Credit 4

Teaching Hours 60
Objectives-

i. To train the students in practical librarianship in the working environment of the
library by deputing them in different types of libraries for a period of one month; and
ii. To train them in preparing the Internship Report in a prescribed format based on their
practical training and learning.
Outcome- After completion of the course, students will be able to works in Library without any

hesitation.

The work for paper shall start in the beginning of the FOURTH semester for which each student will be
allotted a topic for writing the Report. The Report will be submitted at the end of FOURTH semester on
the date to be decided by the Department.

A. Report on Internship Programme — 40 Marks
B. Viva-Voce — 20 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

I117-Year, SEMESTER-V

Course Code BLI1S3501

Course Title Marketing of Library and Information Products and Services
Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To make the students aware of the information products, consolidation,
repackaging, content analysis and marketing of library products.

Outcome- After completion of the course, students will be aware of information products,
consolidation, repackaging, content analysis and marketing of library products.

Unit I: Information Analysis
» Information: Basic Concepts
» Consolidation and Repackaging of Information: Concept, Need and Process.
» Guiding Principles for Arrangement and Presentation of Idea in a Helpful Sequence.
» Packaging and Repackaging of Information Products.

Unit I1: Information Products
» Information Products: Concepts, Nature, Definitions, Design, and Types
» Information Newsletters, Hand Books, House Bulletins
» In-house Communication, Trade Bulletin, Product Bulletin, State-of-the-Art Report,
Trend Report
» Technical Digests: Nature, Concept, Types, Design and Development.

Unit I11: Content Analysis
» Content Analysis: Concept, Types and Process
» Abstract: Definition and Types, Characteristics and Qualities of Good Abstracts.
» Abstracting: Need, Process, Computers and abstracting.
» Abstracting Organizations and Services.

Unit IV: Planning, Management and Marketing
» Planning and Management of Information Analysis and Consolidation
» Marketing of Information Concept, Need and Benefits.
» 5 Ps of Information Marketing; Marketing of Profit and Non- Profit Organization
» Trends in Marketing of Information Services and Information Marketing in India

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar
Page 103 of 185



4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

BAKEWELL (K G): Managing user-centered libraries and information services (Ed. 2,
1997) Maxwell, London.

BUTCHER (Helen): Meeting manager’s information needs (1998) ASLIB, London.
CARPENTER (J) and DAVIES (R): Quantification of the overseas consulting market for
professional consultancy services in librarianship and information science and information
management (1992) Research and Development, British Library, London.

COOTE (Helen) and BATCHELOR (Bridget): How to market your library services
effectively (Ed. 2, 1997) ASLIB, London.

GUPTA (D K): et al. Marketing library and information services: international perspectives
(2006) K.G. Saur, Munich.

HELINSKY (Z): A short-cut to marketing the library (2008) Chandos Publishing, Oxford
JAIN (Abhinandan K): et al. Marketing information products and services: a primer for
libraries and information professionals (1999) Tata McGraw-Hill, New Delhi.

KOTLER (Philip): L Marketing management (Ed.12, 2002) Prentice Hall, Delhi.

KOTLER (Philip) and ARMSTRONG (Gary): Principle of marketing (Ed. 7, 1996)
Prentice- Hall of India, New Delhi.

10. ROWLEY (Jenifer): Information marketing (2001) Ashgate London.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3502

Course Title Information and Communication Technology (Theory)
Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To keep abreast the students with the various computer technologies and
programming languages, internet protocols and standards, telecommunication, and wireless
communication, etc.

Outcome- After completion of the course, students will be skilled with various computer
technologies and programming languages, internet protocols and standards,
telecommunication, and wireless communication, etc.

Unit I: Computer Technology and Programming Language

» Character Representation (ASCII, ISCII, UNICODE)

» Computer Hardware, Computer Software, Storage Devices, Input and Output Devices

» Types of Software: System Software and Application Software

» Programming Language: Object Oriented, Procedural, High Level, Scripting, Web
Languages

Unit I1: Internet Protocols and Standards

» Internet: Web Browsers, WWW, E-mail, Search Engines, Meta and Entity Search Engines

» Internet Protocols and Standards: HTTP, SHTTP, FTP, SMTP, TCP/IP, URN, URI, URL
and POP

» Computer Networks: Topologies, Types of Networks: LAN, MAN, WAN and PAN

Unit I111: Telecommunication and Wireless Communication

» Transmission Channels, Mode and Media, ISDN, PSDN, Multiplexing

» Modulation, Standards and Protocols

» Wireless Communication: Media. Wi-Fi, Li-Fi, Satellite Communication, Mobile
Communication

Unit IV: Information and Communication

» Hypertext, Hypermedia, Multimedia, Video Conferencing, Virtual Reality, and

» Augmented Technologies

» Data Security, Network Security, Firewalls, Cryptographic Techniques, Anti-virus
Software, Anti-spyware, Intrusion Detection System
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. https://www.ddegjust.ac.in/studymaterial/mca-5/mca-101.pdf

https://egyankosh.ac.in/bitstream/123456789/9757/1/Unit-2.pdf

3. https://www.tutorialspoint.com/computer_fundamentals/computer_fundamentals_tut
orial.pdf

4. Pratt T W and Zelkowitz M V. Programming Languages. (3rd edition), Prentice Hall
of India, New Delhi, 1996.

5. Bird R and Wadler P. Introduction to Functional Programming. Prentice Hall Inc.,
Englewood-Cliffs, N J, USA, 1988.

6. Ousterhout J K. Scripting: High level Programming for the 21st Century. Computer.
(IEEE, U.S.A), Vol.31, No.3, 23-30,March 1998.

7. http://repository.ias.ac.in/38341/1/12-PUB.pdf

8. https://www.ime.usp.br/~alvaroma/ucsp/proglang/book.pdf

9. https://sist.sathyabama.ac.in/sist_coursematerial/uploads/SECA3025.pdf

10. https://egyankosh.ac.in/bitstream/123456789/33161/1/Unit-3.pdf

11. https://ccsuniversity.ac.in/bridge-
library/pdf/EC_8th _Sem_Electronic%20Switching_P_Gnanasivam%?20-
%20Telecommunication%20Switching%20and%20Networks_2nd-Edition-2008.pdf

12. https://sist.sathyabama.ac.in/sist_coursematerial/uploads/SEC1404.pdf

13. https://egyankosh.ac.in/bitstream/123456789/9479/3/Unit-3.pdf

14. https://mu.ac.in/wp-content/uploads/2021/05/Web-Programming-1.pdf

15. https://egyankosh.ac.in/bitstream/123456789/10970/1/Unit-2.pdf

16. https://egyankosh.ac.in/bitstream/123456789/26321/1/Unit-5.pdf

17. https://egyankosh.ac.in/bitstream/123456789/35797/5/Unit-12.pdf

o
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3503

Course Title Media and Information Literacy in LIS

Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To understand different theories of media & information literacy (MIL) and to
discuss about the various models of media and information literacy.

Outcome- After completion of the course, students will be able to understand the concept of
media literacy, information literacy & their theories.

Unit I: Introduction to Media and Information Literacy (MIL)
» Media & Information Literacy: Definition, Need and Purpose.
» Historical Context and Evolution of Media and Information Literacy
» Role of MIL in the Society
» Types and Characteristics of Traditional and New Media, Fusion between Traditional
and new Media
Unit I1: Policies and Strategies of MIL
» MIL Policies and Strategies: Introduction and Nature
» MIL Policies and Strategies: Benefits and Importance
» Information Literacy Standards: Foundations and Implications
» Right to Information (RTI): Concept, Nature, Scope

Unit I111: Media Literacy and Data Literacy
» Data Literacy: Concept, Importance and Finding Data
» Media Literacy in India
» Media and Information Ethics: Cyber Laws and Ethics
» Media Ethics
Unit IV: Social Media in Society
» Social Media Platforms and Tools
» Role of Social Media in Society
» Constructing Media Message
» Open Resources
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

10.

11.

12.

13.
14.

Aufderheide, P. (1992). Media Literacy: A Report of the national leadership
conference on media literacy; Washington DC: Aspen Institute.

Horton, Forest Woody, Jr (2007). Understanding Information Literacy: A Primer;
United Nations Educational, Scientific and Cultural Organization.

Carlsson, Ulla (2013). Preface in Media and Information Literacy; Policy and Strategy
Guidelines; UNESCO; 2013.

Criticos, Costas (2001). Media Education for a Critical Citizenry in South Africa in
Robert Kubey (ed.) Media Literacy in an Information Age; New Brunswick; NJ:
Transaction.

Grizzle, A & Wilson, C. (2011). Media and Information Literacy Curriculum for
Teachers, UNESCO,; Paris, France.

Ashraf, T. (2008). Empowering people through information: A case study of India's
Right to Information Act. International Information & Library Review, 40(3), 148-
152. doi:10.1016/}.iilr.2008.06.002

Bhatia, K. (2008). ROLE OF LIBRARIAN IN RIGHT TO INFORMATION (RTI)
AND DEMOCRACY. SRELS Journal of Information Management, 45(1), 11-16.
Coopers, P. (2009). Final Report: Understanding the Key Issues and Constraints in
Implementing the RTI Act. New Delhi: Department of Personnel and Training.
Media and Communication.” Open Access Journals Search Engine (OAJSE).
Accessed May 17, 2015.
http://www.oajse.com/subjects/media_and_communication.htm

Castells, M. & G. Cardoso eds. (2005) The Network Society: from Knowledge to
Policy. Washington Dc, USA.

Baran, S. J (2013). Introduction to Mass Communication: Media Literacy, Mcgraw
Hill Publication

FICCI KPMG report on Indian Media and Entertainment 2015
https://www.kpmg.com/IN/en/IssuesAndInsights/ArticlesPublications/Documents/Fl
CCIKPMG_2015.pdf
http://www.ala.org/acrl/sites/ala.org.acrl/files/content/standards/standards.pdf
Association of College and Research Libraries (ACRL). (2000). Information Literacy
Competency Standards for Higher Education. Chicago: Association of College and
Research Libraries. Chicago: ACRL, ALA.

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar

Page 108 of 185


http://www.oajse.com/subjects/media_and_communication.htm
https://www.kpmg.com/IN/en/IssuesAndInsights/ArticlesPublications/Documents/FICCIKPMG_2015.pdf
https://www.kpmg.com/IN/en/IssuesAndInsights/ArticlesPublications/Documents/FICCIKPMG_2015.pdf
http://www.ala.org/acrl/sites/ala.org.acrl/files/content/standards/standards.pdf

4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3504 A

Course Title Academic Library and Information System
Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware of the objectives, development, collection
development, organizational structure, services, financial and HRM of Academic Library.
Outcome- After completion of the course, students will be aware of objectives, development,
collection development, organizational structure, services, financial and HRM of Academic
Library.

Unit I: Academic Libraries and their Development

» Objectives and Functions

» History and Development of Academic Libraries in India

» History and Development of Academic Libraries in Abroad

» UGC and its Role in the Development of College and University Libraries

Unit I1: Collection Development and Management

> Books and Periodicals
» Conference Literature, Grey Literature and Government Publications
> Non-Book Materials: Electronic-Resources and Databases

Unit I11: Library Organization and Services

» Organizational Structure of Academic Library

» Staff Manual, Library Surveys, Statistics and Standards, etc.

» CAS, SDI, Abstracting and Indexing Services, Library Bulletin, Newspaper Clipping
Services

» Resource Sharing and Networking

Unit 1V: Financial and Human Resource Management

Determination of Finance, Sources of Finance

Types of Budgets

Nature, Size, Selection, Recruitment, Qualification and Training
Responsibilities and Duties

Competency Development Case Study of Academic Library in India

VVVYVYY
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

10.

BAKER (David), Ed. Resource management in academic libraries (1997) Library
Associations, London.
BROPHY (Peter): The academic library (2000) Library Association, London.

BUDD (J M): The academic library: the context, its purpose, and its operation (1988)
Libraries Unlimited, London.

CHAPMAN (Liz): Managing acquisitions in library and information Services (2001)
Library Association, London.

DOWLER (L): Ed. Gateways to knowledge: the role of academic libraries in teaching,
learning and research (1998) The MIT Press, London.

JORDON (Peter): The academic library and its users (1998) Gower Publishing Limited,
London.

LINE (Maurice B), Ed. Academic library management (1990) Library Association,
London.

RANGANATHAN (S R): School and college libraries (1942) Madras Library
Association, Madras.

WEBB (Sylvia P): Personal development in information work (Ed2.1991) ASLIB,
London.

WHITE (Carl M): Survey of university of Delhi (1965) Planning Unit, University of
Delhi, Delhi
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3504 B

Course Title Public Library and Information System
Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware of the objectives, development, collection
development, organizational structure, services, financial and HRM of Public Library.
Outcome- After completion of the course, students will be aware of objectives, development,
collection development, organizational structure, services, financial and HRM of Public
Library.

Unit I: Public Libraries and their Development

Obijectives and Functions

History and Development of Public Libraries in India

History and Development of Public Libraries in Abroad

Role of Government and agency for the promotion and development of Public Libraries
in India

YV VYV

Unit 11: Collection Development and Management
» Books and Periodicals
» Conference Literature, Grey Literature and Government Publications
» Non-Book Materials: Electronic-Resources and Databases
» Manuscripts

UNIT I11: Library Organization and Services
» Organizational Structure of Public Library
» Staff Manual, Library Surveys, Statistics and Standards, etc.
» CAS, SDI, Abstracting and Indexing Services, Library Bulletin, Newspaper Clipping
Services
» Resource Sharing and Networking

UNIT IV: Financial and Human Resource Management
Determination of Finance, Sources of Finance

Types of Budgets

Nature, Size, Selection, Recruitment, Qualification and Training
Responsibilities and Duties

Competency Development Case Study of Public Library in India

VVYVYVY
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. BARUA (B P): National policy on library and information systems and services for
India: perspectives and projections (1992) Popular Bombay

2. BATT (Chris): Information technology in public libraries (1998) London Library
Association Publishing, London.

3. BHATT (R K): UNESCO: development of libraries and documentation centers in
developing countries (2004) KK Publications, New Delhi.

4. HIGGINS (S E): Youth services and public libraries (2007) Chandos Publishing,
Oxford.

5. IFLA: Guidelines for public libraries (revised 2000) The Hague, IFLA.

6. INDIA: Advising committee for libraries (Ed. 2, 1958) Manager of Publications, Delhi.

7. JAGANAYAK (S S): Role of libraries in socio-economic, cultural, and educational
development. (1997) Classical Publication, New Delhi.

8. PATEL (Jashu) and KRISHAN KUMAR: Libraries and librarianship in India (2001)
Greenwood Press, Westport, Connecticut.

9. THOMAS (V K): Public libraries in India: development and finance (1997) Vikas
Publication, New Delhi.

10. WOODRUM (Pat), Ed. Managing public libraries in 21st century (1989) The Hawork
Press, New York.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3504 C

Course Title Research and Technical Library and Information System
Type of Paper DSE (Discipline Specific Elective Course)

Credit 4

Teaching Hours 60

Objectives- To make the students aware of the objectives, development, collection
development, organizational structure, services, financial and HRM of Research and
Technical Library and Information System.

Outcome- After completion of the course, students will be aware of objectives, development,
collection development, organisational structure, services, financial and HRM of Research
and Technical Library and Information System.

Unit I: Research and Technical Libraries and their Development
> Obijectives, Functions, and Development of Research and Technical Library in India
> History and Development of Research and Technical Library in Abroad
» Promotion and Development of Research and Technical Library in India
> Research and Technical Libraries and its Relationship with Parent Organization

Unit 11: Collection Development and Management
> Books and Periodicals
» Conference Literature, Grey Literature and Government Publications
» Non-Book Materials: Electronic-Resources, Databases

Unit I11: Library Organization and Services
» Organizational Structure of Research and Technical Library
» Staff Manual, Library Surveys, Statistics and Standards, etc.
» CAS, SDI, Abstracting and Indexing Services, Library Bulletin
> Resource Sharing and Networking

Unit 1V: Financial and Human Resource Management

Determination of Finance, Sources of Finance

Types of Budgets

Nature, Size, Selection, Recruitment, Qualification and Training

Responsibilities and Duties

Competency Development Case Study of Research and Technical Library in India

YVVVYVY
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

[EEN

. AUGER (C P): Information sources in grey literature (Ed. 3, 1994) Bowker, London.

CHAPMAN (Liz): Managing acquisitions in library and information services (2001)
Library Associations, London.

GROGAN (N): Science and technology: an introduction to the literature (Ed. 4, 1982)
Clive Bingley, London.

HERNON (Peter) and WHITMAN (John R): Delivering satisfaction and service
quality: a customer-based approach for libraries (2001) American Library Association,
Chicago.

LAWES (Ann), Ed. Management skills for the information manager (19930 Gower
Publishing, London.

RAITT (David): Ed. Libraries for the new millennium (1997) Library Association,
London.

SAHA (J): Special libraries and information services in India and the USA (1969)
Scarecrow, New York.

SCAMMELL (AW): Ed. Handbook of special librarianship and information work
(Rev. Ed. 7, 1997) ASLIB, London.

SINGH (S P): Special libraries in the electronic environment (2005) Book well, New
Delhi.

10.STRAUSS (L J): Scientific and technical libraries: their organization and

administration (Ed. 2, 1972) Beckey and Hayes, New York.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3505 A

Course Title Electronic Publishing
Type of Paper GE (Generic Elective)
Credit 4

Teaching Hours 60

Obijectives- To make the students aware of the concept, OAI, formats, structure, and issues
of Electronic Publishing.

Outcomes- After completion of course, students will be aware of concept, OAIl, formats,
structure, and issues of Electronic Publishing.

Unit I: Concept Electronic Publishing
» Concept
» Scope
» Nature
» Types

Unit 11: Open Access Sources of Electronic Publishing
» Evolution of OAI
» Open Access Sources
» Pricing and Pricing models
» Current Trends in E-publishing

Unit I11: Formats and Structure of E-Publishing
» Format of E-Publishing
» Structure of E-Publishing
» Languages of E-publishing

Unit IV: Issues of E-Publishing
» Socio issues in E-Publishing
» Economic issues in E-Publishing
» Legal issues in E-Publishing
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Karen S. W. Marilynn B, Stone, T. A. (2003). Electronic publishing: The definitive
guide. UK: Hard Shell Word Factory.

2. Klostermann, D. (2011). The e-book handbook - A thoroughly practical guide to
formatting, publishing, marketing, and selling your e-book. Cambridge: Full Stop.

3. Loton, T. (2011). E-book publishing DIY: the do it yourself guide to publishing e-
books, 2nd ed. United States: LOTONtech.

4. Meckler, L. (2011). E-book formatting, self-publishing, marketing tips updated . USA:
Linda E meckler on smash words.

5. Sahida, f. k. (2010). Publishing e-book for dummies. USA: CreateSpace

6. Schuster, C. (2011). E-publishing for writers: Trends an opportunities/Fall 2011
(Kindle Edition ed.). UK: Books to Go Now
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3505 B

Course Title Reference Management
Type of Paper GE (Generic Elective)
Credit 4

Teaching Hours 60

Objectives- To make the students equipped with the skills and knowledge required to
effectively manage and cite references in academic and professional writing.

Outcome- After completion of the course, students will be able to understand the importance
of proper referencing and the implications of plagiarism; use reference management software
to organize and cite sources efficiently.

Unit I: Introduction to Reference Management

» Overview of different Citation Styles (APA, MLA, Chicago, etc.) and their
Significance

» Importance of Referencing and Citation in academic work

» Introduction to Reference Management Software (e.g., Zotero, Mendeley, EndNote)
and their features

Unit I1: Collecting and Organizing References

» Searching for Academic Sources: Utilizing Library Databases, Online Catalogues, and
Search Engines

» Importing of Reference Management Software

» Creating and Managing Reference Libraries: Folders, Tags, and Metadata

Unit I11: Citing Sources and Generating Bibliographies

» In-text Citations and Bibliography Formatting

» Linking Reference Management Tools: Microsoft Word, Google Docs)
» Inserting Citations and Generating Bibliographies

» Troubleshooting Common Formatting Issues and Errors

Unit 1V: Advanced Features and Collaboration

» Features of Reference Management Software: Annotation, Note-taking, and
Highlighting.

» Collaborative Reference Management

» Customizing and Creating Citation Styles
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

No ok e

10.

"Cite Right: A Quick Guide to Citation Styles--MLA, APA, Chicago, the Sciences,
Professions, and More™ by Charles Lipson

"The Complete Guide to Referencing and Avoiding Plagiarism™ by Colin Neville
"Cite Unseen: How to Reference Online Sources" by Justin Littman

"The Chicago Manual of Style"

"Publication Manual of the American Psychological Association (APA)"

"MLA Handbook™

"Writing Research Papers: A Complete Guide" by James D. Lester Jr. and James D.
Lester

"Scientific Style and Format: The CSE Manual for Authors, Editors, and Publishers" by
Council of Science Editors

"AMA Manual of Style: A Guide for Authors and Editors"

"The ACS Style Guide: Effective Communication of Scientific Information™ by Anne
M. Coghill and Lorrin R. Garson
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3506

Course Title Re-Envisioning Special Library

Type of Paper IAPC (Internship/Apprenticeship/Project/Community Outreach)
Credit 2

Teaching Hours 30

Objectives- To make the students aware of new perspectives and strategies for designing,
managing, and enhancing special libraries in various contexts.

Outcome- After completion of the course, students will be able to understand the importance
of special libraries with a new perspective.

Unit I: Special Libraries in Contemporary Contexts

Definitions, Characteristics, Functions of Special Libraries

Historical Evolution and Relevance in the Digital Age

Specific needs and user Communities of Special Libraries

Digital Transformation and its Impact on Special Libraries

Challenges in Collection Development, Resource Management, and Information
Dissemination

YVVVVY

Unit I1: Innovating and Enhancing Special Libraries

» Designing Flexible and Collaborative Spaces within Special Libraries
» Digital Collections in Special Libraries

» Web Scale Discovery in Special Libraries

» Knowledge Sharing, Documentation in Special Libraries
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. "Reimagining Libraries: Innovations in Library Design" by Ken Worpole and Frangoise
Dupré

2. "The User Experience Team of One: A Research and Design Survival Guide" by Leah
Buley

3. "Design Thinking for Libraries: A Toolkit for Patron-Centered Design™ by Andrew D.
Weiss

4. "The New Digital Age: Reshaping the Future of People, Nations, and Business" by Eric
Schmidt and Jared Cohen
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3507

Course Title Information and Communication Technology (Practical)
Type of Paper SEC (Skill Enhancement Course)

Credit 2

Teaching Hours 30

Obijectives- To provide hands on experience of library automation software and website
designing tools.

Outcome- After completion of the course, students will be skilled enough to automate the
library as well as design a library website.

Unit 1: Hands-on experience on Library Automation Software
Integrated Library Software: Koha / SOUL

Unit 2: Hands-on experience on Website Designing HTML / Dreamweaver

A) A practical written test on Library Software and Website Designing- 40 Marks
B) Viva Voce- 20 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3508 A

Course Title User Studies and User Education

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit 2

Teaching Hours 30

Objectives- To make students identify the users of a library or of any information system
or service and to understand the concept of user education.

Outcome- After completion of the course, students will be aware of the users and user
education in broader perspectives.

Unit I: User Studies and its Importance

User and its Characteristics

User Studies: Need, Planning and Techniques for User Studies
Limitations and Criticisms of User Studies

Case Studies in India

VVVYVY

Unit I1: User Education

» User Education: Definitions, Components, Goals and Objectives
» Development of User Education

» Information Technology and User Education

» Evaluation of a User Education Programme
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

10.

11.
12.

Banwell, Linda, and Graham Coulson. “Users and User Study Methodology: The Jubilee
Project”. Information Research 9.2 (2004)

Bernal, ].D. Report on Royal Society’s Scientific Conference. London: Royal Society, 1948.
Print

The Transmission of Scientific Information: A User’s Analysis - In: International Conference
on Scientific Information. Vol.1. Washington: NRC, 1959. pp.77-95. Print

Busha, Charles H., and Stephen P. Harter. Research Methods in Librarianship: Techniques and
Interpretations. New York: Academic Press, 1980. Print

Devarajan, G. Library Information User and Use Studies. New Delhi: Beacon Books, 1995.
Print

Guha, B. Techniques of User Studies. Paper 11.3 in DST Course Material. New Delhi :INSDOC,
1976. Print.

Fjallbrant, Nancy and Malley, Ian (1984): User Education in Libraries. 2nd ed: London:- Clive
Bingley

Fjallbrant, N: (1996). Educate.- a networked user education project in Europe. In [FLA
Journal, zz(I)

Girja Kumar and Krishan Kumar (1983). Philosophy of User Education. New Delhi: Visas
Publishing House.

Kirkendall , C.A. (1980). Library Use Education: Current Practices and Trends.. Library
Trends, 29(1).

Knapp, P.B. ('1964). The Monteith College Experiments. New York: Scarecrow Press.
Lubans, ], ed. (1974). Educating the Library User. London: BOWKER.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3508 B

Course Title Big Data and Data Visualization

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit 2

Teaching Hours 30

Obijectives- To enable students to have skills that will help them to solve complex real-world
problems for decision support.

Outcome- After completion of the course, students will be able to visualize big data to
perform decision making in real world problems.

Unit I: Introduction to Big Data

Big data: Importance and Characteristics

3Vs of Data Volume, Velocity and Variety, Data sets, Data analysis, Data analytics
Different types of Data, Drivers for Big Data Adoption

Big Data Technologies: Hadoop ecosystem (HDFS, MapReduce, YARN); NoSQL
databases (MongoDB, Cassandra, etc.)

Data Mining, Statistical Analysis, Machine Learning, Semantic Analysis, Visual
Analysis, Case Studies.

YV V VYV

Y

Unit 11: Introduction to Data Visualization

Importance of Data Visualization

Basic Principles of Visual Perception and Design
Bar Charts, Histograms

Pie Charts, Scatter Plots

Line Plots, Regression

YVVVY
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

Thomas Erl (2016) Big Data Fundamentals-Concepts, Drivers and Techniques.
Pearson publication

Judith Huruwitz, Alan Nugent, Fern Halper, Marcia Kaufman, “Big data for dummies”,
John Wiley & Sons, Inc. (2013)

Paul Zikopoulos, “Understanding Big Data: Analytics for Enterprise Class Hadoop and
Streaming Data, McGraw Hill, 2012 Chuck Lam, “Hadoop In Action”, Dreamtech
Publications, 2010

Seema Acharya, Subhashini Chellappan, “Big Data and Analytics”, Wiley
Publications, First Edition,2015
https://www.psgrkcw.ac.in/wp-content/uploads/2021/08/Data-Visualization-
Tools.pdf
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I11"-Year SEMESTER-VI

Course Code BLI1S3601

Course Title Information Retrieval System

Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To make the students aware of the indexing & vocabulary control techniques and
searching of resources both through print and electronic medium.

Outcome- After completion of the course, students will be aware of using the indexing
techniques to retrieve the useful resources for learning and research.

Unit I:

YV V VYV

Unit 11
>

>
>
>

Unit 11
>

>

>

>

Basics of Information Retrieval Systems
Definition, Components and Types of IRS Systems

Elements of File Organisation
Artificial Intelligence and Expert System
Information Retrieval Models

: Subject Representation and Indexing Languages
Alphabetical Subject Representation

Contributions of Cutter, Kaiser, Ranganathan and Coates
Characteristics of Indexing Languages
Vocabulary Control-List of Subject Headings and Thesaurus

I: Indexing Systems and Techniques
Assigned Indexing vs Derived Indexing

Assigned Indexing Systems: Pre-Coordinate (PRECIS, POPSI and Chain Indexing) and
Post-Coordinate Indexing System (Uniterm, Index System)

Derived Indexing Systems: Title based (KWIC, KWOC and KWAC), Citation based (SClI,
SSCI, etc.) and Full-Text (STAIRS, LEXIS-NEXIS, etc.)

Automatic Indexing: COMPass

Unit IV: Information Searching and Evaluation

>
>
>

Search Methods and Search Strategy, Boolean Search
Information Searching in different Media: Print and Electronic
Need and Parameters of Evaluation - Retrieval Performance: Recall and Precision
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Aitchison, Jean, Gilchrist, Alan; and Bawdown, David. (1990). Thesaurus
Construction and Use: A practical manual. 4th Ed. ASLIB.

2. Becker, Joseph, and Robert M Hayes.(1967). Information Storage and
Retrieval tools Elements & Theories. New York: John Wiley.

3. Choudhury, G.G. (1993). Introduction to Modern Retrieval System. Calcutta:
IASLIC,1993

4. Convey, John.(1992). Online Information Retrieval: An Introductory Manual
to Principles and Practice. 4th ed. London.

5. Elis, David (1996). Progress and Problems in Information Retrieval. London:
Library Association.

6. Fosket, A.C. (1992) Subject Approach to Information. London: Clive Bingley.

7. Fugman, Robert (1993). Subject Indexing and Analysis Theoretical
Foundations & Practical Advice. Frankfurt: Index Verlag.

8. Grolier, Eric de. (1962). A Study of general Categories Applicable to
Classification and Coding in Documentation UNESCO.

9. Lancaster, F.W. (1977). The Measurement and Evaluation of Library Science.
Information Sources Press.

10. Losee, Robert M. (1998). Text retrieval and Filtering: Analytical Models of
Performance. London: Kluwer.

11. Meadow, Charles T. (2000). Text Information retrieval system. Academic Press.

12. Sharp, Harold S. (1964). Readings in Information Retrieval. London: The
Scarecrow Press.

13. Soergel, Dagobert. (1974). Indexing Languages & Thesaurus Construction
&Maintenance. Los Angeles: Melville Pub. House.

14. Soergel, Dagobert. (1985). Organizing Information. Principles of Database &

Retrieval Systems, Academic Press.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3602

Course Title Web Based Information Systems and Services (Theory)
Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To make the students aware of the various web-based information systems and
services in the library.

Outcome- After completion of the course, students will be aware of different web-based services
such as HTML, CSS, XML, web-based protocols etc.

Unit I: Web Based Information Systems
» Web Based Information System: Objectives, Drawbacks, Advantages
» Software Requirements, System Architecture
» Module: Admin Module, User Module
» HTML Basics: tags, attributes, text/paragraph formatting, hyperlinks
» CSS Basics: Inline vs global CSS, CSS selectors, Box-model

Unit 11: XML

XML Concepts: Markup vs semantics, rules for well-formed XML

XML DTD: valid vs well-formed, element and attributes definitions, validation
tools (xmllint)

XML Schema: data types, data facets and patterns, XML namespaces, Simple
vs Complex types

XML Styling: CSS vs XSL, XSLT/XPATH/SQuery, xsltproc tool

XSLT advanced: XPATH Primer, advanced XSLT templates, lists, if-else,
loops

Crosswalk using XSLT: MARCXML to DC/MODS and DC to MODS
YAML/JSON Primer: Basics of JSON, YAML standard and JSON, XML vs
JSON

VV VV VY VYV

Unit 111: Web Based Services and Networking

» Modern web patterns: Templating, MV C pattern, CGI vs WSGI, Security, Flask
framework (Python)
Database abstraction: OS-level abstraction (ODBC), Language-level
(JDBC/PDO/DBI), Object Relational Mapping (ORM)
JavaScript: Client-side script concept, Browser/DOM events, jQuery,
asynchronous programming (AJAX)
Web skills practical: use custom jQuery and CSS in Koha/DSpace
Search engine components: Spider/crawler, Indexer, Searcher, Tokenizer,
Filters, Ranking algorithms (TF-IDF scores)

vV V V

Unit IV: Web Based Services Protocols

Z39.50 Protocol Operations

» Type-1 Query (RPN)

» Z39.50 server setup using Index Data Zebra software, Index MARC
>

Y

records,Record Id de-duplication
Z39.50 Application Profiles
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Anderson, Paul. (2012). Web 2.0 and beyond : principles and technologies. CRC

Press

2. Bates, Chris. (2006). Web Programming: Building Internet Applications. 3rd Ed.
Wiley-India.

3. Duckett, Jon .(2011). HTML and CSS: Design and Build Websites Paperback
Wiley

4. Kalbach, James. (2007). Designing Web Navigation: Optimizing the User
Experience. O’Reilly Media.

5. Macdonald, Matthew (2015). Creating a Website: The Missing Manual. O’Reilly
Media.

6. Morville, Peter & Rosenfeld, Louis. (2006). Information Architecture for the World
Wide Web: Designing Large-Scale Web Sites. 3rd Ed. O’Reilly Media.

7. Robbins, Jennifer Niederst. (2012). Learning Web Design: A Beginner’s Guide to
HTML, CSS, JavaScript, and Web Graphics. 4th Ed. O’Reilly Media.

8. Stallings, William. (2007). Computer Networking with Internet Protocols and
Technology. Pearson Education.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3603

Course Title Content Management System

Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To make the students aware with content management concepts, content
management, and related software.

Outcome- After completion of the course, students will be able to understand the content
management, content developing strategies, Data integration and community information
System.

Unit I: Introduction to CMS
» Introduction of CMS, Benefits
» Concept and Content Creation, Types of Contents
» Challenges and Real-World Application
» Document Management, Record Management

Unit I1: Content Management
» Concept, Content creation and Principles of CMS
» CMS Architecture
» Creating and Managing Web Page and Content
» Fundamentals of planning dynamic websites

Unit 111: Content Management Software and Applications
» CMS Software: WordPress, Drupal, Joomla, and others to create dynamic and
flexible websites.
» Evaluation of CMS.
» Application of CMS; CMS and Community Information Systems
» Document Management, Records Management, Digital Assets Management

Unit IV: Integration and Community Information System (CSI)
» System and Data Integration in CMS
» CMS Application
» CSI: Concept
» CSlI: Conceptual Framework, Purpose & Technology
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Arthur, M.H. (2006). Expanding a digital content management system for the
growing digital media enterprise. Boston: Elsevier Focal Press.

2. Barrie, M. N. (2009). Joomla! 1.5: a user’s guide: building a successful Joomla!
Powered website. Upper Saddle River, NJ: Prentice Hall.

3. Bishop, A. P. etal. (eds.). (2005). Digital Library Use: Social Practice in Design and
Evaluation. Delhi: Ane Books.

4. Bradford, L. E. (2008). Content management systems in libraries: case studies.
Lanham, MD: Scarecrow Press.

5. Chowdhury, G. G. & Chowdhury, Sudatta. (2003). Introduction to Digital Libraries.
London: Facet.

6. Cooper, Michael D. Design of Library Automation Systems: File Structure, Data
Structures and Tools, New York: John Wiley, 1996.

7. Deegan, Marilyn & Tanner, S. (2006). Digital Preservation. London: Facet
Publishing.

8. Hal Stern, Brad Williams, and David Damstra. (2010). Professional WordPress:
design and development. Indianapolis, IN: Wiley Pub., Inc.

9. Janet Majure. (2010). Teach yourself visually WordPress. Indianapolis, IN: Wiley
Pub., Inc.

10. Jason, C. and Helen, F. (2008). Using Moodle. Sebastopol, CA: O’Reilly Community
Press.

11. Jen, K.P. and Sarah, E. (2010). Joomla! Start to finish. Indianapolis, IN: Wiley Pub.,
Inc.

12. Jennifer Marriott and Elin Waring. (2011). The official Joomla! Book. Upper Saddle
River, NJ: Addison-Wesley.

13. John M. Cohn, Ann L. Kelsey and Keith Michael Fiels, Planning for Library
automation: A Practical Handbook London: Library Association, 1998.

14. John M. Colon, Annl Kelsey, Keith Michael Fiels. Planning for Automation: A How-
to-do-it for Librarian. 2nd ed.(S.l.): Neal-Schuman, 1997.

15. Jones, Richard et al. (2006). The Institutional Repository. Oxford: Chandos
Publishing.

16. Judith, Andrews & Derek, Law. (2004). Digital Libraries. Hants: Ashgate.

17. Kausik Bose Information Networks in India: Problems and Prospects / New Delhi:
Ess Ess Publications, 1994.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3604 A

Course Title Computer and Communication Technology
Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To familiarize the students with the basics structure of computer and
Communication Technology.

Outcome- After completion of the course, students will be able to understand the development
of computers and CT, the different software and hardware components, devices, operating
systems, and programming languages etc.

Unit I: Introduction to Computers

» Basic Components of a Computer; Arithmetic Logic Unit - Half-Adder,
Full-Adder, Multiplier; Control Unit

» Memory Unit - Static and Dynamic RAM, ROM, Cache Memory.

» Input/Output Devices — Keyboards, Monitors, Printers, Scanners, Secondary
Storage Elements.

» Generations of Computer

Unit 11: Data Representation and Computer Software

» Data Representation in Computers: Binary Number System, Character
Encoding Standards ASCII, ISCII and UNICODE

» Computer Software: System Software and Application Software

» Programming Concepts: Open Source and Proprietary

» Operating Systems: Windows, DBMS & LINUX. Working with Windows

Unit 111 Introduction of Communication Technology

» Communication Technology: Components, Impact on Society

» Communication Technology and Internet

» Overview of Internet Security, E-mail Threats and Secure E-mail, Viruses
and Antivirus Software, Firewalls, Cryptography, Digital Signatures,
Copyright Issues.

» GOl Digital Initiatives in Higher Education: SWAY AM, Swayam Prabha,
National Academic Depository, National Digital Library of India, E-
Shodhsindhu, Virtual labs, e-acharya, e-Yantra and NPTEL

Unit IV: Telecommunication and Networks

» Tele-communication: Transmission Media, ISDN, Multiplexing, Switching
Technique

» Networking: Topology and Types of Networks, Standards &
Protocols,Network Models (OSI), Networking Devices

» Retrieval Standards: Z39.50, SRU/SRW, Bibliographic Management
Software like ENDNOTE, REFWORK
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. Arora, Ashok & Bansal, Shefali.(2000). Computer Fundamentals. New Delhi:
Excel Books.

2. Basandra, Suresh K. (1999). Computer Today. New Delhi: Galgotia Publications.

3. Chandrasekaran, M.; Govindaraju, S.; Hug, A. Abdul & Narayanan, T. R.
(1996).Elements of Computer Science. New Delhi : New Age International.

4. Date, C. J. (2003).An Introduction to Database Systems. Pearson Education. New
Delhi: BPB Publications,

5. Jain, Madhulika & Jain, Satish.(2007). Introduction to Database Management
Systems. New Delhi : BPB Publication.

6. Kumar, P.S. G. (2004). Information and Communication. Delhi: B. R. Publication.

7. Leon, Alexis & Leon, Mathews. (2006). Fundamentals of Database Management
Systems. Chennai: Vijan Nicole.

8. Matthew, Neil & Stones, Richard.(2008). Beginning Linux Programming. New
Delhi: Wiley India.

9. Prasher, R. G. (2003). Information and its Communication. Ludhiana : Medallion
Press.

10. Ramesh Babu, B. &Gopalakrishnan, S. (2004). Information, Communication,
Library and Community Development. Delhi : B. R. Publishing.

11. Sinha, Pradeep Kumar & Sinha, Priti. (2007). Computer Fundamentals. New Delhi
: BPB Publication.

12. Stallings, William. (2007). Computer Networking with Internet Protocols and
Technology. Delhi: Pearson Education.

13. Sybex. (2007). Linux Complete. BPB Publications, 2007: New Delhi.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3604 B

Course Title Media and Publishing Technology

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware of the media and publishing technology.
Outcome- After completion of the course, students will be aware of multimedia content
creation and future trends and ethical considerations of media and publishing technology.

Unit I: Introduction to Media and Publishing Technology
» Media and Publishing Technology: Overview, Evolution
» Digital Media Production Tools: Audio, Video, Graphics
» Digital Publishing Formats: eBooks, Online Magazines, Interactive Content
» Publishing Software and Platforms: Adobe InDesign, WordPress
» Copyright Laws and Licensing in Media and Publishing

Unit 11: Multimedia Content Creation
» Recording, Editing, and enhancing Audio Content
» Interactive Multimedia Content
» Basics of Animation and Interactive Graphics Design
» Augmented Reality (AR) and Virtual Reality (VR) in Media

Unit 111: Digital Distribution and Publishing Platforms
» Online distribution Platforms (YouTube, Vimeo, social media)
» Web Publishing Tools (CMS)
» Leveraging Social Media for Content Promotion and Engagement
» Analyzing Audience Metrics and User Interaction

Unit IV: Trends and Ethical Considerations
» Al, Blockchain, and other emerging technologies in Media
» Privacy concerns and ethical considerations in Digital Media
» Encouraging innovation in Media and Publishing
» Exploring opportunities for Entrepreneurial Ventures in Media Technology
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RECOMMENDED BOOKS

1. Karen S. W. Marilynn B, Stone, T. A. (2003). Electronic publishing: The
definitive guide. UK: Hard Shell Word Factory.

2. Klostermann, D. (2011). The e-book handbook - A thoroughly practical guide to
formatting, publishing, marketing, and selling your e-book. Cambridge: Full
Stop.

3. Loton, T. (2011). E-book publishing DIY: the do it yourself guide to publishing
e-books, 2nd ed. United States: LOTONTtech.

4. Meckler, L. (2011). E-book formatting, self-publishing, marketing tips updated .
USA:Linda E meckler on smash words.

5. Sahida, f. k. (2010). Publishing e-book for dummies. USA: CreateSpace

6. Schuster, C. (2011). E-publishing for writers: Trends an opportunities/Fall 2011
(Kindle Edition ed.). UK: Books to Go Now
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3604 C

Course Title Data Analytics

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make students aware of the different methods of solving optimization
problems in the areas of linear programming.

Outcome- After completion of the course, students will be aware of various techniques
in data analytics.

Unit I: Introduction to Operations Research (OR)

» Historical Development of OR

» OR models and Advantages

» Methodology of OR, Advantages of OR, Features of OR solution
> Applications and Scope of OR

Unit I1: Linear Programming Problems (LPP)

> Definition of LPP, General Structure of Linear Programming, Formulation of
LPP

» Advantages and Limitations of Linear Programming

» Graphical Solutions of Linear Programming Problems

> Simplex Method, Degeneracy, Duality

Unit 111: Transportation Problems

> Introduction to Transportation Model

» Degeneracy in TP, Solution Techniques of TP

> Different Methods for Obtaining Initial Basic Feasible Solutions viz. Matrix
Minima Method, Row Minima Method, Column Minima Methods, Vogel’s
Approximation Method, Techniques for Obtaining Optimal Basic Feasible
Solution — Steppingstone and MODI Method.

» Assignment Problems: Definition, Types of Assignment Problems, Hungarian
Method for AP.

Unit IV: Game Theory

» Concept of Game problem, Rectangular games. Pure strategy and Mixed
strategy

» Saddle point and its existence. Optimal strategy and value of the game

» Algebraic method, Graphical method and Dominance method of solving
Rectangular games.

> Inter-relation between the theory of Games and L.P.P
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RECOMMENDED BOOKS

Operations Research, S D Sharma, KNRN Publication

Operations Research, P.K. Gupta and D. S. Hira, Sultan Chand Ltd.
Introduction to Operations Research, Hamdy A Taha, PHI Limited, New Delhi.
Operations Research, J K Sharma, Macmillan Publication

e A
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3605 A

Course Title Library and Information Services
Type of Paper GE (Generic Elective)

Credit 4

Teaching Hours 60

Objectives- To familiarize the students with the basic library and information services &
systems.

Outcome- After completion of the course, students will be able to understand the various
information services provided by libraries and information centers and they will get
knowledge about national and international information systems.

Unit I:
>
>
>
>
>

Introduction to Information Services
Concept, Meaning, Definitions

Scope and Types of Information Services
Traditional Library Services

Web enabled library and Information Services
Need and Importance of Library Services

Unit 11: Types of Information Services

YV VYV

Reference Service, Abstracting Service

Indexing Service, Current Awareness Service, and Alerting Service

Document Delivery Service; Planning and Development of Information Services.
Electronic Information Services- e-CAS, e-SDI, Electronic Document Delivery
Services

Unit 111: Study of Information System

>
>
>

>

Concepts, Objectives, Functions

Name of Information Systems

Types of Information Systems: Planning, Design and Evaluation of Information
Systems

Study of National Information Systems- NISCAIR, DESIDOC, and NASSDOC

Unit IV: Study of Global Information System

>
>

Objective and Functions of Global Information Systems
Study of Global Information Systems: INSPEC,
MEDLARS, BIOSIS, COMPENDEX, AGRIS
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RECOMMENDED BOOKS

1. Carmel, Maguire., Weir, Anthony D., Kazlauskas, Edward J. (2013).
Information Services for Innovative Organizations. Emerald Group
Publishing Limited

2. Krishan Kumar: Reference service, New Delhi: Vikas, 1990.

3. Lucas, Amy (Ed): Encyclopedia of Information Systems and Services,
Detroit: Gale Research, 1989.

4. Parida, Baman: Studies on information systems, services, and programs
in India and abroad. Delhi: Ajantha, 1993.

5. Ryan, Brendan. (2014). Optimizing Academic Library Services in the
Digital Milieu: Digital Devices and their Emerging Trends / 1st ed.
Chandos Publishing:

6. Rawley, Jennifer: Abstracting and Indexing services, 1988.

7. Sandra Hirsh. (2015). Information Services Today: An Introduction/ 1st
ed., Rowman & Littlefield,

8. Smith, Linda C., & Wong, Melissa A. (2010). Reference and
Information Services: An Introduction, / 5th ed., Libraries Unlimited,

9. Vickery, B: Information Systems, London: Butterworths, 1987.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3605 B

Course Title Internet Resource and Services
Type of Paper GE (Generic Elective)

Credit 4

Teaching Hours 60

Obijectives- To make the students aware of Internet and its related technologies in daily use.
Outcome- After completion of the course, students will be aware of well use of Internet
technology for learning.

Unit I: Internet: An Overview
> Internet: Introduction, Historical Development and Scope of Internet
» Internet Architecture: H/W & S/W Components
> Client/Server Principle, Routers, Connection Types, ISP, Protocols, Uniform
Resource Locator, IP Address
» Domain Name System

Unit 11: Web Languages & Web Browsers
» Web: Introduction, History and Functions

» Web Languages: HTML, XML, CSS, ASP, JavaScript, PHP
» Web Browsers: Internet Explorer, Mozilla Firefox, Google Chrome

Unit 111: Intranet & Internet Security
> Intranet: Components, Prerequisites and Services

» Extranet: Components, Prerequisites and Services
» Internet Security: Types of Security, Firewalls, Anti-Virus, Anti-Spyware

Unit IV: Internet Tools & Services
» Communication Tools: Email, Telnet, Discussion Groups

» Search Tools: Gopher, Veronica, Jughead, Archie, Search Engines
» Content Enriching Services: Blogs, Wikis, Social Community Websites
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RECOMMENDED BOOKS

1. Bates, Chris. (2006). Web Programming: Building Internet Applications. 3rded. New
Delhi: Wiley-India.

2. Crumlish BLIS, Christian. (2007). The ABCs of the Internet. New Delhi: BPB
Publications.

3. Hartl, Michael and Prochazka, Aurelius. (2007). Rails Space: Building a Social
Networking Website with Ruby on Rails. Addison-Wesley Professional.

4. Kalbach, James. (2007). Designing Web Navigation: Optimizing the User Experience.
Sebastopol: O'Reilly Media.

5. Miller, Joseph B. (2008). Internet Technologies and Information Services (Library and
Information Science Text Series).Libraries Unlimited.

6. Morville, Peter and Rosenfeld, Louis. (2006). Information Architecture for the World
Wide Web: Designing Large-Scale Web Sites. 3rd ed. Sebastopol: O'Reilly Media.

7. Nair, R. Raman. (2002). Internet for Information Services. New Delhi: Ess Ess
Publications.

8. Robbins, Jennifer Niederst. (2012). Learning Web Design: A Beginner's Guide to
HTML, CSS, JavaScript, and Web Graphics. 4th ed. Sebastopol: O'Reilly Media.

9. Sehgal, R. L. (2000). Internet and Internet for Librarians. New Delhi: Ess Ess
Publications.

10. Russell, Jesse and Cohn, Ronald (eds.). (2012). Web Browser. Book on Demand Ltd.

11. Stallings, William. (2007). Computer Networking with Internet Protocols and
Technology. Delhi: Pearson Education.

12. Weinberg, Tamar. (2009). The New Community Rules: Marketing on the Social Web.
Sebastopol: O'Reilly Media.

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar
Page 141 of 185



4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3606

Course Title Re-Envisioning of Law Library

Type of Paper IAPC (Internship/Apprenticeship/Project/Community Outreach)
Credit 2

Teaching Hours 30

Objectives- To make the students aware of new perspectives and strategies for designing,
managing, and enhancing law libraries in various contexts.

Outcome- After completion of the course, students will be able to understand the
importance of law libraries with a new perspective.

Unit I: Law Libraries in Contemporary Contexts

»> Definitions, Characteristics, Functions

Historical Evolution

Specific Needs and User Communities of Law Libraries

Digital Transformation and its Impact on Law Libraries

Challenges in Collection Development, Resource Management, and Information
Dissemination

YV V VYV

Unit 11: Innovating and Enhancing Law Libraries

» Designing Flexible and Collaborative Spaces

» Curating and Promoting Digital Collections

»> Strategies for Effective Content Discovery and Access

» Knowledge Sharing, Documentation, and Retention in Law Libraries
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RECOMMENDED BOOK

1. https://escholarship.org/content/gt5fx7r5p7/gt5fx7r5p7 noSplash 529b3faa6c1383f2cccf4
fa63e05d2a2.pdf

2. https://egyankosh.ac.in/bitstream/123456789/39094/1/Unit-2.pdf

3. Frederic D Donnelly ( Ed). The Law Library: A Living Trust, Institute of Law Librarians,
1963, Chicago.

4. Edwin C. Surreney, Benjamin Feld and Joseph Crea, A Guide to Legal Research, New York,
1959.

5. Legal Research in a Nutshell, West Publishing co. Minnesata 1978.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3607

Course Title Web Based Information Systems and Services (Practice)
Type of Paper Skill Enhancement Course (SEC)

Credit 2

Teaching Hours 30

Objectives- To acquaint the students with the HTML/CSS, Bootstrap, JS, practical of
various types of library resources.

Outcome- After completion of the course, students will be able to develop Website
Designing.

Unit I: Designing with HTML/CSS
» HTML

» CSS
» Bootstrap

» jQuery

Unit 11: Designing with Scripts
» JavaScript
» ReactJS
> Node JS
» Express JS

Hands-on experience on Unit-1 and 11

A. Practical written test on Unit-l and Il - 40 Marks
B. Viva Voce- 20 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLI1S3608 A

Course Title Technical Writing

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours 30

Objectives- To acquaint students with Communication Process, Planning and Organisation
of Technical / Scientific Writing, Technical Editing and Editorial Tools, Publication
Processand Ethics.

Outcome- After completion of the course, students will be confident about Communication
Process, Planning and Organisation of Technical / Scientific Writing, Technical Editing and
Editorial Tools, Publication Process and Ethics.

Unit I: Planning and Organisation of Technical / Scientific Writing

Definition, Structure, Purpose, Characteristics, and Functions.

Aberrations in Technical Writing

Collection, Organisation, and Presentation of Data including Illustrations.

Cast Studies: Preparation of Short Communications, Review Articles, Technical
Report, Monographs, Project proposals, Dissertations, and House Bulletins.

V'V VY

Unit I1: Technical Editing and Editorial Tools

» Editor, Editorial process, Editorial Tools

» Planning, Preparation, Production of Technical Information products.

» Dissemination of Technical Information Products.

» Publication Ethics: Copy Right, IPR, Legal Issues and Professional Ethics
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RECOMMENDED BOOKS

1. Elbow, Peter. Writing without teachers. New York. Oxford University Press. 1973.

2. Gowers, Sir. Ernest. The complete plane words. London: HMSO. 1954.

3. Holsinger, Donald C. A classroom laboratory for writing history. Social studies
review.31(1), 1991. pp. 59 64.

4. Kapp, Ro. The presentation of technical information. London: Constable 1948.

5. Kirkman, John. Good style for scientific and engineering writing. London: Pitman.
1980.

6. Parry, John. The psychology of human communication. London. University of
London Press. 1967.

7. Ramage John D and Bean John C. The allyn and bacon guide to writing. 2ed. London,
Allyn and Bacon. 2000. pp. 658.

8. Turk, Christopher and Kirkman, John. Effective writing: Improving scientific,
technical, and business communication. 2ed. London: Spon Press. 2007.

9. Winokur, Jon. Ed. Writers on Writing. Philadelphia running press: 1986.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3608 B

Course Title Disaster Management

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours 30

Objectives- To make students aware of the disaster management, its types and techniques
to manage disaster.

Outcome- After completion of the course, students will be aware of the techniques of
disaster management, various training and awareness programs and projects on disaster
management.

Unit I: Disaster Management

» Hazards and Disasters, Risk and Vulnerability in Disasters,

» Natural and Man-made Disasters, Earthquakes, Floods Drought, Landslide, Land
subsidence, Cyclones, Volcanoes, Tsunami, Avalanches, Global Climate Extremes.

» Man-made Disasters: Terrorism, Gas and Radiations Leaks, Toxic Waste Disposal,
Oil Spills, Forest Fires.

» Usages of GIS and Remote Sensing Techniques in Disaster Management

» Mini Project on Disaster Risk Assessment and Preparedness for Disasters

Unit I1: Mitigation and Management Techniques of Disaster

Basic Principles of Disaster Management

Disaster Management Cycle, Disaster Management Policy,

National and State Bodies for Disaster Management,

Early Warming Systems, Building Design and Construction in Highly Seismic
Zones, Retrofitting of Buildings.

Training and Drills for Disaster Preparedness

Awareness Generation Program

YV V VYV

Y V
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RECOMMENDED BOOKS

1. Disaster Management Guidelines, GOI-UND Disaster Risk Program (2009-2012)

2. Damon, P. Copola, (2006) Introduction to International Disaster Management,
Butterworth Heineman.

3. Gupta A. K., Niar S.S and Chatterjee S. (2013) Disaster management and Risk
Reduction, Role of Environmental Knowledge, Narosa Publishing House, Delhi.

4. Murthy D.B.N. (2012) Disaster Management, Deep and Deep Publication PVT.
Ltd. New Delhi.

5. Modh S. (2010) Managing Natural Disasters, Mac Millan publishers India LTD.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3609
Course Title Internship
Type of Paper Internship
Credit 4
Teaching Hours 60
Obijectives:

i. Totrain the students in practical librarianship in the working environment of the library
by deputing them in different types of libraries for a period of one month; and
ii. To train them in preparing the Internship Report in a prescribed format based on their
practical training and learning.
Outcome: After completion of the course, students will be able to works in Library without any

hesitation.

The work for paper shall start in the beginning of the SIXTH semester for which each student
will be allotted a topic for writing the Report. The Report will be submitted at the end of SIXTH

semester on the date to be decided by the Department.

A. Report on Internship Programme — 40 Marks
B. Viva-Voce — 20 Marks

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar
Page 149 of 185
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IV'h-Year, SEMESTER-VII

Course Code BLIS3701

Course Title Research and Publication Ethics

Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory
Credit 4

Teaching Hours 60

Objectives- To make students aware of the research and publication ethics. This course focuses
on basics of philosophy of science and ethics, research integrity, publication ethics.
Outcome- After completion of course, students will be aware about philosophy of science and
ethics, research integrity, publication ethics.

Unit I: Philosophy and Ethics

» Philosophy: Definitions, Nature and Scope
» Branches of Philosophy

» Ethics: Definitions, Moral Philosophy

» Nature of Moral Judgements and Reactions

Unit I1: Scientific Conduct

» Ethics with Respect to Science and Research

» Intellectual Honesty and Research Integrity

» Scientific Misconducts: Falsification, Fabrication, and Plagiarism (FFP)

» Redundant Publications: Duplicate and Overlapping Publications, Salami Slicing
» Selective Reporting and Misrepresentation of Data

Unit 111: Publication Ethics

Publication Ethics: Definitions and Importance

Best Practices / Standards setting Initiatives and Guidelines: COPE, WAME, etc.
Conflicts of Interest

Publication Misconduct

Violation of Publication Ethics, Authorship and Contributorship

Identification of Publication Misconduct, Complaints and Appeals

Predatory Publishers and Journals

VVVYVYVY

Unit 1V: Open Access Publishing

» Open Access Publications and Initiatives

» SHERPA/ROMEO Online Resource to Check Publisher Copyright & Self-Archiving
Policies

» Software Tool to Identify Predatory Publications Developed by SPPU

» Journal Finder / Journal Suggestion Tools viz. JANE, Elsevier Journal Finder, Springer
Journal Suggester, etc.
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RECOMMENDED BOOKS

N

~

8.

Bird, A. (2006), Philosophy of Science, Routledge.

Maclntyre, Alasdair (1967) A Short History of Ethics. London

P. Chaddah, (2018) Ethics in Competitive Research: Do not get scooped; do not get
plagiarized, ISBN:978-9387480865

National Academy of Science, National Academy of Engineering and Institute of
Medicine. (2009). On Being a Scientist: A Guide to Responsible Conduct in Research:
Third Edition, National Academies Press.

Resnik, D.B. (2011), what is ethics in research & why is it important. National Institute
of Environmental Health Science, 1-10. Retrieved from
https://www.niehs.nih.gov/research/resources/bioethics/whatis/index.cfm

Beall, J. (2012). Predatory publishers are corrupting open access. Nature, 489(7414),
179-179.

. https://doi.org/10.1038/489179a

Indian National Science Academy (INSA), Ethics in Science Education, Research and
Governance (2019)
ISBN:97881939482-1-7. http://www.insaindia.res.in/pdf/Ethics_Book.pdf
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3702 A

Course Title Research Methodology

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Obijectives- To make the students aware of the research methodology concepts, definitions, and
various techniques used for data analysis in research.

Outcome- After completion of course, students will be aware of implications of research and
confident to take up research work.

Unit I Foundations of Research and Research Design
» Concept, Meaning, Need and Process of Research
» Types of Research: Fundamental and Applied
» Research Design, Types of Research Design
» Designing Research Proposal, Literature Search and Literature Review

Unit 11: Research Methods
» Types of Research: Qualitative and Quantitative method of LIS research
» Scientific Method
» Historical Method, Survey and Case Study Method
» Experimental Method

Unit I11: Data Analysis and Interpretation
» Data Collection Techniques: Questionnaire, Interview, Observation, Sampling and Delphi
» Presentation of Data-Tables, Charts and Graphs
» Interpretation of Data: Frequency Distribution, Measures of Central Tendency, Analysis of
Time Series, Co-relation Studies, and Analysis of Variance
» Use of Statistical Packages

Unit IV: Statistics and its Applications

» Descriptive Statistics — Measures of Central Tendency: & Dispersion, Correlations and
Linear Regression, Chi-Square Test, t-test, z-test, f-test
Presentation of Data: Tabular, Graphic, Bar Diagram and Pie Chart, etc. Report Writing
Statistical Packages — MS-Excel, SPSS, and Web-Based Statistical Analysis Tools, etc.
Plagiarism- Self Plagiarism, Anti-Plagiarism Guidelines and Software
Metric Studies - Scientometrics, Informetric and Webometrics
Style Manuals- Manual Structure, Style, Contents- MLA, APA, CHICAGO.

VVV 'V
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RECOMMENDED BOOKS

1.

10.
11.
12.
13.
14.

15.
16.

17.

18.

Booth, W. C., Williams, J. M. and Colomb, G. G. (2003). The Craft of Research.
University of Chicago Press.

Borgman, Christie L., ed. (1990). Scholarly Communication and Bibliometrics.
Newbury Park, CA: Sage Publications, Inc.

Brady, John. (1997). The Craft of Interviewing. New York: Vintage.

Busha, Charles H. and Harter, Stephen P. (1980) Research Methods in
Librarianship. New York: Academic Press.

Davis, GB (1997) Management Information System: Concept, Foundation
Structure and Development. New York: McGraw Hill.

Gillham, Bill. (2000). The Research Interview. London: Continuum Press.

Gupta, B. M. (1996). Bibliometrics, Scientometrics and Infometrics. New Delhi:
Segment Books.

Khanna, J K (2000) Documentation and Information Services, Systems and
Techniques. Agra: YK Publishers.

Kish, Leslie. (1995). Survey Sampling. New York: Wiley.

Marshall, Catherine and Rossman, Gretchen B (2006). Designing Qualitative
Research. Sage USA.

Nielsen, Jakob. (2000). Designing Web Usability. New Riders, USA.

Payne, Stanley. (1951). The Art of Asking Questions. Princeton University Press.
Raju, Nemani Govinda. (2009). Bibliometric Applications: Study of Literature
Use Patterns

Rea, Louis M and Parker , Richard A. (2005). Designing and Conducting Survey
Research, San Francisco: Jossey-Bass.

Reinard , John C. (2006). Communication Research Statistics. Sage, USA.
Rowntree, Derek. (2003). Statistics without Tears: A Primer for Non-
Mathematicians. London: Penguin.

Rubin, Herbert and Irene. (2004). Qualitative Interviewing: The Art of Hearing
Data. Sage, USA.

Sudman, Seymour (1976). Applied Sampling. New York: Academic Press.

Department of Library and Information Science, Mahatma Gandhi Central University, Motihari, Bihar

Page 153 of 185
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Course Code BLIS3702 B

Course Title Digital Library

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware with content management concepts, content
developing strategies and digitization in library.

Outcome- After completion of the course, students will be able to understand the content
management, content developing strategies and digitization of information resources.

Unit I Digital Library
» Definitions, Fundamentals and Theoretical aspects; Characteristics of Digital Libraries
and Nature of Digital Library Collections
» Major Digital Library Initiatives
» Design and Organization of Digital Libraries: Architecture, Interoperability, Protocols,
and Standards; User Interfaces

Unit I1: Digital Resource Management
» Digital Content Creation: Electronic documents, files & formats & conversion to PDF

» Digital Resources Management; Access to and Use of Digital Libraries
» Digital Storage, Archiving and Preserving Digital Collections

Unit I11: Digital Library Architecture
» Digital Library: Elements

» DOI, Open URL, Cross Reference and other aspects, Metadata, MARC 21, Dublincore,
Access Control and DRM, Security, and Parameter Issues

Unit 1V: Digital Library & Institutional Repository Software
» Digital Library Software: Concept, Definitions, Types, Characteristics

» Installation and Developing Collection using DSpace, GSDL
» Copyright Issues in Development of Digital Library Software
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RECOMMENDED BOOKS

1.

10.

11.
12.

13.

14.

15.

16.
17.

Arthur, M.H. (2006). Expanding a digital content management system for the growing
digital media enterprise. Boston: Elsevier Focal Press.

Barrie, M. N. (2009). Joomla! 1.5: a user’s guide: building a successful Joomla! Powered
website. Upper Saddle River, NJ: Prentice Hall.

Bishop, A. P. et al. (eds.). (2005). Digital Library Use: Social Practice in Design and
Evaluation. Delhi: Ane Books.

Bradford, L. E. (2008). Content management systems in libraries: case studies. Lanham,
MD: Scarecrow Press.

Chowdhury, G. G. & Chowdhury, Sudatta. (2003). Introduction to Digital Libraries.
London: Facet.

Cooper, Michael D. Design of Library Automation Systems: File Structure, Data
Structures and Tools, New York: John Wiley, 1996.

Deegan, Marilyn & Tanner, S. (2006). Digital Preservation. London: Facet Publishing.
Hal Stern, Brad Williams and David Damstra. (2010). Professional WordPress: design
anddevelopment. Indianapolis, IN: Wiley Pub., Inc.

Janet Majure. (2010). Teach yourself visually WordPress. Indianapolis, IN: Wiley Pub., Inc.
Jason, C. and Helen, F. (2008). Using Moodle. Sebastopol, CA: O’Reilly Community
Press.

Jen, K.P. and Sarah, E. (2010). Joomla! Start to finish. Indianapolis, IN: Wiley Pub., Inc.
Jennifer Marriott and Elin Waring. (2011). The official Joomla! Book. Upper Saddle
River, NJ: Addison-Wesley.

John M. Cohn, Ann L. Kelsey and Keith Michael Fiels, Planning for Library
automation: A Practical Handbook London: Library Association, 1998.

John M. Colon, Annl Kelsey, Keith Michael Fiels. Planning for Automation: A How-to-
do-it for Librarian. 2nd ed.(S.1.): Neal-Schuman, 1997.

Jones, Richard et al. (2006). The Institutional Repository. Oxford: Chandos Publishing.
Judith, Andrews & Derek, Law. (2004). Digital Libraries. Hants: Ashgate.

Kausik Bose Information Networks in India: Problems and Prospects / New Delhi: ESSEss
Publications, 1994.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3702 C

Course Title Change Management

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware with concepts of change and change management,
its types and principles.

Outcome- After completion of the course, students will be able to understand concepts of
change and change management, its types, principles and also how to manage change.

Unit I: An Introduction to Change Management

» Management: Concept, Definitions

» Functions of Management

» Change Management

» Need for Changes: Internal forces & External forces.
Unit I1: Change Management

» Types of Change
» Change Management Process
» Strategies for Change Management
» Resistance to Change
Unit I11: Issues and Challenges in Change Management

» Responsibility for Managing Change
> Role of the People in Change Management
» Issues and Challenges in Change Management
» Change Management Principles
Unit IV: Managing Change

» Consent to Change

» Psychological Contract and People Organizational Relationship
» Change Management in LICs

» Kotter’s ‘Eight Steps to Successful Change’
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

no

10.

11.

https://egyankosh.ac.in/bitstream/123456789/35878/5/Unit-3.pdf
https://egyankosh.ac.in/bitstream/123456789/21327/1/Unit-2.pdf

Abrahamson, Eric. “Change Without Pain”. Harvard Business Review 78.4 (2000):75-
79. Print.

Auldey, Genus. Management of Change: Perspective and Practice. London:
International Thomson Business Press, 1998. Print.

Bailey, John. Communicating Change. London: McGraw-Hill, 1995. Print.

Managing People and Technological Change. Long-Acre: Pitman, 1993. Print.

Bryson, J. Effective Library and Information Centre Management. 2nd Ed. Aldershot:
Gower, 1999. Print.

Carnall, Colin A. Managing Change in Organisation. New York: Prentice Hall, 1990.
Print.

Cole, G.A. Management Theory and Practice. 5th Ed. London: Continuum, 1996. Print.
Fred Luthans, (1998). Organizational Behaviour, International Eighth edition, Irwin
McGraw Hill. Robbins, S.P. (1994). Organizational behaviour, concepts, controversies
and applications, 6th edition, N.J. Prentice Hall.

Schultz, D.P. and Schultz, S.E.(1990). Psychology and Industry today, An introduction
to industrial and organizational psychology, 5th edition, NY. McMillon.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3702 D

Course Title Project Management

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To develop critical thinking and knowledge in project management and to provide
the students with analytical skills for solving problems relating to project management.
Outcome- After completion of the course, students will be able to understand project
management and develop analytical skills for solving problems relating to project management.

Unit I: Project Management an Overview

Project Management: Concept, Definitions, Need
The Project Life Cycle

Project Interfaces

Success Factors in Project Management

YV V VYV

Unit I1: Project Management Information System (PMIS)
» Objectives of PMIS
» Planning by Network Analysis: Resource Allocation, WBS.
» Cost Control System
» Project Monitoring & Reporting

Unit I11: Strategic Management and Project Selection
» Project Selection and Criteria
» Types of Project Selection Models
» Nature of Project Selection Models
» Functions, Roles and Responsibilities of a Project Manager

Unit 1V: Tools and Techniques of Project Management
» Project Execution Plan (PEP)
» PERT/CPM
» Time Estimation
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1.

N

©o 0k~ w

~

https://dde.pondiuni.edu.in/files/StudyMaterials/MBA/MBA3Semester/Finance/4Proje
ctManagement.pdf
https://ebooks.lpude.in/management/mba/term_3/DMGT521_PROJECT_MANAGE
MENT.pdf

https://egyankosh.ac.in/handle/123456789/17452
https://egyankosh.ac.in/bitstream/123456789/10726/1/Unit-1.pdf
https://egyankosh.ac.in/bitstream/123456789/10764/1/Unit-11.pdf

Davis GB & Olson M.H., Management Information Systems, McGraw- Hill
International Editors

McRae. TW, Management Information Systems- Selected Readings, Penguin.
https://egyankosh.ac.in/bitstream/123456789/10764/1/Unit-11.pdf
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3702 E

Course Title Indian Culture and Tradition

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4

Teaching Hours 60

Objectives- To make the students aware with the Indian culture and tradition, its meaning,
sources of study of Indian culture etc.

Outcomes- After completion of the course, students will be able to understand about Indian
culture and traditions in detail. It will also help them to develop an understanding towards pre-
historic cultures, proto-historic cultures, Vedic & Post-Vedic periods, etc.

Unit I: Meaning and Concepts of Culture

Traditional and Modern Concepts of Culture

Elements of Culture, Concept of Indianness and Value System
Relation Between Culture and Civilization

Heritage of India and World’s Debt to Indian Culture

YV V VYV

Unit I1: Sources of the Study of Indian Culture

» Archaeological: Cultural Remains, Monuments, Numismatics, Epigraphy
» Literary Sources and Oral Traditions

» Foreign Accounts

» Archival Sources

Unit I11: Pre-Historic and Proto-Historic Cultures

» Stone Age Cultures- Paleolithic, Mesolithic and Neolithic;

» Proto-Historic Cultures - Chalcolithic Horizon, Harappan Culture- Current Debates on
Nomenclature and Scripts

» Town Planning and Architecture, Art, Social, Religious and Economic Life

» Evolution of India’s Main Language Families

Unit 1V: Vedic and Post-Vedic Period

» Early Vedic and Later Vedic Ideas and Institutions: Social, Religious, Economic, Political
and Scientific

» Post Vedic—- Religious Movements and Emergence of States

Shramana Traditions- Buddhism, Jainism, Ajivikas and Other Sectors

Education System and Centres— Taxila and Kashi

YV V
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

https://egyankosh.ac.in/bitstream/123456789/47224/1/Unit-1.pdf

https://www.nios.ac.in/media/documents/Secl CHCour/English/CH.02.pdf

https://ddceutkal.ac.in/Syllabus/MA _history/paper-8-N.pdf

Gore, M. S., Unity in Diversity: The Indian Experience in Nation-Building, Rawat

Publication, Jaipur, 2002.

5. Malik, S. C., Understanding Indian Civilization: A Framework of Enquiry, Indian
Institute of Advanced Study, Shimla, 1975.

6. Mukerji, D. P., Sociology of Indian Culture, Rawat Publications, Jaipur,1948/1979.

7. Pandey, Govind Chandra, Foundations of Indian Culture, Books and Books, New Delhi,
1984.

8. Dube, S.C. 1990.Indian Society New Delhi: National Book Trust, India.

9. Majumdar, R.C. (ed.).1951. The Vedic Age, London.

10. Kochhar, Rajesh 2000. The Vedic people: Their history and geography. New Delhi:
Orient Longman Limited.

11. Luniya, B.N., Evolution of Indian Culture. 4th Ed. Lakshmi Narain Agarwal, Agra,

1967.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3703

Course Title Library Minor Project/ Dissertation
Type of Paper VAC (Value- Added Course)
Credit 6

Teaching Hours {90

Objectives- To make the students aware about writing a library project/ dissertation.
Outcome- After completion of the course, students will be aware about library project/

dissertation writing.

Dissertation work shall start in the beginning of the SEVENTH semester for which each student
will be allotted a topic for writing the Dissertation. The Dissertation will be submitted at the

end of SEVENTH semester on the date to be decided by the Department.

A. Dissertation Evaluation by External and Internal Examiner: 25 X 2 = 50 Marks
B. Viva-Voce: 25 X 2 =50 Marks
C. Total: A + B =100 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3704
Course Title Internship
Type of Paper Internship
Credit 8
Teaching Hours 120
Obijectives-

i. To train the students in practical librarianship in the working environment of the
library by deputing them in different types of libraries for a period of one month; and
ii. To train them in preparing the Internship Report in a prescribed format based on their
practical training and learning.
Outcome- After completion of the course, students will be able to work in Library without any
hesitation.

The work for paper shall start in the beginning of the SEVENTH semester for which each
student will be allotted a topic for writing the Report. The Report will be submitted at the end
of SEVENTH semester on the date to be decided by the Department.

A. Report on Internship Programme — 40 Marks
B. Viva-Voce — 20 Marks
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code

BLIS3705 A

Course Title LIS Research
Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours

30

Objective- To make the students understand about the development of research in the field of

LIS.

Outcome- After completion of the course, students will be able to understand the concepts of
research in the field of LIS.

Unit I: Development of Research in LIS

YV V VY

Beginning of LIS Education
Research in LIS

Relevance of Research in LIS
Ranganathan’s Work

Unit I1: Research Tools and Techniques in Library Science

YVVVVYYV

Research Process
Questionnaire Method
Observation Method

Interview Method

Recent Trends in LIS Research
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. https://files.eric.ed.gov/fulltext/EJ1311932.pdf

2. https://egyankosh.ac.in/bitstream/123456789/11204/1/Unit-1.pdf
3. Best, John W and Kahn James, V. (1999). Research in Education. 2nd ed. New Delhi:

Prentice Hall of India.

4. Busha, Charles H and Harter, Stephen H (1988). Research Methods in Librarianship:
Techniques and Interpretations. New York: Academic Press.

5. De Vaus, David (2001). Research Design in Social Research. New Delhi: Sage
Publications.

6. Encyclopedia of Library and Information Science (1978). Ed. by Allen Kent [et al.]
Research Methodology. V. 25. New York: Marcell Dekker.

7. Ghosh B N (1984). Scientific Method and Social Research. 2nd ed. Delhi: Sterling.

8. Goode, William J and Hart, Paul K (1981). Methods of Social Research. London:
McGraw Hill.

9. Kerlington, Fred. Ed.(1964). Foundations of Behavioural Research, Educational and
Psychological Inquiry. New York: Rinehart and Winston.
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BLIS3705 B

Course Title Organisational Behaviour

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours |30

Objectives- To make the students understand about the individuals and groups behaviour
inside the organizations.

Outcomes- After completion of the course, students will be skilled in understanding and
appreciating individuals, interpersonal, and group process for increased effectiveness both
within and outside of organizations.

Unit I: Focus and Purpose

» Definition, Need and Importance of Organizational Behaviour — Nature and Scope —
Frame Work —Organizational Behavior Models

» Organization and the Environmental Factors

» Organizational Theory, Organizational Behavior Modification

» Misbehavior —Types

Unit I1: Individual Behavior and Group Behaviour

» Personality — Types — Factors Influencing Personality — Theories

» Attitudes — Characteristics — Components — Formation — Measurement- Values

» Perceptions — Importance — Factors Influencing Perception — Interpersonal Perception-
Impression Management. Emotions and Moods in Workplace

» Organization Structure — Formation — Groups in Organizations — Influence — Group
Dynamics —Interpersonal Communication

» Team Building - Interpersonal Relations — Group Decision Making Techniques.

» Meaning of Conflict and its Types, Conflict Redressal Process
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

Human Behavior at work by Keith Devis

Organizational Behavior; Concepts, Skills and Practices by Kinicki Kreitner
Dimension of Organizational Behavior by T. Herbert
Organization & Management by R. D. Agrawal

Organizational Behavior and Performance by Aszilagyl & Walace
Organizational Behavior by K. Aswathapa

Organizational Behavior by Jit Chandan

Organizational Behavior by V. Ghosh

Organizational Behavior by Gregory Morehead

10 Organizational Behavior by Fred Luthans

11. Organizational Behavior by Rosy Joshi

12. Organizational Behavior by Stephen Robbins

© o Nk bR
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4-Year Bachelor (Honours with Research) in Library and Information Science

IV!h-Year, SEMESTER-VIII

Course Code BL1S3801

Course Title Information Communication Technology: Application

Type of Paper Core/DSC (Discipline Specific Core Course) Compulsory
Credit 4
Teaching Hours |60

Obijectives- Students will gain experience with a range of ICT tools and platforms, enabling
them to effectively use and apply technology to solve real-world problems.

Outcome- By the end of the course, students would be able to demonstrate proficiency in using
various ICT tools and platforms. Evaluate the ethical, social, and security implications of ICT
applications. Collaborate and communicate effectively using ICTs.

Unit I: Introduction to Information Communication Technologies

» Overview of ICTs and their Significance
» Evolution of Technology and Impact on Society
» Digital Literacy and Technology Skills

Unit I1: Productivity and Collaboration Tools

» Using Office Suites (e.g., Microsoft Office, Google Workspace)
» Collaborative Document Editing and Cloud Storage
» Project Management Tools and Techniques

Unit I11: Web and Multimedia Applications

» Creating and Maintaining Websites (e.g., WordPress, Wix)
» Graphic Design and Image Editing Tools
» Introduction to Audio and Video Editing

Unit 1V: Data Management and Analysis

» Introduction to Data Management
» Spreadsheet Applications (e.g., Microsoft Excel, Google Sheets)
» Basic Data Analysis and Visualization Tools
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

1. https://ncert.nic.in/vocational/pdf/iees103.pdf

Kumar, P. S. G. (2004). Information and Communication. Delhi: B. R.Publication.

3. Database Management Systems (3rd Edition). Raghu Ramakrishnan and Johannes
Gehrke. McGraw Hill, 2003.

4. https://cs.uwaterloo.ca/~gweddell/cs348/1-overview-handout-notes.pdf

https://www.egyankosh.ac.in/handle/123456789/971

6. https://www.manage.gov.in/studymaterial/PM.pdf

LA
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3802 A

Course Title Special Library and Information System

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4
Teaching Hours |60

Objectives- To make the students aware of the objectives, development, collection
development, organisational structure, services, financial and HRM of Special Library and
Information System.

Outcome- After completion of the course, students will be aware of objectives, development,
collection development, organisational structure, services, financial and HRM of Special
Library and Information System.

Unit I: Special Libraries and their Development
» Objectives and Functions
» Development of Special Libraries
» Role of Government, Committees and Other Agencies in the Development of Special
Libraries in India

Unit I1: Collection Development and Management
» Books and Periodicals
» Conference Literature, Grey Literature and Government Publications
» Non-Book Materials: Electronic-Resources, Databases

Unit I11: Library Organization and Services
» Organizational Structure of Special Library
» Staff Manual, Library Surveys, Statistics and Standards, etc.
» CAS, SDI, Abstracting and Indexing Services, Library Bulletin
» Resource Sharing and Networking

Unit IV: Financial and Human Resource Management
» Determination of Finance, Sources of Finance
» Types of Budgets
» Nature, Size, Selection, Recruitment, Qualification and Training
» Responsibilities and Duties
» Competency Development Case Study of Special Libraries in India
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4-Year Bachelor (Honours with Research) in Library and Information Science

RECOMMENDED BOOKS

10.

11.
12.

13.

https://egyankosh.ac.in/bitstream/123456789/33045/1/Unit-8.pdf
https://epgp.inflibnet.ac.in/epgpdata/uploads/epgp_content/S000021L1/P000102/MO
04257/ET/1498804480ModulelDSRL-1-etext-
SpecialLibraryCharacteristicsandFunctions.pdf

Ahrenfield, J.L. [et al]. (1981). Special Libraries: A Guide for Management. New
York: Special Library Association.

Gates J.K. (1968). Introduction to Librarianship. New York: Mc-Graw-Hill.

Harvey, Joan M. (1976). Specialist Information Centres. London: Clive Bingley
Kent, Allen (et.al) (ed.) (1980). Encyclopedia of Library and Information Science,
V01.28. pp.386-97: New York: Marcel Dekkar

Silve, Manil (1970). Special Libraries: Andre Deutsch (Grfton Basic Texts): London.
Strauss, L.J. (et.al) (1964). Scientific and Technical Libraries: Their Organisation and
Administration. New York: Inter Science Publication.

Weisman, Herman M. (1972). Information Systems, Services and Centres. New York:
BeckBr and Hayes.

Dana, J. C. (1991). The evolution of special library. In C. A. Hanson, ed. Librarian at
large: Selected writings of John Cotton Dana (pp. 55-64). Washington: Special
Libraries Association.

Echelman, S. (1976). Towards the new special library. Library Journal, 101(1), 91-94.
Frank S. Schick and Paul Howard (Comp.) (1968). Survey of special libraries serving
the Federal Government. Washington: U.S.G.P.O.

Ferguson, Elizabeth and Mobley, Emily R (1984). Special libraries at work. Hamden:
Library Professional (p. 4).
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4-Year Bachelor (Honours with Research) in Library and Information Science

Course Code BL1S3802 B

Course Title Engineering Library and Information System

Type of Paper DSE (Discipline Specific Elective Course)

Credit 4

Teaching Hours |60

Objectives- To make the students aware of the objectives, development, collection development,
organisational structure, services, financial and HRM of Engineering and Technological
Library and Information System.

Outcome- After completion of the course, students will be aware of objectives, development,
collection development, organisational structure, services, financial and HRM of Engineering
and Technological Library and Information System.

Unit I: Engineering and Technological Libraries and their Development
» Objectives and Functions
» Development of Engineering and Technological Libraries
» Role of Government, Committees and Other Agencies in the Development of
Engineering and Technological Libraries in India

Unit 11: Collection Development and Management
» Books and Periodicals
» Conference Literature, Grey Literature and Government Publications
» Non-Book Materials: Electronic-Resources, Databases

Unit I11: Library Organization and Services
» Organizational Structure of Engineering and Technological Library
» Staff Manual, Library Surveys, Statistics and Standards, etc.
» CAS, SDI, Abstracting and Indexing Services, Library Bulletin
» Resource Sharing and Networking

Unit IV: Financial and Human Resource Management
» Determination of Finance, Sources of Finance
» Types of Budgets
» Nature, Size, Selection, Recruitment, Qualification and Training
» Responsibilities and Duties
» Competency Development Case Study of Engineering and Technological Library in
India
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

RECOMMENDED BOOKS

1.

Ramesh, B.D., Sahu, J.R., and Karisiddappa, C.R. (1999). Accessing Engineering
Resources on the Internet. In: Proceedings of Library Vision - 2010-Indian Libraries
and Librarianship in Retrospect and Prospect held at Hissar, India. Edited byJ. L.
Sardana .pp.223-231.

Arikrishnan (2010) e-Resources for Engineering and Technology: An Overview,
University News, VVol.48, No.33, p20-24

Parashar, Datta and Patnaik, (2011), Flexibility in Engineering Education. University
News, Vol.49.No0.50. p. 101-114.

Vikas, (2011), Quality up gradation in engineering education network (QUEEN).
University News, Vol.49.No.42. p. 26-29.

Bhatt and Rana, (2011), Engineering and Management: The two most-sought after
fields. University News, Vol.49.No.36. p. 9-17.

Rupsing, (2007), AICTE Policy for Collection Development in Engineering College
Libraries. Library and information science journalvol.1,No.2, p. 40-43,

Singh and Singh, (2011), Web Based Library Services in Engineering College
Punjab: A Case Study.
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

Course Code BLI1S3802 C

Course Title Health Science Library and Information System

Type of Paper DSE (Discipline Specific Elective Course)
Credit 4
Teaching Hours |60

Obijectives- To make the students aware of the objectives, development, collection development,
organisational structure, services, financial and HRM of Health Science Library and
Information System.

Outcome- After completion of the course, students will be aware of objectives, development,
collection development, organisational structure, services, financial and HRM of Health
Science Library and Information System.

Unit I: Health Science Libraries and their Development
» Objectives and Functions
» History and Development of Health Libraries with Special Reference to India
» History and Development of Health Libraries with Special Reference to
Abroad
» Medical Libraries Information Policies in India

Unit I1: Collection Development and Management
» Books and Periodicals
» Conference Literature, Grey Literature and Government Publications
» Non-Book Materials: Electronic-Resources
» Databases

Unit I11: Library Organization and Services
» Organizational Structure of Medical Libraries
» Staff Manual, Library Surveys, Statistics and Standards, etc.
» CAS, SDI, Abstracting and Indexing Services, Library Bulletin
» Resource Sharing and Networking

Unit IV: Financial and Human Resource Management

Determination of Finance, Sources of Finance

Types of Budgets

Nature, Size, Selection, Recruitment, Qualification and Training
Responsibilities and Duties

Competency Development Case Study of Health Libraries in India

YV VVYV
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

RECOMMENDED BOOKS

1.

10.

Baker, P.G. (1997). Electronic libraries of the future. Encyclopaedia of library and
information science, Volume 50, supplement 22. Edited by Allan Kant and Hall, CM.
New York, Marcel Dekker, p. 119-153

Dixit, R.P. (1995). Information management in Indian medical libraries. New Delhi,
New Concept, p. 227-238.

Godlee, F., et al. Can we achieve health information for all by 2015. The Lancet,
295- 300.

Money, P.K. and Nagaraj, C. (2007). Health information management: an
introduction to disease classification and coding. National Medical Journal of India.
20(6), p. 307- 310

Planning Commission. Government of India 11th Five Year Plan (2007-2012).
Report of the working group on health systems research, biomedical research &
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

Course Code BLI1S3802 D

Course Title Agricultural Sciences Library and Information System

Type of Paper DSE (Discipline Specific Elective Course)

Credit 4

Teaching Hours |60

Objectives- To make the students aware of the objectives, development, collection
development, organisational structure, services, financial and HRM of Agricultural Sciences
Library and Information System

Outcome- After completion of the course, students will be aware of objectives, development,
collection development, organisational structure, services, financial and HRM of Agricultural
Sciences Library and Information System.

Unit I: Agricultural Science Libraries and their Development
» Objectives and Functions
» History and Development of Agricultural Libraries with Special Reference to
India
» History and Development of Agricultural Libraries with Special Reference to
Abroad
> Role of ICAR, Committees and Other Agencies in the Development of
Agricultural Libraries in India

Unit 11: Collection Development and Management
> Books and Periodicals
» Conference Literature, Grey Literature and Government Publications
» Non-Book Materials: Electronic-Resources, Databases

Unit I11: Library Organization and Services
» Organizational Structure of Agricultural Library
» Staff Manual, Library Surveys, Statistics and Standards, etc.
» CAS, SDI, Abstracting and Indexing Services, Library Bulletin
» Resource Sharing and Networking

Unit IV: Financial and Human Resource Management

Determination of Finance, Sources of Finance

Types of Budgets

Nature, Size, Selection, Recruitment, Qualification and Training
Responsibilities and Duties

Competency Development Case Study of Agricultural Library in India

YVYVYYVYY
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RECOMMENDED BOOKS

1. BHATT (V S): Information resources in agricultural research in 40years of
agricultural research in India (1989) ICAR, New Delhi.

2. CHOTEY LAL (C): Agricultural libraries and information systems: a
handbook for users (1998) R K Techno Science Agency, New Delhi.

3. DAYMATH (Y) and RUTTAN (V W): Agricultural development: an
international perspective (1979) John Hopkins, Baltimore.

4. DESHMUKH (P P): Standardization of library and information services with
special reference to scientific and agricultural libraries (1990) ABC, New
Delhi.

5. KUMAR (P S G): Agricultural librarianship: M.L.I.Sc. elective paper (2008)
B.R. Publication, New Delhi.

6. SHARMA (R D): The agricultural information network for India (1989)
Society for Information Science, New Delhi.

7. SUBBAIHA (R): Agricultural librarianship in India: an overview (1988)
Metropolitan, New Delhi.

8. SWAMINATHAN (M S): Report of the working group on agricultural
research and education for the formulation of the eighth plan (1989) Planning
Commission, ICAR, New Delhi.
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

Course Code BLI1S3802 E

Course Title Information Resource Development

Type of Paper DSE (Discipline Specific Elective Course)

Credit 4

Teaching Hours |60

Obijectives- To acquaint students with various information resource development principles
and selection tools.

Outcome- After completion of the course, students will be confident enough to equip the library
by using various information resource selection tools and principles.

Unit I: Types of Information Resources
» Documentary (Primary, Secondary & Tertiary)
» Non-Documentary
» E-Resources

Unit I1: Book Selection Principles
» Drury’s Principle
» Dewey’s Principle
» McColvin’s Principle
» Ranganathan’s Principle

Unit I11: Selection Tools
» Current List, Bibliographies
» Library Catalogue
» Books in Print
» Publishers’ Catalogue, Directories, WebOPAC (WorldCat), Websites

Unit IV: Categories of Documents
» By Physical Characteristics
» By Information Characteristics
» Books and Periodicals, Theses and Dissertations
» Govt. Publications, Grey Literature
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

RECOMMENDED BOOKS

1.

10.

11.

12.

Keith R. McCloy. (1995). Resource management information systems: process
and practice. Bristol, PA: Taylor & Francis. London.

Kenneth C. Laudon, Jane Price Laudon. (2002). Management information
systems: managing the digital firm. Prentice-Hall. New Jersey, USA

Margaret C. Harrell ... [et al.]. (2011). Information systems technician rating
stakeholders: implications for effective performance. Santa Monica, CA : RAND
National Defense Research Institute

Mcnurlin. (2003). Information Systems Management in Practice. Pearson
Education India. Delhi.

Okon. E. Ani & Blessing Ahiauzu. (2008). Towards effective development of
electronic information resources in Nigerian university libraries. Emerald Group
Publishing Ltd.

Pitschmann, Louis. (2001). A Building sustainable collections of free third-party
Web resources. Washington, D.C.: Digital Library Federation, Council on Library
and Information Resources.

Smith, Allen N. & Donald B. Medley.(1987). Information resource management.
South-Western Pub. Co. Cincinnati.

Smith, Abby. (2001). Strategies for building digitized collections. Washington,
D.C.: Digital Library Federation, Council on Library and Information Resources
Tarig Ashraf and Puja Anand Gulati. (2012). Design, Development, and
Management of Resources for Digital Library Services. Amazon.co.uk

Timothy D. Jewell et al. (2005). Electronic Resource management: report of the
DLF resource management initiative. Digital Library Federation. Washington D
C

Turban. (2008). Information Technology for Management: Transforming
Organizations in The Digital Economy, 4th ed. Jon Wiley & Son. USA

William G. Smith & Associates. (1991). Information resource management
policies. Database Research Group. Boston
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

Course Code

BLI1S3803

Course Title Academic Project/ Dissertation
Type of Paper VAC (Value-Added Course)
Credit 6

Teaching Hours |90

Objectives- To make the students aware about writing a dissertation.
Outcome- After completion of the course, students will be aware about dissertation writing.

Dissertation work shall be start in the beginning of the EIGHTH semester for which each

student will be allotted a topic for writing the Dissertation. The Dissertation will be submitted

at the end of EIGHTH semester on the date to be decided by the Department.

A. Dissertation Evaluation by External and Internal Examiner: 25 X 2 =50 Marks
B. Viva-Voce: 25 X 2 = 50 Marks
C. Total: A + B =100 Marks
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

Course Code BLI1S3804
Course Title Internship
Type of Paper Internship
Credit 8
Teaching Hours 120

Objectives-

i. Totrain the students in practical librarianship in the working environment of the library
by deputing them in different types of libraries for a period of one month; and
ii. To train them in preparing the Internship Report in a prescribed format based on their
practical training and learning.
Outcome- After completion of the course, students will be able to works in Library without

any hesitation.

The work for paper shall start in the beginning of the EIGHTH semester for which each student

will be allotted a topic for writing the Report. The Report will be submitted at the end of
EIGHTH semester on the date to be decided by the Department.

A. Report on Internship Programme — 40 Marks
B. Viva-Voce — 20 Marks
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

Course Code BLIS3805A

Course Title Semantic Web

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours |30

Objectives- To make the students aware about the fundamental concepts of the Semantic Web,
to describe the importance of semantic technologies for data representation and integration.
Outcomes- After completion of the course, students will be able to understand the semantic web
Vision and technologies and model data using RDF (Resource Description Framework).

Unit I: Introduction to the Semantic Web

Overview of the Semantic Web and its Goals

Benefits of Semantic Technologies for Data Integration
Semantic Web Standards and Languages

Introduction to Ontologies and their Role in the Semantic Web
Overview of the Web Ontology Language (OWL)

Creating and Reasoning with OWL Ontologies

VVVYVYYY

Unit 2: RDF and Linked Data

Understanding RDF Triples (Subject, Predicate, Object)

Creating RDF Graphs and Resources

Linked Data Principles and Best Practices

Introduction to SPARQL and its Role in Querying Semantic Data
Constructing SPARQL Queries to Retrieve Data

Joining and filtering Data using SPARQL

YVVVYYV

Mahatma Buddha Campus, Bankat, Motihari, East Champanagar, Bihar
Page 182 of 185
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RECOMMENDED BOOKS

1. Semantic Web for the Working Ontologist: Effective Modeling in RDFS and OWL"
by Dean Allemang and James Hendler

2. "Learning SPARQL.: Querying and Updating with SPARQL 1.1" by Bob DuCharme

3. Online tutorials and resources related to RDF, OWL, and SPARQL
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4-YEAR BACHELOR (HONOURS WITH RESEARCH) IN LIBRARY AND INFORMATION SCIENCE

Course Code BL1S3805 B

Course Title Informatics and Scientometrics

Type of Paper MENC (Mandatory Elective Non-Credit Course)
Credit -

Teaching Hours |30

Objectives- To acquaint students with Informetrics, Bibliometrics Laws, Growth and
Obsolescence of Literature, Citation analysis and Science Indicators.

Outcome- After completion of the course, students will be confident about Informetrics,
Bibliometrics Laws, Growth and Obsolescence of Literature, Citation analysis and Science
Indicators.

Unit I: Bibliometrics, Scientometrics, and Informetrics

» Concept and Definition of Librametric, Bibliometrics, Scientometrics,
Informetrics, Webometrics and Altimetric. Librametry, Bibliometrics
Theoretical Foundation of Bibliometrics and Scientometrics; Limitations of
Bibliometrics, Scientometrics, Informetrics and Webometrics
Garfield’s Law of Concentration, Mathew Effect, Other Models of Scientific
Communications
Bibliometric Data Sources: Scopus, Web of Science, Google Scholar; Crossref;
Microsoft Academic
Bibliometric Data Collection: Citation Counting Methods
Individual Impact Measures: H-Index, G-index, etc; Co-Citation Analysis,
Bibliographic Coupling
Journal Citation Measures: Journal Impact Factor, Journal Citation Indicator,
Immediacy Index, CiteScore, SNIP, Weighted Impact -Eigenfactor, SIR; Half-
life; Normalized Impact Indicators

YV VYV VYV Vv V

Unit I1: Advanced Learning in Bibliometrics/ Scientometrics
» Classical Laws of Bibliometrics - Broadford's Law, Zipf’s Law, Lotka's Law,
Brookes, Leimkhler, Bookstein Formulation, Bradford-Zipf Distribution; Price
Theory, Ortega Hypothesis.

Altimetric and Webometric: Data Source and Analysis
Responsible Research Metrics — DORA Declaration, Leiden Manifesto, etc.

» Fitting of Informetrics Models: Bradford’s Curve, Leimukuhler’s Distribution.

» Aspects of Concentration Measures; 80-20 Rule, Price’s Law relating to
Scientific Productivity Analysis of Use Statistics.

» Publication Productivity Dynamics - Journal Level, Institutional Level,
Regional Level, National Level, Global Level, Discipline Level Publication

» Scientometrics Analysis Tools- R Software -Bibliometrix, Publish or Perish,
Bibexcel, etc.

» Network Visualization Software — VVosviewer; Pajek, Sci2Tools, CiteSpace,
etc.

>

>
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RECOMMENDED BOOKS

1. Carpenter, R.L. and Vasu, E.S. (1979). Statistical methods for librarian.

Chicago: ALA.

2. Donohue, J C. (1990). Understanding scientific literature: A Bibliometric
approach. London: MIT.

3. Egghe, L., and Rousseau, R. (1990). Introduction to Informetrics: Quantitative
methods in Library, Documentation and Information Science. Amsterdam:
Elsevier.

4. Nicholas D. and Ritchil, M. (1979). Literature and Bibliometrics. London:
Clive Bingley.

5. Bornmann, L., & Daniel, H. D. (2008). What do citation counts measure? a
review of studies on citing behavior. Journal of Documentation, 64(1), 45 —
80. 2.

6. Cronin, B. & Sugimoto, C. (Eds). (2014) Beyond Bibliometrics : Harnessing
Multidimensional Indicators of Scholarly Impact. Massaschussets, MIT Press

7. Cronin, B. (1984). The citation process: the role and significance of citations
in scientific communication: Taylor Graham.

8. Cronin, B., & Atkins, H.B. (Eds.). (2000). The Web of Knowledge: A
Festschrift in Honor of Eugene Garfield: Information Today Inc.

9. De Bellis, N. (2009). Bibliometrics and Citation Analysis: From the Science
Citation Index to Cybermetrics. Lanham: Scarecrow Press.

10. Egghe, L. (2005). Power Laws in the Information Production Process:
Lotkaian Informetrics: Emerald Group Publishing Limited.

11. Glanzel, W., Moed, H.F., Schmoch, U., Thelwall, M. (Eds.) (2019) Springer
Handbook of Science and Technology Indicators. Cham, Switzerland:
Springer Nature

12. Haustein, S. (2012). Multidimensional journal evaluation: Analyzing
scientific periodicals beyond the Impact Factor. Berlin : De Gruyter.

13. Moed, H. F. (2005). Citation analysis in research evaluation. Dordrecht,:
Springer.

14. Sugimoto, C. R. (Ed.) ( 2016), Theories of Informetrics and Scholarly
Communication: A festschrift in honor of Blaise Cronin

15. Thelwall, M. (2016). Web indicators for research evaluation: A practical
guide. Synthesis Lectures on Information Concepts, Retrieval, and Services.
San Rafael, CA: Morgan & Claypool Publishers.

16. Vinkler, P. (2010). The Evaluation of Research by Scientometric Indicators.
Oxford: Chandos.

17. Waltman, L. (2016). A review of the literature on citation impact indicators.
Journal of Informetrics, 10(2), 365-391.
https://doi.org/10.1016/j.j0i.2016.02.007.

18. Wilsdon, J. (2016), Towards Metric Tide: Independent Review of the Role of
Metrics in Research Assessment and Management, Sage publication/ HEFCE,
UK
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